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Chapter 1: OMi Management Pack for SAP
TheOMi Management Pack for SAP (OMi MP for SAP) works with Operations Manager i (OMi) and
enables you tomonitor primary and advanced components of your SAP environment and the underlying
infrastructure.

It includes Health Indicators (HIs) and Event Type Indicators (ETIs) that analyze the events that occur
in your SAP Configuration Items (CIs) and report the health status of the SAP environment. It also
includes two sets of out of the box Management Templates for monitoring the availability, health, and
performance of ABAP and Java Application Servers in your SAP landscape. TheseManagement
Templates consists of a two separate sets of Aspects which enable easy monitoring of both ABAP and
Java Application Servers in your SAP landscape.TheManagement Templates can be deployed by
administrators for monitoring your SAP landscape. TheManagement Templates can also be easily
customized by Subject Matter Experts (SMEs) and developers to suit different monitoring
requirements.

The SAP ABAP Monitoring Templates features RemoteMonitoring which extends the scope of
monitoring ABAP Application Servers by enabling you tomonitor SAP ABAP Application Servers on
nodes which does not haveOperations Agent installed. You can set up and perform the remote
monitoring of ABAP Application Servers from an SAP CI, where Operations Agent is installed andOMi
MP for SAP Management Templates are deployed.

TheOMi MP for SAP includes the following artifacts for monitoring your SAP environment:

l Two separate sets of Management Templates for ABAP and Java Application Servers

l Separate Aspects for ABAP and Java Application Servers

l ABAP Monitoring Templates

l J2EE Policy Templates

l Instrumentation

OMi MP for SAP works with OMi and provides the following salient features:

l Ready-to-deploy, management solutions to suit different monitoring requirements

l Separate set of Management Templates and Aspects covering ABAP and Java Application Servers
for creating customized solutions

l RemoteMonitoring solution for ABAP Application Servers

HPE OMi Management Pack for SAP (1.00) Page 10 of 308



Chapter 2: Getting Started
Youwant to monitor a business critical SAP environment comprising of ABAP and Java Application
Server instances.

Your SAP environment can have either ABAP, Java or both Application Server instances. You want to
check the availability and performance of either ABAP, Java or both Application Servers and also
monitor the basic functionality of your SAP Environment.

Task 1: Adding Remote Managed Node to BSM 9.2x

or OMi 10.x Console

Before you beginmonitoring, follow these steps to add the nodes.

1. Open theMonitored Nodes pane from Administration:

On BSM 9.2x, click Admin > Operations Management > Setup > Monitored Nodes.

OnOMi 10.x, click Administration > Setup and Maintenance > Monitored Nodes.

2. In the Node Views pane, click Predefined Node Filter > Monitored Nodes and then click
and then select the required OS type. The Create New Monitored Nodes dialog box appears.

3. Specify the Primary DNS Name, IP address, Operating System, and Processor Architecture of
the node and click OK.

Task 2: Enabling the Enrichment Rules

Youmust enable the following enrichment rules to populate the SAP CI’s display label with additional
information about container or the hostname:

l SoftwareElementDisplayLabelForNewHost

l SoftwareElementDisplayLabelForExistingHost

l SoftwareElementDisplayLabelPopulator

To enable the Enrichment rules, follow these steps:
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1. Open the Enrichment manager pane:

On BSM 9.2x, click Admin > RTSM Administration > Modeling > Enrichment manager.

OnOMi 10.x, click Administration > RTSM Administration > Modeling > Enrichment
manager.

2. In the Enrichment Rules pane, select SoftwareElementDisplayLabelForNewHost from the list.

3. Right-click and select Properties.

The Enrichment Rule Properties window appears.

4. Click Next.

5. Select Rule is Active.

6. Click Finish.

7. In the Enrichment Rules pane, click Save to save the changes.

8. Select SoftwareElementDisplayLabelForExistingHost and repeat steps 3 to 7.

9. Select SoftwareElementDisplayLabelPopulator and repeat steps 3 to 7.

Task 3: Deploying the SAP Discovery Aspect

To discover the SAP CI on the added SAP managed nodes, youmust deploy the SAP Discovery
aspect. OMi MP for SAP has two separate set of Discovery aspects for ABAP and J2EE Application
Server. You can deploy the Discovery aspect depending on the type of CI you want to discover.

Deploying SAP J2EE Discovery Aspect

To discover the J2EE Applications Servers in your SAP Landscape, follow these steps:

1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

Configuration Folders > ERP Management > SAP NetWeaver Application Server >
JAVA Aspects

User Guide
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3. In the JAVA Aspects folder, select theSAP J2EE DiscoveryAspect, and then click to open

the Assign and Deploy Wizard.

4. In theConfiguration Item tab, select the SAP managed node to which you want to deploy the
SAP J2EE Discovery Aspect.

5. Click Next to go toRequired Parameters tab.

6. Click Next to go toAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x.

Note: In theAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x, you
can override the default values of any parameter. You can specify a value for each parameter
at theManagement Template level. By default, parameters defined as expert parameters are

not shown. To view expert parameters, click Show Expert Parameters.

7. Click Next.

8. (Optional). If you do not want to enable the assignment immediately, Enable AssignedObjects On
BSM 9.2x or OnOMi 10.x Enable Assignment(s) check box

On BSM 9.2x, clear theEnable Assigned Objects check box.

OnOMi 10.x, clear theEnable Assignment(s) check box.

You can then enable the assignment later using the Assignments & Tuning pane.

9. Click Finish.

Deploying SAP ABAP Discovery Aspect

To discover the SAP ABAP Applications Servers in your SAP Landscape, follow these steps:

1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

Configuration Folders > ERP Management > SAP NetWeaver Application Server > ABAP
Aspects

3. In the ABAP Aspects folder, select theSAP ABAP DiscoveryAspect, and then click to open

the Assign and Deploy Wizard.

4. In theConfiguration Item tab, click the SAP managed node to which you want to deploy the
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SAP ABAP Discovery Aspect.

5. Click Next to go toRequired Parameters tab.

6. Click Next to go toAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x.

Note: In theAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x, you
can override the default values of any parameter. You can specify a value for each parameter
at theManagement Template level. By default, parameters defined as expert parameters are

not shown. To view expert parameters, click Show Expert Parameters.

7. Click Next.

8. (Optional). If you do not want to enable the assignment immediately, .

On BSM 9.2x, clear theEnable Assigned Objects check box.

OnOMi 10.x, clear theEnable Assignment(s) check box.

You can then enable the assignment later using the Assignments & Tuning pane.

9. Click Finish.

Deploying SAP ABAP Remote Configuration Aspect

If you want to monitor SAP ABAP Application Servers on nodes which do not haveOperations Agent
(OA) installed, you can deploy SAP ABAP Remote Configuration Aspect.

To deploy SAP ABAP Remote Configuration Aspect, follow these steps:

1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

Configuration Folders > ERP Management > SAP NetWeaver Application Server > ABAP
Aspects

3. In the ABAP Aspects folder, select theSAP ABAP Remote Configuration Aspect, and then
click to open the Assign and Deploy Wizard.

4. In theConfiguration Item tab, click the SAP managed node you want to use as themonitoring
host (where the Agent is installed) and then click Next.

5. In theRequired Parameters tab, youmust specify the details about the remote SAP Central
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Instance node that you want to monitor using OMi MP for SAP.

a. Select theSAP ABAP Application Server Instance with HostName and SID parameter

in the list, and then click . The Edit Parameter: SAP ABAP Application Server Instance

number with HostName and SID dialog box opens.

b. Specify theSAP ABAP Application Server Central Instance along with Host Name and
SID of Remote SAP ABAP Application Server as shown in the following example:

Example:

testnode.hpe.com_T01_00

Here testnode.hpe.comis the fully qualified SAP Remote Host Name, T01is the SID 
for SAP Remote Host and 00is the SAP Instance number.

c. Click OK.

d. Select theSAP ABAP Application Server Client parameter in the list, and then click .

The Edit Parameter: SAP ABAP Application Server Client opens.

e. Click Value, specify the client number of remote SAP ABAP Application Server, and then
click OK.

6. Click Next to go toAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x. To

change the default values of the parameters, you can select the parameter and then click . The

Edit Parameter dialog box opens. Click Value, specify the value, and then click OK. For example,
you can change the default username and password for the Remote SAP ABAP Application
Server from the Edit Instance Parameter pane. You can also addmultiple Remote Host that you
want to monitor from the Edit Instance Parameter pane.

To add SAP Remote nodes from within the Edit Instance Parameter pane, follow these steps:

a. In the Instance Values pane, click . The Edit Parameter dialog box opens.

b. Specify the SAP ABAP Application Server Instance along with Host Name and SID of
Remote SAP ABAP Application Server as shown in the following example:

Example:

testnode.hpe.com_T01_00

Here testnode.hpe.com is the fully qualified SAP Remote Host Name, T01 is the SID for
SAP Remote Host and 00 is the SAP Instance number.
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OMi MP for SAP enables you to provide the Remote SAP ABAP Application Server
credentials in the following combinations:

i. Remote Host Name (fully qualified) Single SAP SID andMultiple ABAP Application
Server Instance.

Example:

testnode.hpe.com_T01_00

testnode.hpe.com_T01_01

testnode.hpe.com_T01_03

ii. Remote Host Name (fully qualified) Multiple SAP SID and ABAP Application Server
Instance.

Example:

testnode.hpe.com_T01_00

testnode.hpe.com_T02_00

testnode.hpe.com_T03_00

iii. Multiple Remote Host Name (fully qualified) with SAP SID and ABAP Application
Server Instance.

Example:

testnode.hpe.com_T01_00

testnode01.hpe.com_T01_00

testnode02.hpe.com_T01.3_00

Note: In theAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x, you
can override the default values of any parameter. You can specify a value for each parameter
at theManagement Template level. By default, parameters defined as expert parameters are

not shown. To show expert parameters, click Show Expert Parameters.

7. Click Next.

8. (Optional). If you do not want to enable the assignment immediately, .

On BSM 9.2x, clear theEnable Assigned Objects check box.

OnOMi 10.x, clear theEnable Assignment(s) check box.

You can then enable the assignment later using the Assignments & Tuning pane.

9. Click Finish.
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Note:After deploying SAP Discovery Aspect, youmust verify if the SAP CIs are populated in the
BSM 9.2x or OMi 10.x console. To view discovered CIs:

1. Open the Events Perspective pane:

On BSM 9.2x, click Applications > Operations Management > Event Perspective.

OnOMi 10.x, clickWorkspaces > Operations Console > Event Perspective.

2. Select SAP_Deployment view. The SAP CIs are populated in the Browse Views.

3. Select SAP_ABAP_Deployment andSAP_J2EE_Deployment view to visualize the
respective SAP Application Server CIs.

Task 4: Configuring SAP Node for ABAP Application

Server Monitoring

Youmust complete the following tasks to enable the OMi MP for SAP for monitoring SAP ABAP
Application Server:

1. Apply OMi MP for SAP Transport

Youmust copy the OMi MP for SAP transport files from instrumentation folder to the SAP
transport directories on each SAP NetWeaver central instance and apply them.

2. Configure SAP User for OMi

Youmust set up an SAP User for OMi so that OMi MP for SAP can log on to SAP whenever OMi
MP for SAP applications, monitors, or actions need access to SAP.

3. Copy lib files to Instrumentation folder

Youmust copy the SAP RFC library files to the instrumentation folder on the SAP managed node.

4. For Solaris managed node, configure LD_LIBRARY_PATH to 32-bit libgcc_s.so path

Youmust configure LD_LIBRARY_PATH to 32-bit libgcc_s.so path, if you aremonitoring a
Solaris managed node.

For more information about Configuring SAP Node for ABAP Application Server Monitoring, seeOMi
MP for SAP Installation Guide.
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Task 5: Deploying SAP ABAP Configuration Aspect

Note:Youmust deploy SAP ABAP Configuration Aspect before deploying SAP ABAP
Management Templates.

To deploy SAP ABAP Configuration Aspect on SAP ABAP Application Server, follow these steps:

1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

Configuration Folders > ERP Management > SAP NetWeaver Application Server > SAP
ABAP Aspects

3. In the ABAP Aspects folder, select theSAP ABAP Configuration Aspect, and then click to

open the Assign and Deploy Wizard.

4. In theConfiguration Item tab, click the SAP ABAP Application Server Central Instance you want
to deploy the SAP Aspects. For more information about SAP ABAP Aspects that supports SAP
Central Instance and Application Server, seeOMi MP for SAP ABAP Monitoring Template
Configuration Files table in Deployment Scenarios.

Note:Youmust not select the SAP ABAP Application Server configured as part of
SAP ABAP Remote Configuration Aspect. For more information "Deploying
SAP ABAP Remote Configuration Aspect ".

5. Click Next. TheRequired Parameters tab opens.

6. Select SAP ABAP Application Server Client parameter and click .

The Edit Parameter: SAP ABAP Application Server Client opens.

7. Click Value, specify the value, and then click OK.

8. Click Next to go toAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x.
You can edit the default values for parameters inAll Parameters tab.
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Note: To change the default values of Mandatory Parameter for SAP ABAP Application

Server, you can select the parameter and then click . The Edit Parameter dialog box

opens. Click Value, specify the value, and then click OK.

9. Click Next.

10. (Optional). If you do not want to enable the assignment immediately, .

On BSM 9.2x, clear theEnable Assigned Objects check box.

OnOMi 10.x, clear theEnable Assignment(s) check box.

You can then enable the assignment later using the Assignments & Tuning pane.

11. Click Finish.

Data Collection

Frequency (polling interval) at which each Aspect must bemonitored is predefined with a default value
in a specific frequency parameter. Frequency parameter is an expert parameter that is defined for each
of themetrics regardless of whether they are for generating events or not.

Following are the four predefined frequency parameters:

Parameter Frequency

Very High 5mins

High 15mins

Medium 1 hour

Low 24 hours

After Management Templates and Aspects are deployed, collector is triggered based on the predefined
frequency parameter in a specific Aspect. You canmodify the default value of the parameter at
following two levels:

l During deployment of theManagement Template or Aspects using theManagement Templates &
Aspects pane.

l After deployment using the Assignments & Tuning pane.

For more information about how tomodify the parameter values, see Types of Parameters.
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Task 6: Identifying and Deploying an

SAP Management Template

Note:Youmust deploy the SAP Discovery Aspect even if the CIs are already populated by any
other source such as SiteScope, DDM, and so on. For more information, see "Task 3: Deploying
the SAP Discovery Aspect".

OMi MP for SAP contains two separate set of Management Templates and Aspects for monitoring the
ABAP and J2EE Application Servers in your SAP Landscape. TheOMi MP for SAP also contains a set
of SAP ABAP Monitoring Templates which you can configure to run at regular intervals to collect
information regarding various functionality of ABAP Application Servers in your SAP Environment. For
more information about ABAP Monitoring Templates, see "RemoteMonitoring with SAP ABAP
Monitoring Templates ".

Deploying an SAP Management Template

Youmust identify the SAP Management Template suitable for your SAP environment before
deployment by following these recommendations:

l Formonitoring the basic functionality of SAP ABAP Application Server that comprises any of these
components - health, dump status, batch job health, transport, user health, processes and
dispatcher, work processes, security, and RFC destinations, you can deploy Essential
SAP ABAP Management Template.

l For in-depth and detailedmonitoring of SAP ABAP Application Server environments, you can
deploy Extensive SAP ABAP Management Template.

l Formonitoring the basic functionality of SAP J2EE Application Server that comprises any of these
components - SAP J2EE requests, system and application thread pool, memory, and transaction
status, you can deploy Essential SAP J2EE Management Template.

l For in-depth and detailedmonitoring of SAP J2EE Application Server environments, you can deploy
Extensive SAP J2EE Management Template.

To deploy OMi MP for SAP Management Templates, follow these steps:

1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.
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OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

For ABAP Application Server:

Configuration Folders > ERP Management > SAP NetWeaver Application Server > ABAP
Management Templates

For J2EE Application Server:

Configuration Folders > ERP Management > SAP NetWeaver Application Server > JAVA
Management Templates

3. In theSAP Management Templates folder, click theManagement Template that you want to
deploy, and then click . The Assign and Deploy wizard opens.

4. In theConfiguration Item tab, click the SAP system or SID to which you want to assign the
Management Template, and then click Next. You can select multiple items by holding down the
Ctrl orShift key while selecting them.

5. In theRequired Parameters tab, youmust specify themandatory parameters.

For J2EE:

a. Select the Java Installation Directory parameter in the list, and then click the . The Edit

Parameter: Java Installation Directory dialog box opens.

b. Click Value, specify the value, and then click OK.

c. Select theSAP J2EE Application Server Instance User Name parameter in the list, and

then click the . The Edit Parameter: SAP J2EE Application Server Instance User Name

dialog box opens.

d. Click Value, specify the value, and then click OK.

e. Select theSAP J2EE Application Server Instance Password parameter in the list, and

then click the . The Edit Parameter: SAP J2EE Application Server Instance Password

dialog box opens.

f. Click Value, specify the value, and then click OK.

For ABAP:

6. Click Next to go toAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x. To

change the default values of the parameters, you can select the parameter and then click . The

Edit Parameter dialog box opens. Click Value, specify the value, and then click OK.
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Note: In theAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x, you
can override the default values of a parameter. You can specify a value for each parameter at
theManagement Template level. By default, parameters defined as expert parameters are not

shown. To show expert parameters, click Show Expert Parameters.

7. Click Next.

8. (Optional). If you do not want to enable the assignment immediately, clear the Enable Assigned
ObjectsEnable Assignment(s) check box.

On BSM 9.2x, clear theEnable Assigned Objects check box.

OnOMi 10.x, clear theEnable Assignment(s) check box.

You can then enable the assignment later using the Assignments & Tuning pane.

9. Click Finish.

Note: The username given during the deployment of aManagement Templatemust have
required privileges for OMi MP for SAP to collect data. You can create separate user for
ABAP and J2EE Application Servers. You can also create a single SAP user with necessary
privileges to collect data from ABAP and J2EE Application Servers.

Note:Data logging is disabled by default for SAP ABAP Application Server. Youmust run the
SAP ABAP Application Server - Start Performance Agent tool to enable
SAP ABAP data logging.

Task 7: Deploying SAP Aspects

If you are usingMonitoring Automation for Servers license, youmust deploy the OMi MP for SAP
Aspects to the SAP CIs.

Note:Youmust deploy the SAP Discovery Aspect even if the CIs are already populated by any
other source such as SiteScope, DDM, and so on. For more information, see "Task 3: Deploying
the SAP Discovery Aspect".

Note:Youmust deploy SAP ABAP Configuration Aspect before deploying other
SAP ABAP Aspects.

Deploying SAP ABAP Configuration Aspect on SAP Managed Nodes

To deploy SAP ABAP Configuration Aspect on SAP managed nodes, follow these steps:
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1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

Configuration Folders > ERP Management > SAP NetWeaver Application Server > ABAP
Aspects

3. In the SAP ABAP Aspects folder, select theSAP ABAP Configuration Aspect, and then click
Assign and Deploy Item to open the Assign and Deploy Wizard.

4. In theConfiguration Item tab, click the appropriate SAP managed node to which you want to
deploy the SAP ABAP Configuration Aspect. Click Next to accept the CIs and go toRequired
Parameters.

5. In theRequired Parameters tab, youmust specify themandatory parameters.

a. Select theSAP ABAP Application Server Instance Name parameter and click . The

Edit Parameter dialog box opens.

b. In the Edit Instance Parameter pane, select theSAP ABAP Application Server Instance

Name parameter and click . The Edit Parameter dialog box opens.

c. Click Value, specify the value in the following format:

ShortHostName_SAPSID_SAPInstNum_ABAP

Example:

TestNode_W09_00_ABAP

d. Click OK.

e. Select theSAP ABAP Application Server Client parameter in the list, and then click .

The Edit Parameter: SAP ABAP Application Server Client dialog box opens.

f. Click Value, specify the SAP ABAP server client number, and then click OK.

Example:

001

g. Select theSAP ABAP Application Server Instance Number parameter and click . The

Edit Parameter dialog box opens.

User Guide
Chapter 2: Getting Started

HPE OMi Management Pack for SAP (1.00) Page 23 of 308



h. Click Value, specify the SAP ABAP server instance number, and then click OK.

Example:

00

i. Select theSAP ABAP Host Name parameter and click .

The Edit Parameter dialog box opens.

j. Click Value, specify the SAP managed node name (fully qualified) within parenthesis.

Example:

(TestNode.hpe.com)

k. Click OK.

6. Click Next to go toAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x. To

change the default values of the parameters, you can select the parameter and then click . The

Edit Parameter dialog box opens. Click Value, specify the value, and then click OK.

7. Click Finish.

Deploying OMi MP for SAP Aspects

To deploy OMi MP for SAP Aspects on SAP Managed Nodes, follow these steps:

1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

For ABAP Application Server:

Configuration Folders > ERP Management > SAP NetWeaver Application Server > ABAP
Aspects

For J2EE Application Server:

Configuration Folders > ERP Management > SAP NetWeaver Application Server >
JAVA Aspects

3. In the specific SAP Aspects folder, select the SAP Aspect you want to deploy, and then click

Assign and Deploy Item to open the Assign and Deploy Wizard.
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4. In theConfiguration Item tab, click the appropriate SAP managed node to which you want to
deploy the SAP Aspect. You can select multiple items by holding down theCtrl orShift key while
selecting them. Click Next to accept the CIs and go toRequired Parameters.

5. In theRequired Parameters tab, youmust specify themandatory parameters.

For J2EE:

a. Select the Java Installation Directory parameter in the list, and then click . The Edit

Parameter: Java Installation Directory dialog box opens.

b. Click Value, specify the value, and then click OK.

c. Select theSAP J2EE Application Server Instance User Name parameter in the list, and

then click . The Edit Parameter: SAP J2EE Application Server Instance User Name dialog

box opens.

d. Click Value, specify the value, and then click OK.

e. Select theSAP J2EE Application Server Instance Password parameter in the list, and

then click . The Edit Parameter: SAP J2EE Application Server Instance Password dialog

box opens.

f. Click Value, specify the value, and then click OK.

For ABAP:

6. Click Next to go toAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x. To

change the default values of the parameters, you can select the parameter and then click . The

Edit Parameter dialog box opens. Click Value, specify the value, and then click OK.

Note: In theAll Parameters tab on BSM 9.2x orParameter Summary tab onOMi 10.x, you
can override the default values of any parameter. You can specify a value for each parameter
at theManagement Template level. By default, parameters defined as expert parameters are

not shown. To view expert parameters, click Show Expert Parameters.

For J2EE:

To change the default values of SAP J2EE Application Server Instance Name parameter, you can

select the parameter and then click . The Edit Parameter dialog box opens. Click Value,
specify the value, and then click OK.

For ABAP:
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To change the default values of Mandatory Parameter for SAP ABAP Application Server, you can

select the parameter and then click . The Edit Parameter dialog box opens. Click Value,
specify the value, and then click OK.

7. Click Next.

8. (Optional). If you do not want to enable the assignment immediately, .

On BSM 9.2x, clear theEnable Assigned Objects check box.

OnOMi 10.x, clear theEnable Assignment(s) check box.

You can then enable the assignment later using the Assignments & Tuning pane.

9. Click Finish.

Task 8: Configuring SAP ABAP Monitoring

Templates

TheOMi MP for SAP contains SAP ABAP Monitoring Templates which enables you tomonitor specific
functionality of SAP ABAP Application Server. A set of SAP ABAP Monitoring Templates provided
with OMi MP for SAP contains out-of-the-box configuration which enables deployment without any
manual configuration. OMi MP for SAP enables you to configure SAP ABAP Monitoring Template for
monitoring functionality specific to your SAP environment.

The SAP ABAP Monitoring Templates with out-of-the-box configuration are listed in the following table:

SAPABAP Monitoring Template Description

SAPABAP_CCMSIntegrationMon SAP ABAP Monitoring Template for monitoring the output of
SAP CCMS monitoring infrastructure.

SAPABAP_DispMon SAP ABAP Monitoring Template for monitoring the size,
content and status of various queues for different types of SAP
work processes.

SAPABAP_DumpMon SAP ABAP Monitoring Template for monitoring the runtime
errors that occur on the SAP ABAP system.

SAPABAP_LckChkMon SAP ABAP Monitoring Template for monitoring the Enqueue
process whichmanages the SAP ABAP logical locks for
different SAP transactions and SAP reports.

SAPABAP_Perfmon SAP ABAP Monitoring Template for collecting the SAP
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Performancemetrics from different OMi MP for SAP
Performancemonitors.

SAPABAP_SplMon SAP ABAP Monitoring Template for monitoring the number of
SAP ABAP Spooler entries, error generating spool requests,
erroneous spooler entries in the print requests.

SAPABAP_StatusMon SAP ABAP Monitoring Template for monitoring the SAP ABAP
Application Server Availability Status.

SAPABAP_TraceMon SAP ABAP Monitoring Template for monitoring all the SAP
Trace and Log files for "ERROR".

SAPABAP_TransMon SAP ABAP Monitoring Template for monitoring the
successfully imported/exported SAP ABAP transports, failed
imports/exports, availability of confirmed/unconfirmed repairs
and connections/tptests to the configured systems.

SAPABAP_UpdProcMon SAP ABAP Monitoring Template for monitoring the different
conditions of SAP ABAP update processes like inactive Status
and errors.

SAPABAP_WPMon SAP ABAP Monitoring Template for monitoring the running
work processes, waiting work process, checking the various
status of work process such as Debug, Private or No Restart.

For more information about configuring SAP ABAP Monitoring Templates, see "SAP ABAP Monitoring
Templates".

Monitoring SAP Environment

After you deploy Management Template and Aspects, you can analyze the status of events from the
following perspectives:

l Event Perspective

l Health Perspective

l Performance Perspective

Event Perspective

The Event Perspective provides complete information of events from an Event Perspective. In the
Event Perspective, you can view the event information of SAP Application Server CIs that are
monitored by OMi MP for SAP.

To view the Event Perspective of SAP Application Server CIs, follow these steps:
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1. Open the Event Perspective pane:

On BSM 9.2x, click Applications > Operations Management > Event Perspective.

OnOMi 10.x, clickWorkspaces > Operations Console > Event Perspective.

The View Explorer pane appears.

2. In theBrowse Views tab, select SAP_Deployment orSAP_ABAP_Deployment orSAP_
J2EE_Deployment view that contains the respective SAP Application Server CIs for which you
want to view the events. Alternatively, you can useSearch tab to find Application Server CI.

3. Click the SAP Application Server CI for which you want to view the Event Perspective. The list of
events for the selected SAP Application Server CI appears on the Event Browser pane.

When you click an event from the Event Browser, the Event Details pane opens where you can
view following details:

o General - Displays the detailed information about the selected event such as Severity,
Lifecycle State, Priority, Related CIs and so on.

o Additional Info - Displays more detailed information about the attributes of the selected event.

o Source Info - Displays an overview of the information available about the source of the
selected event.

o Actions - Displays the list of actions available for a selected event. There are two types of
possible actions: User Action and Automatic Action.

o Annotations - Displays a list of the annotations attached to the selected event.

o Custom Attributes - Displays a list of the attributes that either an administrator or a
responsible user manually configured and added to the selected event.

o Related Events - Displays an overview of all the events that are related to the event selected
in the Event Browser.

o History - Displays the history of the selected event.

o Resolver Hints - Displays the information used to identify the node and CI associated with an
event.

o Instructions - Displays instruction information designed to help operators handle the
associated event.

o Forwarding - Displays the transfer of ownership details if any, for the events.

Note: Formore information about Managing Events, see theOperations Manager i Concepts
Guide.

Health Perspective
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The Health Perspective provides a high-level view of the overall health information of the related CIs in
the context of events. In the Health Perspective, you can view the health information of the SAP
Application Server CIs that aremonitored by OMi MP for SAP.

To view the Health Perspective of SAP Application Server CIs, follow these steps:

1. Open the Health Perspective pane:

On BSM 9.2x, click Applications > Operations Management > Health Perspective.

OnOMi 10.x, clickWorkspaces > Operations Console > Health Perspective.

The View Explorer pane appears.

2. In theBrowse Views tab, select SAP_Deployment orSAP_ABAP_Deployment orSAP_
J2EE_Deployment view that contains the respective SAP Application Server CIs for which you
want to view the health related events. Alternatively, you can useSearch tab to find a SAP
Application Server CI.

3. Click the SAP Application Server CI for which you want to view the Health Perspective. The list of
health related events for the selected SAP Application Server CI appears on the Event Browser
pane.

When you click an event from the Event Browser pane, the following panes appear:

o Health Top View - Displays the health top view of the selected event.

o Health Indicators - Displays the Key Performance Indicators (KPIs) and HIs related to the CI
that you select from the Health Top View pane.

o Actions - Displays the list of actions available for a selected event.

Note: Formore information about Managing Events, see theOperations Manager i Concepts
Guide.

Performance Perspective

Performance Perspective enables you to populate graphs from existing graph templates. You can also
plot customized graphs by selecting the requiredmetrics for a selected CI.

To view the Performance Perspective of SAP Application Server CIs using graphs, follow these steps:

1. Open the Performance Perspective pane:

On BSM 9.2x, click Applications > Operations Management > Performance Perspective.

OnOMi 10.x, clickWorkspaces > Operations Console > Performance Perspective.

The View Explorer pane appears.
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2. In theBrowse Views tab, select SAP_Deployment orSAP_ABAP_Deployment orSAP_
J2EE_Deployment view. The performance pane appears, which lists the default graphs available
for the respective views.

3. Click the graph you want to plot from theGraphs tab, and then click Draw Graphs. The
selected graph is plotted on the right pane.
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Chapter 3: Components
TheOMi MP for SAP includes the following components for monitoring your SAP environment:

l SAP Management Templates

l SAP Aspects

l SAP ABAP Monitoring Templates

l SAP Parameters

l Run-time ServiceModel (RTSM) Views

l Event Type Indicators (ETIs)

l Health Indicators (HIs)

l Configuration Items (CIs) and Configuration Item Types (CITs)

l Topology Based Event Correlation (TBEC) Rules

l Tools

SAP Management Templates

The SAP Management Templates provide a completemanagement solution for monitoring the health
and performance of different systems and applications in your SAP landscape.

By default, OMi MP for SAP comprises two sets of SAP Management Templates with predefined
settings tomonitor ABAP and Java application servers in the environment. You can deploy the SAP
Management Templates with the default parameters and seamlessly monitor the systems in your
environment. These SAP Management Templates comprises several Aspects which enables you to
monitor the ABAP and Java Application Servers.

Based on themonitoring requirements, you can also customize the SAP Management Templates or
create SAP Management Templates tomonitor the systems in your environment.
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Overview of SAP Management Templates

OMi MP for SAP comprises the following two sets of Management Templates tomonitor ABAP and
Java stacks in your SAP environment:

SAP ABAP Monitoring

OMi MP for SAP contains the followingManagement Templates for monitoring ABAP application
server:

l "Essential SAP ABAP Management Template"

l "Extensive SAP ABAP Management Template"

SAP J2EE Monitoring

OMi MP for SAP contains the followingManagement Templates for monitoring Java application server:

l "Essential SAP J2EE Management Template "

l "Extensive SAP J2EE Management Template"

How to Access Management Templates

1. For ABAP Application Server:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. Click Configuration Folders > ERP Management > SAP NetWeaver Application Server >
ABAP Management Templates.

3. For J2EE Application Server:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

4. Click Configuration Folders > ERP Management > SAP NetWeaver Application Server >
JAVA Management Templates.
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Tasks

You can perform the following tasks onOMi MP for SAP Management Template:

How to Deploy OMi MP for SAP Management Templates

Formore information, see Task 6: Identifying and Deploying a SAP Management Template.

How to Automatically Assign OMi MP for SAP Management Templates and OMi MP for SAP
Aspects

To automatically assign OMi MP for SAP Management Templates or Aspects, follow these steps:

1. Open the Automatic Assignment Rules:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Automatic
Assignment Rules.

OnOMi 10.x, click Administration > Monitoring > Automatic Assignment Rules.

Automatic Assignment Rules consists of Auto-Assignment Rules pane at the top and Parameters
pane at the bottom.

2. In theAuto-Assignment Rules pane, click New Assignment and select the appropriate
option. The Create Auto-Assignment Rule wizard opens.

3. In theSelect Target View tab, select the view for which you want to create the automatic
assignment rule, and then click Next.

4. In theSelect Item to Assign tab, click theManagement Template or an Aspect that you want to
automatically assign to all the CIs, and then click Next.

The latest version of theManagement Template or Aspect that you want to assign is selected by
default. Click Next.

5. In theRequired Parameters tab, click Next.

Note: There are no parameters that require editing for this assignment.

6. (Optional). In theAll Parameters on BSM 9.2x orParameter Summary tab onOMi 10.x, you can
change the default value of parameters by following these steps:

a. To edit a parameter, double-click it or select it from the list and click Edit. The Edit
Parameter dialog box opens.

b. Change the default value and click OK.
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7. Click Next.

8. (Optional). In theConfigure Option tab, clear theActivate Auto- Assignment Rule check box if
you do not want to activate the assignment rule immediately. You can activate automatic
assignment rules later using the Automatic Assignment Rules pane at Administration >
Monitoring > Automatic Assignment Rules.

9. Click Finish to save the changes. The assignment rule is added to the list of auto-assignment
rules.

An assignment may trigger an event to be sent to OMi if one of the following situations applies:

l A deployment job fails.

l An auto-assignment fails.

l An auto-assignment succeeds.

You can check if the automatic assignment rule successfully created the expected assignments by
following these steps:

1. Open the Assignments & Tuning pane:

On BSM 9.2x, click Admin > Operations Management > Assignments & Tuning.

OnOMi 10.x, click Administration > Monitoring > Assignments & Tuning.

2. In theBrowse Views tab, select the view you identified while creating your automatic assignment
rule.

3. Expand the view, and select a node that corresponds to the root CI type of the assigned item.
Assignments created as a result of Automatic Assignment Rules are shown in the list of
assignments at the top of the right pane, and have the value Auto-Assignment in the column
Assigned By.

You can consider the following options for tuning the assignment:

l Use the Auto-Assignment Rules pane to tune the parameter values for all assignments triggered by
the automatic assignment rule.

l Use the Assignments pane to tune, redeploy, delete, and enable or disable individual assignments.

How to display an Inventory Report for OMi MP for SAP Management Template

The Inventory Report displays theManagement Templates, Aspects, and Policy Templates that are
available on a server. To display an Inventory Report for OMi MP for SAP Management Template,
follow these steps:
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1. Select theManagement Template for which you want to create the report for.

2. Click Generate Inventory Report in the Configuration Folders pane.

The report displays theManagement Templates, Aspects, and Policy Templates that are available
on the server.

You can display additional types of reports from the Assignments & Tuning pane.

Essential SAP ABAP Management Template

The Essential SAP ABAP Management Templatemonitors the SAP ABAP systems in your
SAP Landscape. You canmonitor the health and availability of the following system:

SAP ABAP Application Server

How to Access Essential SAP ABAP Management Template

1. Open theManagement Templates & Aspects pane:
On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. Click Configuration Folders > ERP Management > SAP NetWeaver Application Server >
ABAP Management Templates > Essential SAP ABAP Management Template.

User Interface Reference

Management Template - General

Provides an overview of the attributes of theManagement Template.

UI Element Description

Name Name of ABAP Management Template

Description The description of theManagement Template.

ID A unique Identifier for the GUID version.

Version ID A unique identifier for this version of theManagement Template.

Version The current version of theManagement Template. In this instance, the version of the
Management Template is 1.0.

Change The text that describes what is new ormodified in this version of theManagement
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UI Element Description

Log Template.

Management Template - Topology View

Provides an overview of the CI type you want to assign to theManagement Template.

UI
Element Description

Topology
View

Essential SAP ABAP Management Template uses SAP_ABAP_Deployment for
Topology View. It contains the CI types that you want to manage using the
Management Template.

CI Type The type of CIs managed by Essential SAP ABAP Management Template. This is the
type of CI to which theManagement Template can be assigned. The Essential SAP
ABAP Management Template contains SAP System CI Types.

Extensive SAP ABAP Management Template

The Extensive SAP ABAP Management Templatemonitors the SAP ABAP systems in your
SAP Environment. You canmonitor the health and availability of the following system:

SAP ABAP Application Server

How to Access Extensive SAP ABAP Management Template

1. Open theManagement Templates & Aspects pane:
On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. Click Configuration Folders > ERP Management > SAP NetWeaver Application Server >
ABAP Management Templates > Extensive SAP ABAP Management Template.

User Interface Reference

Management Template - General

Provides an overview of the attributes of theManagement Template.

UI Element Description

Name Name of ABAP Management Template
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UI Element Description

Description The description of theManagement Template.

ID A unique Identifier for the GUID version.

Version ID A unique identifier for this version of theManagement Template.

Version The current version of theManagement Template. In this instance, the version of the
Management Template is 1.0.

Change
Log

The text that describes what is new ormodified in this version of theManagement
Template.

Management Template - Topology View

Provides an overview of the CI type you want to assign to theManagement Template.

UI
Element Description

Topology
View

Essential SAP ABAP Management Template uses SAP_ABAP_Deployment for
Topology View. It contains the CI types that you want to manage using the
Management Template.

CI Type The type of CIs managed by Essential SAP ABAP Management Template. This is the
type of CI to which theManagement Template can be assigned. The Essential SAP
ABAP Management Template contains SAP System CI Types.

Essential SAP J2EE Management Template

The Essential SAP J2EE Management Templatemonitors the SAP J2EE requests, system and
application thread pool, memory, and transaction status. You canmonitor the health and availability of
the SAP J2EE Application Server.

How to Access the Essential SAP J2EE Management Template

1. Open theManagement Templates & Aspects pane:
On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. Click Configuration Folders > ERP Management > SAP NetWeaver Application Server >
JAVA Management Templates > Essential SAP J2EE Management Template.
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User Interface Reference

Management Template - General

Provides an overview of the attributes of theManagement Template.

UI
Element Description

Topology
View

Essential SAP ABAP Management Template uses SAP_ABAP_Deployment for
Topology View. It contains the CI types that you want to manage using the
Management Template.

CI Type The type of CIs managed by Essential SAP ABAP Management Template. This is the
type of CI to which theManagement Template can be assigned. The Essential SAP
ABAP Management Template contains SAP System CI Types.

Management Template - Topology View

Provides an overview of the CI type you want to assign to theManagement Template.

UI
Element Description

Topology
View

SAP_Deployment is the topology view for Essential SAP J2EE Management
Template. It contains the CI types that you want to manage using theManagement
Template.

CI Type The type of CIs managed by Essential SAP J2EE Management Template. This is the
type of CI to which theManagement Template can be assigned. The Essential SAP
J2EE Management Template contains SAP System CI Types.

Extensive SAP J2EE Management Template

The Extensive SAP J2EE Management Templatemonitors the SAP J2EE application server
availability, SAP J2EE requests, system and application thread pool, memory, transaction, ports,
JMX, EJB, sessions, and connector services.

You canmonitor the health and availability of SAP J2EE Application Server.

How to Access the Extensive SAP J2EE Management Template

1. Open theManagement Templates & Aspects pane:
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OnBSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. Click Configuration Folders > ERP Management > SAP NetWeaver Application Server >
JAVA Management Templates > Extensive SAP J2EE Management Template.

User Interface Reference

Management Template - General

Provides an overview of the attributes of theManagement Template.

UI
Element Description

Topology
View

Essential SAP ABAP Management Template uses SAP_ABAP_Deployment for
Topology View. It contains the CI types that you want to manage using the
Management Template.

CI Type The type of CIs managed by Essential SAP ABAP Management Template. This is the
type of CI to which theManagement Template can be assigned. The Essential SAP
ABAP Management Template contains SAP System CI Types.

Management Template - Topology View

Provides an overview of the CI type you want to assign to theManagement Template.

UI
Element Description

Topology
View

SAP_Deployment is the topology view for Essential SAP J2EE Management
Template. It contains the CI types that you want to manage using theManagement
Template.

CI Type The type of CIs managed by Essential SAP J2EE Management Template. This is the
type of CI to which theManagement Template can be assigned. The Essential SAP
J2EE Management Template contains SAP System CI Types.

SAP Aspects

SAP Aspects are used tomonitor specific functionality of the applications and systems operating in
your SAP Landscape. The systems can be individual or clustered systems. Each SAP Aspect
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comprises policy templates, instrumentation, and parameters which enables you tomonitor the health
and performance of SAP systems. Each Aspect provides the ability to monitor a configured application
server CI.

Types of SAP Aspects

OMi MP for SAP comprises the following two sets of Aspects to monitor ABAP and Java stacks in
your SAP environment:

l SAP ABAP Monitoring - "SAP ABAP Aspects"

l SAP J2EE Monitoring - SAP J2EE Aspects

How to Access SAP Aspects

1. Open theManagement Templates & Aspects pane:
On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. Click Configuration Folders > ERP Management > SAP NetWeaver Application Server.

Tasks

This section provides information about the following tasks:

How to deploy OMi MP for SAP Aspect

Formore information about deploying OMi MP for SAP, see Task 7: Deploying SAP Aspects.

How to Create OMi MP for SAP Aspect

1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. Click Configuration Folders > ERP Management > SAP NetWeaver Application Server >
ABAP Aspects.
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3. In theManagement Templates & Aspects pane, click , and then click Create Aspect. The
Add New Aspect dialog box opens.

4. In theGeneral tab, specify a Name for the new Aspect, and then click Next.

5. In theCI Types tab, select one or more CITs from Available CI Types pane to associate with the

Aspect and click to add them to the Assigned CI Types pane, and then click Next.

Note:You can useCTRL orSHIFT key to select multiple CITs.

6. In the Instrumentation tab, click Add Instrumentation to add instrumentation categories to
the Aspect. The Add Instrumentation window opens which lists the instrumentation that you want
to add. Select the instrumentation and click OK. Click Next.

Note:You can add instrumentation based on your requirement. You can skip the step if you
do not want to add instrumentation to the Aspect.

7. (Optional). In theAspects tab, click Add Existing Aspect. The Add Existing dialog box opens
which enables you to select an existing Aspect that you want to add within an Aspect. Click an
Aspect and then click OK. You can useCTRL orSHIFT key to select multiple Aspects. Click
Next.

Note: If you are adding existing Aspects within an Aspect, ensure at least one of the CITs of
the Aspect that you addmust be a CIT or a parent CIT of the existing Aspect.

8. (Optional). In thePolicy Template tab, click Add Policy Templates on BSM 9.2x orAdd
Policy Templates From List onOMi 10.x. The Add New Policy Templates From List to Aspect
dialog box on BSM 9.2x or Add New Policy Templates dialog box onOMi 10.xopens.Select the
Policy Templates that you want to add and click OK.

9. If suitable Policy Templates do not exist, follow these steps to add a new Policy Template:

a. Click , and then click Add New Policy Template to create a Policy Template. The
Select Type for New Policy Template dialog box opens.

b. Select theMeasurement Threshold Policy Template type from the Type drop-down list and
click OK. The Policy Related Information dialog box opens.

c. In the Policy Related Information dialog box, specify a unique policy name and click OK. A
new Policy Template is added.

10. Click Next.

11. In theParameters tab, you see a list of parameters from the Policy Templates that you added to
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this Aspect.

To edit parameters:

a. Double-click the parameter or select the parameter from the list and click Edit. The Edit
Parameter dialog box opens.

b. Modify the default parameter value and click OK.

12. In the Add New Aspect dialog box, click Finish to save the aspect. The new aspect appears in the
Management Templates & Aspects pane.

How to Deploy OMi MP for SAP Aspects

Formore information, see Task 7: Deploying SAP Aspects.

SAP ABAP Aspects

SAP ABAP Aspects are used tomonitor the ABAP applications and system operating in your SAP
environment. These systems can be individual or clustered systems. Each SAP ABAP Aspect
comprises of policy templates, instrumentation, and parameters for monitoring the health and
performance of the SAP systems. Each Aspect provides the ability to monitor a Computer CI.

User Interface Reference

General Provides an overview of the general attributes of the SAP Aspects.

CI Type The type of configuration items that the Aspect can be assigned to. This is the
type of CI to which theManagement Template can be assigned. The SAP
Aspects contain Computer and SAP ABAP Application Server CI types.

Instrumentation Provides a single package which contains the binaries for discovery, collection,
and data logging.

Aspects Provides an overview of any Aspects that the SAP Aspect contains. You can
expand each item in the list to seemore details about the nested Aspect. The
SAP ABAP Base Aspect is part of all the other Aspects.

Policy
Templates

Provides an overview of the policy templates that the SAP Aspect contain. You
can expand each item in the list to seemore details about the policy template.

TheOMi MP for SAP contains the following aspects for monitoring ABAP Application Server:
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SAP ABAP Batch Job Health

Monitors the status and collects performance of batch jobs running on the SAP system.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
BatJobMon

NA Configuration file for monitoring
the SAP ABAP Batch jobs that
are exceeding the defined time
interval, closed before the
defined time interval, and not
started at the scheduled time.

SAP
ABAP
Monitoring
Template

SAP ABAP Base

Base Aspect for Monitoring SAP ABAP Landscapes contains Configuration, Scheduler, and Logger.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
High

NA Runs the SAP ABAP
collector/analyzer every 15
min with favorites metrics

Scheduled
Task

SapAbapApplicationServer SAPABAP_
Messages

NA SAP MP message template for
message interception.

Open
Message
Interface

SapAbapApplicationServer SAPABAP_
Low

NA Runs the SAP ABAP
collector/analyzer Low
schedule

Scheduled
Task

SapAbapApplicationServer SAPABAP_
Medium

NA Runs the SAP ABAP
collector/analyzer every
MEDIUM schedule

Scheduled
Task

SapAbapApplicationServer SAPABAP_
VeryHigh

NA Runs the SAP ABAP
collector/analyzer every
VERYHIGH schedule

Scheduled
Task

SAP ABAP Configuration

Collects configuration information for SAP ABAP application server CIs.
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CI Type Policy Template Indicator Description
Policy
Type

SapAbapApplicationServer SAPABAP_
Configuration

NA SAP ABAP
Configuration Details.

ConfigFile

SAP ABAP Correction and Transport System Status

Monitors the various parameters of SAP Correction and Transport System.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
CTSMon

NA Configuration file for monitoring
the SAP Correction and
Transport System for different
transport requests, tasks, and
objects.

SAP
ABAP
Monitoring
Template

SAP ABAP Discovery

Discovers the various ABAP instances in the SAP landscape.

CI Type Policy Template Indicator Description Policy Type

Computer SAPABAP_
Discovery

NA SAP ABAP discovery
policy.

Service Auto-
Discovery

SAP ABAP Dump Status

Monitors the runtime errors on the SAP ABAP environment.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
DmpMon

NA Configuration file for
monitoring the runtime errors
that occur on the SAP ABAP
system.

SAP
ABAP
Monitoring
Template

SAP ABAP Idoc Status

Monitors the status of Inbound andOutbound Idocs.
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CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
IdocStatusMon

NA Configuration file for
monitoring the current
status of different Idocs on
the SAP ABAP system.

SAP
ABAP
Monitoring
Template

SAP ABAP Lock Status

Monitors the database locks on the SAP system.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
LckChkMon

NA Configuration file for monitoring
the Enqueue process which
manages the SAP ABAP
logical locks for different SAP
transactions and SAP reports.

SAP
ABAP
Monitoring
Template

SAP ABAP Performance Monitor

Collects the SAP performancemetrics with respect to Oracle database, document statistics,
enterprise portal, ICM statistics, batch jobs, buffer, memory, spools, update jobs, users, statistical
records, workload statistics, and work processes.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
StatRecMon

NA Configuration file for specifying
the SAP transactions for SAP
ABAP statistical records
performancemonitor.

SAP
ABAP
Monitoring
Template

SapAbapApplicationServer SAPABAP_
PerfMon

NA Configuration file for collecting
the SAP Performancemetrics
from different SAP MP
performancemonitors.

SAP
ABAP
Monitoring
Template

SAP ABAP Processes and Dispatcher Status

Monitors the status of various SAP work processes and the ABAP dispatcher.
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CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
ProcMon

NA Configuration file for monitoring
the number of SAP ABAP
processes.

SAP
ABAP
Monitoring
Template

SapAbapApplicationServer SAPABAP_
DispMon

NA Configuration file for monitoring
the size, content and status of
various queues for different
types of SAP work processes.

SAP
ABAP
Monitoring
Template

SAP ABAP RFC Destination Status

Monitors the failed SAP RFC destinations.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
RFCDestMon

NA Configuration file for
monitoring the failed SAP
RFC destinations based on
the connection type and
name of the SAP RFC
destinations.

SAP
ABAP
Monitoring
Template

SAP ABAP Remote Configuration

Configuration input for SAP ABAP remotely monitored nodes.

CI Type Policy Template Indicator Description
Policy
Type

Computer SAPABAP_
RemoteDiscovery

NA Discovers SAP ABAP Remote Nodes
along with SAP System and Instance
number

Service
Auto-
Discovery

Computer SAPABAP_
RemoteConfiguration

NA SAP ABAP Remote Configuration
Details.

ConfigFile

SAP ABAP Security Status

Monitors the security status of important SAP users, SAP system parameters and security events.
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CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
SecMon

NA Configuration file for monitoring
the SAP ABAP Security
parameters like the privileges
and authorizations of important
SAP users, parameters that
affect the overall SAP.

SAP
ABAP
Monitoring
Template

SAP ABAP Spool Health

Monitors the status of various spool requests in the SAP system.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
SplMon

NA Configuration file for monitoring
the number of SAP ABAP
spooler entries, error generating
spool requests, and erroneous
spooler entries in the print
requests.

SAP
ABAP
Monitoring
Template

SAP ABAP System Change Option Status

Monitors the SAP system change option.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
SysChgOptMon

NA Configuration file for
monitoring the SAP ABAP
System Change options
based on the global edit
Status flag, namespaces,
and software components.

SAP
ABAP
Monitoring
Template

SAP ABAP Transport Status

Monitors the status of imports/exports of the transports on the SAP system.
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CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
TransMon

NA Configuration file for monitoring
the successfully
imported/exported SAP ABAP
transports, failed
imports/exports, availability of
confirmed/unconfirmed repairs
and connections/tptests to the
configured systems.

SAP
ABAP
Monitoring
Template

SAP ABAP Update Tasks Health

Monitors the status of update tasks running on the SAP system.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
UpdProcMon

NA Configuration file for
monitoring the different
conditions of SAP ABAP
Update processes like
inactive Status and errors.

SAP
ABAP
Monitoring
Template

SAP ABAP User Health

Monitors the status of logged-in users.

CI Type
Policy
Template Indicator Description Policy Type

SapAbapApplicationServer SAPABAP_
UsrMon

NA Configuration file for
monitoring the SAP ABAP
logged-in Users.

SAP ABAP
Monitoring
Template

SAP ABAP Work Process Health

Monitors the status of the SAP work processes.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_ NA Configuration file for monitoring SAP
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CI Type
Policy
Template Indicator Description

Policy
Type

WPMon the running work processes,
waiting work process, checking
the various Status of work
process like Debug/Private/No
Restart.

ABAP
Monitoring
Template

SAP CCMS Integration

Monitors the output of SAP CCMS monitor sets.

CI Type Policy Template Indicator Description
Policy
Type

SapAbapApplicationServer SAPABAP_
CCMSIntegrationMon

NA Configuration file for
monitoring the output
of SAP CCMS
monitoring
infrastructure.

SAP
ABAP
Monitoring
Template

SAP System Health

Monitors the SAP System availability status and trace file/log file status.

CI Type
Policy
Template Indicator Description

Policy
Type

SapAbapApplicationServer SAPABAP_
TraceMon

NA Configuration file for
monitoring all the SAP Trace
and Log files for "ERROR".

SAP
ABAP
Monitoring
Template

SapAbapApplicationServer SAPABAP_
StatusMon

NA Configuration file for
monitoring the SAP ABAP
Application Server Availability
Status.

SAP
ABAP
Monitoring
Template

SAP Temporary Sequential File Monitoring

Monitors the inconsistencies of the temporary Sequential objects.
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CI Type Policy Template Indicator Description
Policy
Type

SapAbapApplicationServer SAPABAP_
TempSeqFileMon

NA Configuration file for
monitoring the
inconsistencies found in
the SAP ABAP temporary
sequential objects.

SAP
ABAP
Monitoring
Template

SAP J2EE Aspects

SAP J2EE Aspects are used tomonitor the Java applications and system operating in your SAP
Landscape. The systems can be individual or clustered systems. Each SAP J2EE Aspect comprises
of policy templates, instrumentation, and parameters for monitoring the health and performance of the
SAP systems. Each Aspect enables you tomonitor a Computer CI.

User Interface Reference

General Provides an overview of the general attributes of the SAP Aspects.

CI Type The type of configuration items that the Aspect can be assigned to. This is the
type of CI to which theManagement Template can be assigned. The SAP
Aspects contain the Computer and SAP J2EE Application Server CI types.

Instrumentation Provides a package which contains the binaries for discovery, collection, and
data logging.

Aspects Provides an overview of SAP Aspects. You can expand each item in the list to
seemore details about an Aspect. The SAP J2EE Base Aspect is part of all the
other Aspects.

Policy
Templates

Provides an overview of the policy templates that the SAP Aspect contains. You
can expand each item in the list to seemore details about the policy template.

TheOMi MP for SAP contains the following aspects for monitoring J2EE Application Server:

SAP J2EE Base

Base Aspect for monitoring SAP Landscapes and contains configuration, scheduler, and logger.
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CI Type
Policy
Template Indicator Description

Policy
Type

SapJ2eeApplicationServer SAPJ2EE_
VeryHigh

NA Runs the SAP J2EE
collector/analyzer every
VERYHIGH schedule

Scheduled
Task

SapJ2eeApplicationServer SAPJ2EE_
Low

NA Runs the SAP J2EE
collector/analyzer Low
schedule

Scheduled
Task

SapJ2eeApplicationServer SAPJ2EE_
Medium

NA Runs the SAP J2EE
collector/analyzer every
MEDIUM schedule

Scheduled
Task

SapJ2eeApplicationServer SAPJ2EE_
High

NA Runs the SAP J2EE
collector/analyzer every 15min
with favorites metrics

Scheduled
Task

SapJ2eeApplicationServer SAPJ2EE_
Messages

NA SAP MP message template for
message interception.

Open
Message
Interface

SapJ2eeApplicationServer SAPJ2EE_
NWStatus

NA Status and availability of SAP
J2EE Application Server.

Scheduled
Task

SAP J2EE Application Thread Pool Performance

Monitors the performance of application thread pools of the SAP J2EE system. This Aspect supports
different metrics depending on the SAP versions.

CI Type

Policy
Templat
e Indicator

Descripti
on

Policy
Type

SapJ2eeApplicationSe
rver

SAPJ2E
E_0226

NA Min
Thread
Pool Size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0219

ApplicationThreadPoolUtilization:H
igh /
ApplicationThreadPoolUtilization:N
ormal

Applicatio
n Threads
pool -
Thread
pool
usage rate

Measurem
ent
Threshold

SapJ2eeApplicationSe
rver

SAPJ2E
E_0229

NA Waiting
Tasks

ConfigFile
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CI Type

Policy
Templat
e Indicator

Descripti
on

Policy
Type

Queue
Overflow.

SapJ2eeApplicationSe
rver

SAPJ2E
E_0031

NA Maximum
Applicatio
n threads
pool size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0227

ApplicationThreadPoolUtilization:H
igh /
ApplicationThreadPoolUtilization:N
ormal

Applicatio
n Threads
pool -
Thread
pool
capacity
rate

Measurem
ent
Threshold

SapJ2eeApplicationSe
rver

SAPJ2E
E_0221

NA Active
Threads
Count.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0034

NA Active
Applicatio
n threads
pool size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0033

NA Current
Applicatio
n threads
pool size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0036

NA Waiting
tasks
queue
size in the
Applicatio
n threads
pool.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0032

NA Initial
Applicatio
n threads
pool size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0223

NA Initial
Thread
Pool Size.

ConfigFile
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CI Type

Policy
Templat
e Indicator

Descripti
on

Policy
Type

SapJ2eeApplicationSe
rver

SAPJ2E
E_0225

NA Max
Waiting
Tasks
Queue
Size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0220

ApplicationThreadPoolUtilization:H
igh /
ApplicationThreadPoolUtilization:N
ormal

Applicatio
n Threads
pool -
Waiting
tasks
usage rate

Measurem
ent
Threshold

SapJ2eeApplicationSe
rver

SAPJ2E
E_0228

NA Waiting
Tasks
Count.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0222

NA Current
Thread
Pool Size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0224

NA Max
Thread
Pool Size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0218

ApplicationThreadPoolUtilization:H
igh /
ApplicationThreadPoolUtilization:N
ormal

Applicatio
n threads
pool -
Usage
rate

Measurem
ent
Threshold

SapJ2eeApplicationSe
rver

SAPJ2E
E_0030

NA Minimum
Applicatio
n threads
pool size.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0035

NA Waiting
tasks
count in
the
Applicatio
n threads
pool.

ConfigFile

SapJ2eeApplicationSe
rver

SAPJ2E
E_0037

NA Waiting
tasks

ConfigFile
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CI Type

Policy
Templat
e Indicator

Descripti
on

Policy
Type

queue
overflow
in the
Applicatio
n threads
pool.

SAP J2EE Cluster Manager - Message Server Communication Layer
Performance

Monitors themessage server communication layer in the cluster manager. This Aspect supports
different metrics depending on the SAP versions.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
0066

NA Total number of bytes
received from the
configurationManager
throughmessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0230

NA Averagemessage
processing time

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0081

NA Total number of bytes
received from deploy service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0041

NA Total number of bytes sent
from the cachemanager
throughmessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0062

NA Total number of bytes sent
from the servlet JSP service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0038

NA Current message context
pool size of the J2EE cluster

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
0051

NA Total number of bytes sent
from Telnet service through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0071

NA Total number of bytes
received from the IIOP port
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0053

NA Total number of bytes sent
from JMS provider through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0069

NA Total number of bytes
received from the internal
connection of the service
manager through the
message server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0045

NA Total number of bytes sent
from the IIOP port through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0087

NA Total number of bytes
received from webDYNPRO
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0057

NA Total number of bytes sent
from connector service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0074

NA Total number of bytes
received from the web
services through the
message server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0070

NA Total number of bytes
received from the P4 port
through themessage server
communication layer

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
0084

NA Total number of bytes
received from the specified
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0043

NA Total number of bytes sent
from the internal connection
of the servicemanager
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0078

NA Total number of bytes
received from JMX service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0047

NA Total number of bytes sent
from the shell service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0076

NA Total number of bytes
received from JMX
notification service through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0086

NA Total number of bytes
received from security
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0083

NA Total number of bytes
received from connector
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0050

NA Total number of bytes sent
from JMX notification service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0079

NA Total number of bytes
received from JMS provider
through themessage server
communication layer

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
0056

NA Total number of bytes sent
from naming service through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0085

NA Total number of bytes
received from the SAP
security core user
management engine service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0068

NA Total number of bytes
received from the Deploy
distributor of the service
manager throughmessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0088

NA Total number of bytes
received from the servlet
JSP service through the
message server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0080

NA Total number of bytes
received from HTTP port
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0072

NA Total number of bytes
received from the SLD
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0042

NA Total number of bytes sent
from the deploy distributor of
the servicemanager through
message server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0054

NA Total number of bytes sent
from HTTP port through the
message server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0075

NA Total number of bytes
received from the log

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

configurator through the
message server
communication layer

SapJ2eeApplicationServer SAPJ2EE_
0089

NA Total number of bytes
received from the RFC
engine service through the
message server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0049

NA Total number of bytes sent
from the log configurator
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0044

NA Total number of bytes sent
from the P4 port through the
message server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0040

NA Total number of bytes sent
from the Configuration
Manager throughmessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0090

NA Total number of bytes
received from the application
tracing service through the
message server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0060

NA Total number of bytes sent
from security service through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0055

NA Total number of bytes sent
from deploy service through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0048

NA Total number of bytes sent
from the web services
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_ NA Total number of bytes sent Measurement
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CI Type
Policy
Template Indicator Description Policy Type

0061 from webDYNPRO service
through themessage server
communication layer

Threshold

SapJ2eeApplicationServer SAPJ2EE_
0059

NA Total number of bytes sent
from the sap security core
user management engine
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0067

NA Total number of bytes
received from the cache
manager throughmessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0052

NA Total number of bytes sent
from JMX service through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0058

NA Total number of bytes sent
from the specified service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0046

NA Total number of bytes sent
from the SLD service through
themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0091

NA Total number of bytes
received from the
PRTBRIDGE service
through themessage server
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0082

NA Total number of bytes
received from naming
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0073

NA Total number of bytes
received from the shell
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_ NA Total number of bytes Measurement
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CI Type
Policy
Template Indicator Description Policy Type

0077 received from telnet service
through themessage server
communication layer

Threshold

SapJ2eeApplicationServer SAPJ2EE_
0065

NA Total number of bytes sent
from the PRTBRIDGE
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0064

NA Total number of bytes sent
from the application tracing
service through themessage
server communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0039

NA Averagemessage context
process time of the J2EE
cluster

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0063

NA Total number of bytes sent
from the RFC engine service
through themessage server
communication layer

Measurement
Threshold

SAP J2EE Cluster Manager - Session Communication Layer Performance

Monitors the session communication layer in the cluster manager. This Aspect supports different
metrics depending on the SAP versions.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
0106

NA Total number of bytes sent
from the IIOP service
through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0096

NA Current size of the HTTP
message queue in the
session communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0104

NA Total number of bytes sent
from the JMS provider
service through the session
communication layer

Measurement
Threshold
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Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
0103

NA Total number of bytes sent
from the HTTP service
through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0111

NA Total number of bytes
received from the JMS
provider service through the
session communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0097

NA Current size of the JMS
provider message queue in
the session communication
layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0109

NA Total number of bytes
received from the telnet
service through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0110

NA Total number of bytes
received from the HTTP
service through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0231

NA Average session processing
time

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0095

NA Current size of the telnet
message queue in the
session communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0102

NA Total number of bytes sent
from the telnet service
through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0105

NA Total number of bytes sent
from the web services
through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0094

NA Current size of the internal
message queue in the
session communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0092

NA Maximum session queue
size

Measurement
Threshold
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Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
0100

NA Total number of bytes sent
from the P4 port service
through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0093

NA Current size of the P4
message queue in the
session communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0098

NA Current size of the web
services message queue in
the session communication
layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0108

NA Total number of bytes
received from the internal
service through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0101

NA Total number of bytes sent
from the internal service
through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0099

NA Current size of the IIOP
message queue in the
session communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0113

NA Total number of bytes
received from the IIOP
service through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0107

NA Total number of bytes
received from the P4 port
service through the session
communication layer

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0112

NA Total number of bytes
received from the web
services through the session
communication layer

Measurement
Threshold

SAP J2EE Configuration

Collects configuration for J2EE application server CIs.
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CI Type Policy Template Indicator Description
Policy
Type

SapJ2eeApplicationServer SAPJ2EE_
Configuration

NA SAP J2EE Configuration
Details.

ConfigFile

SAP J2EE Configuration Manager and Class Loader Performance

Monitors the cache hit rate and commit duration parameters of the configurationManager and Class
loader count.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
0002

NA Commit
duration

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0233

CacheHitRate:High /
CacheHitRate:Normal

Configuration
manager -
Cache hit rate

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0234

NA Configuration
manager -
Commit
Duration

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0232

NA Class loader
count

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0001

CacheHitRate:High /
CacheHitRate:Normal,
CacheHitRate:High /
CacheHitRate:Normal

Cache hit rate Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0012

NA Class loader
count

Measurement
Threshold

SAP J2EE Connections Manipulator Performance

Monitors the number of connections for different ports in the connectionmanipulator. This Aspect
supports only SAP version 7.0 and SAP 7.0x.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_ NA Maximum possible ConfigFile
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CI Type
Policy
Template Indicator Description Policy Type

0021 connections in the
connections manipulator
(dispatcher).

SapJ2eeApplicationServer SAPJ2EE_
0015

NA P4 connections count of
connections manipulator
(dispatcher).

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0016

NA IIOP connections count of
connections manipulator
(dispatcher).

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0020

NA Free connections in the pool
of connections manipulator
(dispatcher).

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0013

NA Total connections count of
connections manipulator
(dispatcher)

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
0018

NA Telnet connections count of
connections manipulator
(dispatcher).

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0014

NA HTTP connections count of
connections manipulator
(dispatcher).

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0017

NA JMS connections count of
connections manipulator
(dispatcher).

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0019

NA Other connections count of
connections manipulator
(dispatcher).

ConfigFile

SAP J2EE Connector Service Performance

Monitors themanaged connections for different resource adapters.This Aspect supports only SAP
version 7.0 and SAP 7.0x.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2116

NA Number of freemanaged
connections from ADS

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

resource adapter

SapJ2eeApplicationServer SAPJ2EE_
2063

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_FO resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2077

NA Number of usedmanaged
connections from SAP/CAF_
EUP_ER resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2093

NA Number of usedmanaged
connections from SAP/BC_
SLM resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2127

NA Maximum number of
managed connections
simultaneously opened from
the SDK_SAPQ resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2075

NA Maximum number of
managed connections
simultaneously opened from
the SAP/CAF_EUP_ER
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2021

NA Number of usedmanaged
connections from
SAPSR3DB resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2131

NA Maximum number of
managed connections
simultaneously opened from
the SDK_XMLA resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2040

NA Number of freemanaged
connections from SAP/CAF_
RT resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2128

NA Number of freemanaged
connections from SDK_
SAPQ resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_ NA Number of freemanaged Measurement
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CI Type
Policy
Template Indicator Description Policy Type

2092 connections from SAP/BC_
SLM resource adapter

Threshold

SapJ2eeApplicationServer SAPJ2EE_
2130

NA Number of clients waiting for
pooledmanaged connections
for SDK_SAPQ resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2028

NA Number of freemanaged
connections from SAP/BC_
MIGSERVICE resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2024

NA Number of freemanaged
connections from SAP/EP_
PRT resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2129

NA Number of usedmanaged
connections from SDK_
SAPQ resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2094

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_SLM resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2096

NA Number of freemanaged
connections from
SAP/LOCAL_
MAINFRAME_POOL
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2115

NA Maximum number of
managed connections
simultaneously opened from
the ADS resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2103

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_JDO resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2039

NA Maximum number of
managed connections
simultaneously opened from
the SAP/CAF_RT resource

Measurement
Threshold
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Policy
Template Indicator Description Policy Type

adapter

SapJ2eeApplicationServer SAPJ2EE_
2110

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_UDDI resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2109

NA Number of usedmanaged
connections from SAP/BC_
UDDI resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2126

NA Number of clients waiting for
pooledmanaged connections
for SDK_CAF resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2053

NA Number of usedmanaged
connections from
SAP/CAF/EUP_GP/MAIL_
CF resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2056

NA Number of freemanaged
connections from SAP/BC_
UME resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2105

NA Number of usedmanaged
connections from SAP/BC_
JDO resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2023

NA Maximum number of
managed connections
simultaneously opened from
the SAP/EP_PRT resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2135

NA Maximum number of
managed connections
simultaneously opened from
the SDK_ODBO resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2133

NA Number of usedmanaged
connections from SDK_
XMLA resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2068

NA Number of freemanaged
connections from SAP/BC_
XMLA resource adapter

Measurement
Threshold
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Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2120

NA Number of freemanaged
connections from SDK_
JDBC resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2019

NA Maximum number of
managed connections
simultaneously opened from
the SAPSR3DB resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2027

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_MIGSERVICE
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2091

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_SLM resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2104

NA Number of freemanaged
connections from SAP/BC_
JDO resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2035

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_WDRR
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2038

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_WDRR
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2044

NA Number of freemanaged
connections from SAP/BW_
MMR resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2042

NA Number of clients waiting for
pooledmanaged connections
for SAP/CAF_RT resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_ NA Number of clients waiting for Measurement
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Policy
Template Indicator Description Policy Type

2034 pooledmanaged connections
for SAP/CAF_EUP_GP
resource adapter

Threshold

SapJ2eeApplicationServer SAPJ2EE_
2138

NA Number of clients waiting for
pooledmanaged connections
for SDK_ODBO resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2049

NA Number of usedmanaged
connections from SAP/EP_
DQE resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2051

NA Maximum number of
managed connections
simultaneously opened from
the SAP/CAF/EUP_
GP/MAIL_CF resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2057

NA Number of usedmanaged
connections from SAP/BC_
UME resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2052

NA Number of freemanaged
connections from
SAP/CAF/EUP_GP/MAIL_
CF resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2085

NA Number of usedmanaged
connections from SAP/BC_
ADM resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2025

NA Number of usedmanaged
connections from SAP/EP_
PRT resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2061

NA Number of usedmanaged
connections from SAP/BC_
JMS resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2098

NA Number of clients waiting for
pooledmanaged connections
for SAP/LOCAL_
MAINFRAME_POOL
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_ NA Number of freemanaged Measurement
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Template Indicator Description Policy Type

2108 connections from SAP/BC_
UDDI resource adapter

Threshold

SapJ2eeApplicationServer SAPJ2EE_
2066

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_FO resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2058

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_UME resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2050

NA Number of clients waiting for
pooledmanaged connections
for SAP/EP_DQE resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2113

NA Number of usedmanaged
connections from UTDB
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2031

NA Maximum number of
managed connections
simultaneously opened from
the SAP/CAF_EUP_GP
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2132

NA Number of freemanaged
connections from SDK_
XMLA resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2036

NA Number of freemanaged
connections from SAP/BC_
WDRR resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2082

NA Number of clients waiting for
pooledmanaged connections
for SAP/EP_PCD resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2100

NA Number of freemanaged
connections from SAP/BC_
SLD resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2074

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_MON resource

Measurement
Threshold
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Template Indicator Description Policy Type

adapter

SapJ2eeApplicationServer SAPJ2EE_
2073

NA Number of usedmanaged
connections from SAP/BC_
MON resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2043

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BW_MMR resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2055

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_UME resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2102

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_SLD resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2097

NA Number of usedmanaged
connections from
SAP/LOCAL_
MAINFRAME_POOL
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2095

NA Maximum number of
managed connections
simultaneously opened from
the SAP/LOCAL_
MAINFRAME_POOL
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2121

NA Number of usedmanaged
connections from SDK_
JDBC resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2125

NA Number of usedmanaged
connections from SDK_CAF
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2048

NA Number of freemanaged
connections from SAP/EP_
DQE resource adapter

Measurement
Threshold
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SapJ2eeApplicationServer SAPJ2EE_
2122

NA Number of clients waiting for
pooledmanaged connections
for SDK_JDBC resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2020

NA Number of freemanaged
connections from
SAPSR3DB resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2029

NA Number of usedmanaged
connections from SAP/BC_
MIGSERVICE resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2076

NA Number of freemanaged
connections from SAP/CAF_
EUP_ER resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2047

NA Maximum number of
managed connections
simultaneously opened from
the SAP/EP_DQE resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2037

NA Number of usedmanaged
connections from SAP/BC_
WDRR resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2032

NA Number of freemanaged
connections from SAP/CAF_
EUP_GP resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2078

NA Number of clients waiting for
pooledmanaged connections
for SAP/CAF_EUP_ER
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2088

NA Number of freemanaged
connections from SAP/CAF_
BW_RT resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2041

NA Number of usedmanaged
connections from SAP/CAF_
RT resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2124

NA Number of freemanaged
connections from SDK_CAF

Measurement
Threshold
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Policy
Template Indicator Description Policy Type

resource adapter

SapJ2eeApplicationServer SAPJ2EE_
2080

NA Number of freemanaged
connections from SAP/EP_
PCD resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2112

NA Number of freemanaged
connections from UTDB
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2062

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_JMS resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2123

NA Maximum number of
managed connections
simultaneously opened from
the SDK_CAF resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2099

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_SLD resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2059

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_JMS resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2054

NA Number of clients waiting for
pooledmanaged connections
for SAP/CAF/EUP_
GP/MAIL_CF resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2106

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_JDO resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2046

NA Number of clients waiting for
pooledmanaged connections
for SAP/BW_MMR resource

Measurement
Threshold
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Template Indicator Description Policy Type

adapter

SapJ2eeApplicationServer SAPJ2EE_
2111

NA Maximum number of
managed connections
simultaneously opened from
the UTDB resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2136

NA Number of freemanaged
connections from SDK_
ODBO resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2134

NA Number of clients waiting for
pooledmanaged connections
for SDK_XMLA resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2119

NA Maximum number of
managed connections
simultaneously opened from
the SDK_JDBC resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2030

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_MIGSERVICE
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2071

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_MON resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2060

NA Number of freemanaged
connections from SAP/BC_
JMS resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2064

NA Number of freemanaged
connections from SAP/BC_
FO resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2026

NA Number of clients waiting for
pooledmanaged connections
for SAP/EP_PRT resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2084

NA Number of freemanaged
connections from SAP/BC_

Measurement
Threshold
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Template Indicator Description Policy Type

ADM resource adapter

SapJ2eeApplicationServer SAPJ2EE_
2118

NA Number of clients waiting for
pooledmanaged connections
for ADS resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2069

NA Number of usedmanaged
connections from SAP/BC_
XMLA resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2065

NA Number of usedmanaged
connections from SAP/BC_
FO resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2067

NA Maximum number of
managed connections
simultaneously opened from
the SAP/BC_XMLA resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2045

NA Number of usedmanaged
connections from SAP/BW_
MMR resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2033

NA Number of usedmanaged
connections from SAP/CAF_
EUP_GP resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2101

NA Number of usedmanaged
connections from SAP/BC_
SLD resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2070

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_XMLA resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2022

NA Number of clients waiting for
pooledmanaged connections
for SAPSR3DB resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2079

NA Maximum number of
managed connections
simultaneously opened from
the SAP/EP_PCD resource
adapter

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2081

NA Number of usedmanaged
connections from SAP/EP_
PCD resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2137

NA Number of usedmanaged
connections from SDK_
ODBO resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2090

NA Number of clients waiting for
pooledmanaged connections
for SAP/CAF_BW_RT
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2086

NA Number of clients waiting for
pooledmanaged connections
for SAP/BC_ADM resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2114

NA Number of clients waiting for
pooledmanaged connections
for UTDB resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2089

NA Number of usedmanaged
connections from SAP/CAF_
BW_RT resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2072

NA Number of freemanaged
connections from SAP/BC_
MON resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2107

NA Maximum Number of
managed connections
simultaneously opened from
the SAP/BC_UDDI resource
adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2117

NA Number of usedmanaged
connections from ADS
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2087

NA Maximum Number of
managed connections
simultaneously opened from
the SAP/CAF_BW_RT
resource adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2083

NA Maximum Number of
managed connections

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

simultaneously opened from
the SAP/BC_ADM resource
adapter

SAP J2EE Discovery

Discovers the various JAVA instances in the SAP landscape.

CI Type Policy Template Indicator Description Policy Type

Computer SAPJ2EE_
Discovery

NA SAPMP J2EE Discovery
policy.

Service Auto-
Discovery

SAP J2EE EJB Performance

Monitors the performance of the session statefull beans, stateless beans , message driven beans and
entity beans. This Aspect supports only SAP version 7.0 and SAP 7.0x.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2159

NA Initial number of bean
instances that will be created
in the pool

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2151

NA Number of bean instances
that this pool can hold

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2164

NA Number of bean instances
provided by this pool, which
are currently used by the
application or are stored in
the pool

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2147

NA Number of times a bean
instance has been activated

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2146

NA Number of times a bean
instance has been
passivated

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2169

NA Number of times a bean
instance has been

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

passivated

SapJ2eeApplicationServer SAPJ2EE_
2148

NA Number of times a bean has
been created

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2167

NA The number by which the
total number of instances in
the pool will be incremented
each time a new instance is
requested and there are no
idle instances in the pool.
The value of this element
must be positive.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2157

NA Number of bean instances
provided by this pool, which
are currently used by the
application or are stored in
the pool.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2161

NA Number of bean instances
provided by this pool which
are currently used by this
application.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2142

NA Number of bean sessions
that are currently passivated

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2154

NA Number of bean instances
provided by this pool which
are currently used by this
application

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2170

NA Number of times a bean
instance has been activated

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2139

NA The time in seconds after
which an idle active session
is passivated

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2166

NA Initial number of bean
instances that will be created
in the pool

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2155

NA Number of times a bean has
been created

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_ NA Number of times a bean and Measurement
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CI Type
Policy
Template Indicator Description Policy Type

2163 its session has been
removed

Threshold

SapJ2eeApplicationServer SAPJ2EE_
2149

NA Number of times a bean and
its session has been
removed

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2165

NA Number of bean instances
that this pool can hold

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2145

NA Number of times a bean and
its session has been
removed

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2140

NA The period in seconds since
the bean's passivation, after
which the EJB container
clears the session bean's
instance from the swap and
destroys the session.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2158

NA Number of bean instances
that this pool can hold.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2168

NA Number of bean instances
provided by this pool which
are currently used by this
application.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2150

NA Number of bean instances
provided by this pool, which
are currently used by the
application or are stored in
the pool.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2152

NA Initial number of bean
instances that will be created
in the pool

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2143

NA Number of completed
sessions

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2141

NA Number of active bean
sessions

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2156

NA Number of times a bean and
its session has been
removed

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2153

NA The number by which the
total number of instances in
the pool will be incremented
each time a new instance is
requested and there are no
idle instances in the pool.
The value of this element
must be positive.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2162

NA Number of times a bean has
been created

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2160

NA The number by which the
total number of instances in
the pool will be incremented
each time a new instance is
requested and there are no
idle instances in the pool.
The value of this element
must be positive.

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2144

NA Number of times a bean has
been created.

Measurement
Threshold

SAP J2EE Http Provider Performance

Monitors the performance of requests in the HTTP provider. This Aspect supports different metrics
depending on the SAP versions.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2014

NA Number of skipping requests
of the open connections in
the HTTP provider

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2215

NA All Requests Count. ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2216

NA HTTP provider - Active
threads count

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2018

NA Average request response
time of the HTTP provider

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2186

NA Total number of all requests
in the HTTP provider.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2017

NA Total count of requests in the
HTTP provider.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2217

NA HTTP provider - Threads in-
process rate

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2012

NA Number of reading requests
of the open connections in
the HTTP provider

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2011

NA Total count of the open
connections of the HTTP
provider

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2013

NA Number of reading response
of the open connections in
the HTTP provider

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2016

NA Average rate of requests per
connection in the HTTP
provider

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2015

NA Number of Keep Alive
waiting connections of the
HTTP provider

Measurement
Threshold

SAP J2EE JMS Performance

Monitors the JMS session container. This Aspect supports versions starting from SAP 7.1

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2207

NA JMS Session container -
Connections count

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2208

NA JMS Session container -
Consumer count

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2209

NA JMS Session container -
Producers count

Measurement
Threshold
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SAP J2EE JMX Adapter Performance

Monitors the JMX Adapter protocol.This Aspect supports different metrics depending on the SAP
versions.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2229

NA JMX Adapter - Local MBean
Repository size of JMX
Adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2001

NA Maximum entries in the JMX
Adapter cache

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2228

NA JMX Adapter - Cluster wide
notification listeners

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2006

NA Active threads in the
notification queue of JMX
Adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2002

NA Current entries in the JMX
Adapter cache

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2003

NA Replaced entries in the JMX
Adapter cache

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2004

NA Cache hit rate of the JMX
Adapter

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2005

NA Notification queue size of the
JMX Adapter

Measurement
Threshold

SAP J2EE JNDI Registry Status

Monitors the JNDI registry.This Aspect supports versions starting from SAP 7.1.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2231

NA JNDI Registry - Byte
Array Cache size

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2230

NA JNDI Registry - Bound
objects count

Measurement
Threshold
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SAP J2EE Log Configurator Performance

Monitors the log file size and status of themessages in the log configurator. This Aspect supports
different metrics depending on the SAP versions.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2213

NA Number of error messages in
the Log Configurator.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2211

NA Number of all logged
messages in the Log
Configurator.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2007

NA Total log file size in the Log
Configurator

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2210

NA Log Configurator - Total log
file size

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2214

NA Number of fatal messages in
the Log Configurator.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2212

NA Number of warning
messages in the Log
Configurator.

ConfigFile

SAP J2EE Memory Status

Monitors the status of J2EE memory and time out parameter of SAP system. This Aspect supports
different metrics depending on the SAP versions.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2010

NA UsedMemory. ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2201

NA AllocatedMemory. ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2203

NA Usedmemory. ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2202

NA Available Memory. ConfigFile
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CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2008

NA AllocatedMemory. ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2204

NA Timeout - Estimated
frequency per minute

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2009

NA Available Memory. ConfigFile

SAP J2EE P4 and IIOP Provider Performance

Monitors the performance of P4 and IIOP service providers. This Aspect supports different metrics
depending on the SAP versions.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2227

NA IIOP Provider - Thread
usage rate

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2218

NA P4 provider - Failed
requests count

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2219

NA P4 provider - Thread
usage rate

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2220

NA RequestsCount. ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2185

NA Number of requests in the
P4 provider.

ConfigFile

SAP J2EE Ports Manager Performance

Monitors the accepting threads usage for different ports. This Aspect supports only SAP version 7.0
and SAP 7.0x.

CI Type
Policy
Template Indicator Description

Policy
Type

SapJ2eeApplicationServer SAPJ2EE_
0007

NA Accepting threads usage rate of
P4 port.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_ NA Accepting threads usage rate of ConfigFile
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CI Type
Policy
Template Indicator Description

Policy
Type

0006 IIOP (SSL) port.

SapJ2eeApplicationServer SAPJ2EE_
0011

NA Accepting threads usage rate of
JMS provider.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0009

NA Accepting threads usage rate of
P4 (SSL) port.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0005

NA Accepting threads usage rate of
IIOP port.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0003

NA Accepting threads usage rate of
HTTP port.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0010

NA Accepting threads usage rate of
Telnet.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0004

NA Accepting threads usage rate of
HTTP (SSL) port.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
0008

NA Accepting threads usage rate of
P4 (HTTP Tunneling) port.

ConfigFile

SAP J2EE Sessions Manager Performance

Monitors the status and performance of sessions and session aggregated data. This Aspect supports
different metrics depending on the SAP versions.

CI Type

Policy
Templat
e Indicator

Descriptio
n

Policy
Type

SapJ2eeApplicationS
erver

SAPJ2E
E_2232

UnsuccessfulLogonAttemptsRate:
High /
UnsuccessfulLogonAttemptsRate:
Normal

Security -
Unsuccess
ful logon
attempts

Measurem
ent
Threshold

SapJ2eeApplicationS
erver

SAPJ2E
E_2182

NA Number of
timed out
sessions in
the
security
server.

ConfigFile

SapJ2eeApplicationS
erver

SAPJ2E
E_0204

NA Sessions
manager -

Measurem
ent
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CI Type

Policy
Templat
e Indicator

Descriptio
n

Policy
Type

Active web
sessions
count

Threshold

SapJ2eeApplicationS
erver

SAPJ2E
E_2184

NA Number of
logged off
sessions in
the
security
server.

ConfigFile

SapJ2eeApplicationS
erver

SAPJ2E
E_0202

NA Opened
Web
Sessions
Count.

ConfigFile

SapJ2eeApplicationS
erver

SAPJ2E
E_2180

NA Number of
active
sessions in
the
security
server.

ConfigFile

SapJ2eeApplicationS
erver

SAPJ2E
E_2183

NA Number of
invalid
sessions in
the
security
server.

ConfigFile

SapJ2eeApplicationS
erver

SAPJ2E
E_2181

NA Total
number of
sessions in
the
security
server.

ConfigFile

SapJ2eeApplicationS
erver

SAPJ2E
E_0205

NA Sessions
manager -
Number of
logged in
users

Measurem
ent
Threshold

SapJ2eeApplicationS
erver

SAPJ2E
E_0201

NA Opened
security
sessions

ConfigFile
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CI Type

Policy
Templat
e Indicator

Descriptio
n

Policy
Type

count.

SapJ2eeApplicationS
erver

SAPJ2E
E_0203

NA Opened
EJB
sessions
count.

ConfigFile

SAP J2EE System Thread Pool Performance

Monitors the performance of Java Application Response timeMeasurement requests.

CI Type
Policy
Template Indicator

Descripti
on

Policy
Type

SapJ2eeApplicationSer
ver

SAPJ2E
E_0215

SystemThreadPoolUtilization:Hi
gh /
SystemThreadPoolUtilization:No
rmal

System
Threads
pool -
Thread
pool
capacity
rate

Measureme
nt
Threshold

SapJ2eeApplicationSer
ver

SAPJ2E
E_0024

NA Initial
System
threads
pool size.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0027

NA Waiting
tasks
count in
the
System
threads
pool.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0028

NA Waiting
tasks
queue size
in the
System
threads
pool.

ConfigFile

SapJ2eeApplicationSer SAPJ2E NA Current ConfigFile
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CI Type
Policy
Template Indicator

Descripti
on

Policy
Type

ver E_0025 System
threads
pool size.

SapJ2eeApplicationSer
ver

SAPJ2E
E_0214

NA Min
Thread
Pool Size.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0022

NA Minimum
System
threads
pool size.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0208

NA System
Threads
pool -
Waiting
tasks
usage rate

Measureme
nt
Threshold

SapJ2eeApplicationSer
ver

SAPJ2E
E_0206

SystemThreadPoolUtilization:Hi
gh /
SystemThreadPoolUtilization:No
rmal

System
Threads
pool -
Usage rate

Measureme
nt
Threshold

SapJ2eeApplicationSer
ver

SAPJ2E
E_0207

NA System
Threads
pool -
Thread
pool usage
rate

Measureme
nt
Threshold

SapJ2eeApplicationSer
ver

SAPJ2E
E_0211

NA Initial
Thread
Pool Size.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0023

NA Maximum
System
threads
pool size.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0029

NA Waiting
tasks
queue
overflow in
the
System

ConfigFile
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CI Type
Policy
Template Indicator

Descripti
on

Policy
Type

threads
pool.

SapJ2eeApplicationSer
ver

SAPJ2E
E_0209

NA Active
Threads
Count.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0026

NA Active
thread
count in
the
System
threads
pool.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0212

NA Max
Thread
Pool Size.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0213

NA Max
Waiting
Tasks
Queue
Size.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0217

NA Waiting
Tasks
Queue
Overflow.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0210

NA Current
Thread
Pool Size.

ConfigFile

SapJ2eeApplicationSer
ver

SAPJ2E
E_0216

NA Waiting
Tasks
Count.

ConfigFile

SAP J2EE Transaction Status

Monitors the status of different types of transactions.This Aspect supports versions starting from SAP
7.1.
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CI Type

Policy
Templa
te Indicator Description

Policy
Type

SapJ2eeApplicatio
nServer

SAPJ2
EE_
2221

NA CommittedTransaction
sCount.

ConfigFil
e

SapJ2eeApplicatio
nServer

SAPJ2
EE_
2223

NA RolledBackTransactio
nsCount.

ConfigFil
e

SapJ2eeApplicatio
nServer

SAPJ2
EE_
2224

NA SuspendedTransaction
sCount.

ConfigFil
e

SapJ2eeApplicatio
nServer

SAPJ2
EE_
2222

NA OpenTransactionsCou
nt.

ConfigFil
e

SapJ2eeApplicatio
nServer

SAPJ2
EE_
2226

J2EETransactionSuccessR
ate:Low /
J2EETransactionSuccessR
ate:Normal

Transaction - Success
Rate

Measure
ment
Threshold

SapJ2eeApplicatio
nServer

SAPJ2
EE_
2225

NA TimedOutTransactions
Count.

ConfigFil
e

SAP J2EE Web Container Performance

Monitors the performance of web container.This Aspect supports different metrics depending on the
SAP versions.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2188

NA Number of current security
sessions in the web
container

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2190

NA Number of timed out security
sessions in the web
container

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2189

NA Number of timed out HTTP
sessions in the web
container

Measurement
Threshold
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CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2187

NA Number of current HTTP
sessions in the web
container

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2206

NA AllRequestsCount. ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2191

NA Total number of all requests
in the web container.

ConfigFile

SapJ2eeApplicationServer SAPJ2EE_
2205

NA Web container - Average
processing time

Measurement
Threshold

SAP J2EE Web Services Performance

Monitors the performance of requests for various services.This Aspect supports only SAP version 7.0
and SAP 7.0x.

CI Type
Policy
Template Indicator Description Policy Type

SapJ2eeApplicationServer SAPJ2EE_
2172

NA Number of requests that
have failed for any reason

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2175

NA Implementation time for the
service

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2178

NA Implementation time for the
service

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2174

NA Pre-processing time for the
service

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2179

NA Post-processing time for the
service

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2177

NA Pre-processing time for the
service

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2171

NA Number of successfully
passed requests

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2176

NA Post-processing time for the
service

Measurement
Threshold

SapJ2eeApplicationServer SAPJ2EE_
2173

NA Number of currently
processed requests

Measurement
Threshold
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SAP JARM Requests Performance

Monitors the performance of Java Application Response timeMeasurement requests.

CI Type

Policy
Templat
e Indicator

Descripti
on

Policy
Type

SapJ2eeApplication
Server

SAPJ2E
E_4001

NA Number
of jarm
requests

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4005

JARMRequestsAverageCPUTime:Hig
h /
JARMRequestsAverageCPUTime:Nor
mal

Average
CPU time
for jarm
requests

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4206

NA Number
of
requests

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4002

NA Number
of jarm
requests
per
second

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4003

NA Number
of
compone
nt calls
by all
jarm
requests

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4004

JARMRequestsAverageResponseTim
e:High /
JARMRequestsAverageResponseTim
e:Normal

Average
response
time of
jarm
requests

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4205

NA Number
of
compone
nt calls

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4201

JARMRequestsAverageResponseTim
e:High /

Average
response

Measurem
ent
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CI Type

Policy
Templat
e Indicator

Descripti
on

Policy
Type

JARMRequestsAverageResponseTim
e:Normal

time of
J2EE
Engine

Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4204

NA Average
out bound
data

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4202

NA Requests
per
second

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4006

NA Average
outbound
data for
jarm
requests

Measurem
ent
Threshold

SapJ2eeApplication
Server

SAPJ2E
E_4203

JARMRequestsAverageCPUTime:Hig
h /
JARMRequestsAverageCPUTime:Nor
mal

Average
CPU time

Measurem
ent
Threshold

SAP ABAP Monitoring Templates

TheOMi MP for SAP contains a set of SAP ABAP Monitoring Templates which you configure to run at
regular intervals to collect information regarding various Aspects of ABAP Application Servers in your
SAP Environment.

TheOMi MP for SAP enables you to extensively customize the SAP ABAP Monitoring Templates to
suit your monitoring requirements. Each SAP ABAP Monitoring Template enables you tomonitor a set
of functionality of the ABAP Application Server and has a set of keywords that can be configured to
monitor a specific functionality.

Eachmonitoring template provided with the OMi MP for SAP defines default settings by using
keywords. Some keywords can only be used with specific SAP ABAP Monitoring Templates.

How to Access SAP ABAP Monitoring Templates

1. Open SAP ABAP Monitoring Templates:
On BSM 9.2x, click Admin > Operations Management > Monitoring > Policy Templates.
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OnOMi 10.x, click Administration > Monitoring > Policy Templates.

2. In the Policy Templates Group pane:

On BSM 9.2x, click Policy Templates by group> SAP ABAP Monitoring Templates.

OnOMi 10.x, click Policy Management > Templates grouped by type >
SAP ABAP Monitoring.

Remote Monitoring with SAP ABAP Monitoring

Templates

The SAP ABAP Monitoring Templates extends the scope of monitoring ABAP Application Servers by
enabling you tomonitor SAP ABAP Application Servers on nodes which does not haveOperations
Agent installed. You set up and perform the remotemonitoring of ABAP Application Servers from a
node where Operations Agent is installed andOMi MP for SAP Management Templates are deployed.

Tomake use of the remote-monitoring feature provided by the OMi MP for SAP, for example, to monitor
an SAP System running in an environment that is not supported by the OMi MP for SAP, you need to
perform the following actions. Specifying Individual Remote Servers toMonitor shows how a new line
is required for each additional SAP server, which you want to monitor remotely.

l Enable theRemoteMonitoring keyword by removing the leading hash symbol “#” in eachmonitor’s
configuration file.

l Define the name of the local host, on which you want to perform themonitoring. Note that you need
a new line for each local host that you want to associate with a remote host.

l Define the name of the remote SAP server (RemoteHost), which you want to monitor.

l Make sure that the remote host is configured with SAP ABAP Configuration Aspect.

The RemoteMonitoring keyword accepts the following parameters:

l LocalHost

This is the name of the local OMi MP for SAP managed node (where Agent is installed) with which
you want to remotely monitor the SAP server defined in the parameter “RemoteHost”.

l RemoteHost

This is the name of the remote SAP server you want to monitor from the host defined in the
parameter “LocalHost”.
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l SAP System and SAP Number (SAPABAP_CCMSIntegrationMon only)

The SAPABAP_CCMSIntegrationMonMonitoring Template needs to know both the ID and the
Number of the SAP System running on the SAP server defined in the parameter “RemoteHost”.

Specifying Individual Remote Servers to Monitor

#------------------------------------------------------------

# Remote LocalHost RemoteHost

# Monitoring

RemoteMonitoring =sap1 =sdsap1

RemoteMonitoring =sap1 =sdsap2

RemoteMonitoring =sap2 =sdsap3

#------------------------------------------------------------

Formore information about configuring RemoteMonitoring for SAPABAP_CCMSIntegrationMon, see
"SAPABAP_CCMSIntegrationMon".

SAPABAP_BatJobMon

The SAPABAP_BatJobMon enables monitoring of SAP ABAP Batch jobs that are exceeding the
defined time interval, closed before the defined time interval, and not started at the scheduled time.

The job-report alert monitor SAPABAP_BatJobMon identifies and reports on batch jobs for the following
conditions:

l A batch job’s run time is either less than or has exceeded a specified limit.

l A specified period of time passes between a batch job’s scheduled and actual start time (and date).

l A batch job has aborted.

Note:You cannot configure SAPABAP_BatJobMon to sendmultiple messages, for example, first
send aWARNINGmessage if the run time for a batch job exceeds 5minutes and then send a
CRITICALmessage if the run time for the same batch job exceeds 10minutes.

The SAP ABAP Monitoring Template SAPABAP_BatJobMon references:
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l Reports created using SAP NetWeaver transaction SM36 or SM38.

l Job details including ID number using SAP NetWeaver transaction SM37.

Monitor Type

The SAPABAP_BatJobMonMonitoring Template is of type time frame. One run gathers only one value
set.

Alert Types

The SAPABAP_BatJobMonMonitoring Template has the following alert types. Note that if you want to
use the SAPABAP_BatJobMonMonitoring Template, youmust configure the alert types listed below:

l JOB_MAX_RUN_TIME

Defines themaximum allowed run time for a job. SAPABAP_BatJobMonMonitoring Template
sends an alert if the defined job runs for longer than themaximum defined time, specified in
minutes.

l JOB_MIN_RUN_TIME

Defines theminimum allowed run time for a job. SAPABAP_BatJobMonMonitoring Template
sends an alert if the defined job does not run for at least as long as the defined time, specified in
minutes.

l START_PASSED

It is themaximum allowed delay between scheduled and actual start time for a defined job.
SAPABAP_BatJobMonMonitoring Template triggers an alert if the job does not start within the defined
time, specified in minutes.

l JOB_ABORTED

SAPABAP_BatJobMonMonitoring Template sends an alert whenever the jobs specified in its
configuration fail to complete successfully.

First Time Monitoring

Whenmonitoring batch job alerts for a particular alert type for the first time, the Job-report monitor
SAPABAP_BatJobMonMonitoring Template checks for the following conditions in SAP:

l Jobs which are not yet scheduled to run

l Jobs which ended within the previous two days
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l Jobs which are still running

Performance Aspects

On a production system, the SAP standard table tbtco is usually very big. To speed up the database
selection, you should specify the job names in as much detail as possible. For more information about
themeaning of the query conditions in the SAP ABAP Monitoring Template Configuration, see "Query
Conditions for Monitoring Templates".

The runtime cost of a job selection grows in the order shown in the following table:

Specified Jobname Sign Option Selection

JOBNAME I EQ Z5_CRITICAL_JOB_1> select via index

JOBNAME I CP Z5_CRITICAL_JOB*> select via index

JOBNAME E CP Z5_CRITICAL_JOB*> sequential scan

Note:Exclude options tend to bemore expensive than include options in performance terms.
Using wild cards such as “*” in general database queries is more expensive than in explicit queries.

File Locations

The SAPABAP_BatJobMonMonitoring Template uses the files listed in this table:

File Description

r3moncol (.exe) Collector executable for the batch jobmonitor

r3monjob.cfg Configuration file for monitored jobs and job conditions.

r3monjob.log Trace file for storing trace data.

The SAPABAP_BatJobMonMonitoring Template do not write history information to a specific history file.
For more information, see "SAP ABAP Monitoring Templates, Monitoring Template Configuration Files,
and History Files".

Environment Variables

The SAPABAP_BatJobMonMonitoring Template uses the environment variables described in
Environment Variables.

Command-Line Parameters

The SAPABAP_BatJobMonMonitoring Template uses the command-line parameters described in
Command Line Parameters.

Remote Monitoring
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Formore information about configuring the SAPABAP_BatJobMonMonitoring Template tomonitor
another SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

Configuring Job-Report Monitor Alert Types

You can configure SAPABAP_BatJobMonMonitoring Template, the job-report monitor, for each of the
listed alert types for a specific job, a combination of jobs, or for all jobs. You can also define exceptions
for jobs that need different monitoring conditions. Note that the general rules for using exclude and
include parameter values, which are of particular importance for these alert types.

Try to avoid using select option CP with the JOBNAME parameter because CP slows down the
selection process. If you do use CP, try to limit its scope, for example, instead of specifying CP *,
specify CP SAP*.

Parameter Values

This section describes how theOMi MP for SAP interprets include and exclude parameter values for an
alert type entry. TheOMi MP for SAP compares values in different parameters using ‘and’; the OMi MP
for SAP compares values in the same parameter as follows.

l Include: use ‘or’ to compare the parameters

l Exclude: use ‘and’ to compare the parameters

TheOMi MP for SAP evaluates include values before exclude values, as shown in the following table:

Select
Options

Alert Type:JOB_MAX_RUN_TIME
Example Configuration of Select
Options Comparison

1 =JOBNAME =I =CP =ZREP* =
=MAX_RUNTIME =I =GT =10 =

OR

2 =JOBNAME =I =CP =SAP* =
=MAX_RUNTIME =I =GT =20 =

OR

3 =JOBNAME =E =CP =SAP_ZREP*
=

AND

JOB_MAX_RUN_TIME

The JOB_MAX_RUN_TIME alert type defines themaximum allowed run time for a job. Use the JOB_
MAX_RUN_TIME alert type to configure the job-report SAPABAP_BatJobMonMonitoring Template to
generate an alert when a job exceeds the value configured in the parameter MAX_RUNTIME.

The following table lists, the parameters that you can use to configure the JOB_MAX_RUN_TIME alert
type and shows the value assigned to the parameters by default. The configuration of any of the
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parameters listed in this table is optional. If both parameters are omitted, SAPABAP_BatJobMon
Monitoring Template reports all jobs running in the specified time.

Parameter
Name Description Query Conditions

Default
Value

JOBNAME Name of the jobs tomonitor = Sign: I, E I

= Opt: EQ, CP, BT CP

= Low <Name of job> *

= High (Only for use with a range)

MAX_
RUNTIME

Job run time inminutes
which, if exceeded,
generates an alert.

= Sign I, E I

= Opt: EQ, GE, GT, BT GT

= Low (Specify this parameter as a
number. Otherwise themonitor ends with
a dump.)

5

= High (Only for use with a range)

The following examples illustrates both the default and a customized configuration for the JOB_MAX_
RUN_TIME alert type.

l Default JOB_MAX_RUN_TIME Configuration

In Default JOB_MAX_RUN_TIME Configuration, an event generating an alert occurs if any report
named <jobname>* has a runtime exceeding fiveminutes.

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1 \

=WARNING =MaxRunTime =R3_Jobs\

=JOB_MAX_RUN_TIME =JOBNAME =I =CP =<jobname>* =\

=MAX_RUNTIME =I =GT =5 =

l Customized JOB_MAX_RUN_TIME Configuration

In Customized JOB_MAX_RUN_TIME Configuration, an event generating an alert occurs if all the
reports named SAP*, except reports SAPZ*, have a runtime exceeding tenminutes.

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1\

=WARNING =MaxRunTime =R3_Jobs \

=JOB_MAX_RUN_TIME =JOBNAME =I =CP =SAP* = \

=MAX_RUNTIME =I =GT =10 =
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AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1\

=WARNING =MaxRunTime =R3_Jobs \

=JOB_MAX_RUN_TIME =JOBNAME =E =CP =SAPZ* = \

=MAX_RUNTIME =I =GT =10 =

TheOMi MP for SAP optional test transport includes a program that you can run to start a long-running
job. You can use the job to verify that the SAPABAP_BatJobMonMonitoring Template is correctly
configured to send amessage to OMi, if a job runs for more than a defined amount of time. If the test
completes successfully, a message about the test job appears in the OMi message browser. For more
information about Transports, see Transports readme file on the OMi managed node. For more
information about importing and applying OMi MP for SAP Transports, seeOMi MP for
SAPInstallation Guide.

After importing the transport, the installed test program /HPOV/YSPI0002 can be viewed using the
SAP ABAP Object Navigator Transaction SE80.

JOB_MIN_RUN_TIME

The JOB_MIN_RUN_TIME alert type defines theminimum allowed run time for a job. Use the JOB_
MIN_RUN_TIME alert type to configure the job-report Monitoring Template SAPABAP_BatJobMon to
generate an alert when a job does not run for the time specified in the parameter MIN_RUNTIME.

The following table lists the parameters that you can use to configure the JOB_MAX_RUN_TIME alert
type and shows the value assigned to the parameters by default:

The configuration of any of the parameters below is optional. If both parameters are omitted, all jobs
running in the specified time frame are reported.

Parameter
Name Description

Query
Conditions

Default
Value

JOBNAME Name of the
jobs to
monitor

= Sign: I, E I

= Opt: EQ,
CP, BT

CP

= Low
<Name of
job>

*

= High: a
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MIN_
RUNTIME

This defines
the
minimum
allowed run
time. Alerts
are triggered
for jobs
which did
not run for
the time
specified (in
minutes).

= Sign I, E I

= Opt:
EQ,LE, LT,
BT

LT

=Low <Min.
value in
minutes> b

1

= High

aOnly for use with range.

bSpecify this parameter as a number, otherwise themonitor ends with a dump.

The following examples illustrates both the default and a customized configuration for the JOB_MIN_
RUN_TIME alert type.

l Default JOB_MIN_RUN_TIME Configuration

In Default JOB_MIN_RUN_TIME Configuration, an event generating an alert occurs if any report
named <jobname>* has a runtime of less than oneminute.

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1 \

=WARNING =MinRunTime =R3_Jobs\

=JOB_MIN_RUN_TIME =JOBNAME =I =CP =<jobname>* = \

=MIN_RUNTIME =I =LT =1 =

l Customized JOB_MIN_RUN_TIME Configuration

In Customized JOB_MIN_RUN_TIME Configuration, an event generating an alert occurs if all
reports named SAP*, except reports SAPZ*, have a runtime of less than twominutes.

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1 \

=WARNING =MinRunTime =R3_Jobs \

=JOB_MIN_RUN_TIME =JOBNAME =I =CP =SAP* = \

=MIN_RUNTIME =I =LT =2 =

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1 \

=WARNING =MinRunTime =R3_Jobs \
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=JOB_MIN_RUN_TIME =JOBNAME =E =CP =SAPZ* = \

=MIN_RUNTIME =I =LT =2 =

TheOMi MP for SAP optional test transport includes a program that you can run to start a short job.
You can use the job to verify that the SAPABAP_BatJobMonMonitoring Template is correctly
configured to send amessage to OMi if a job runs for less than a defined amount of time. If the test
completes successfully, a message about the test job appears in the OMi message browser. For more
information about Transports, see Transports readme file on the OMi managed node. For more
information about importing and applying OMi MP for SAP Transports, seeOMi MP for
SAPInstallation Guide.

After importing the transport, the installed test program /HPOV/YSPI0005 can be viewed using the
SAP ABAP Object Navigator Transaction SE80.

START_PASSED

The START_PASSED alert type defines themaximum allowed delay between a job’s scheduled and
actual start times. Use the START_PASSED alert type to configure the SAPABAP_BatJobMon
Monitoring Template to generate an alert if the specified jobs do not start within the configured TIME_
SPAN after the scheduled start time. The following table lists the parameters that you can use to
configure the START_PASSED alert type and shows the value assigned to the parameters by default.

If a job is scheduled but does not have a start time, SAPABAP_BatJobMonMonitoring Template
cannot monitor it until and unless an assigned start time is visible in the SAP database. SAP
associates a start time with a job only when the job assumes a particular status. The following SAP job
statuses have a start time whichmeans you canmonitor them with SAPABAP_BatJobMon
Monitoring Template: Released, Ready, Active, Finished, and Canceled.

The configuration of any of the parameters below is optional. If both parameters are omitted all jobs
running in the specified time frame are reported.

Parameter
Name Description Query Conditions

Default
Value

JOBNAME Name of the jobs tomonitor = Sign: I, E I

= Opt: EQ, CP, BT CP

= Low <Name of job> *

= High 1
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Parameter
Name Description Query Conditions

Default
Value

TIME_SPAN The job run time inminutes that specifies
when an alert should be raised. Note that it
is not necessary to use a time range. You
can specify a particular time instead.

= Sign I, E I

= Opt: EQ, GT, GE, BT GT

=Low 2 <low_value_of_
range _in_minutes_
past_ scheduled_
start_time>

1

=High <high_value_
of_ range_in_
minutes_past_
scheduled_start_
time>

1. Only for use with a range.

2. Specify this parameter as a number. Otherwise themonitor ends with a dump.

Default START_PASSED Configuration

In Default START_PASSED Configuration, an event generating an alert occurs if any report named
<jobname>* does not start more than oneminute after the scheduled start time.

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1\

=WARNING =StartPassed =R3_Jobs \

=START_PASSED =JOBNAME =I =CP =<jobname>* =\

=TIME_SPAN =I =GT =1 =

JOB_ABORTED

The JOB_ABORTED alert type defines the names of the jobs, which fail to complete successfully.
Use the JOB_ABORTED alert type to configure the SAPABAP_BatJobMonMonitoring Template to
generate an alert whenever the jobs specified in its configuration fails. The following table lists the
parameters that you can use to configure the JOB_ABORTED alert type and shows the value assigned
to the parameters by default:

Note: The configuration of the parameter below is optional.

Parameter Name Description Query Conditions Default Value
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JOBNAME Name of the jobs to bemonitored = Sign: I, E I

= Opt: EQ, CP, BT CP

= Low <Name of job> *

= High 1

1. Only for use when specifying a range.

l Default JOB_ABORTED Configuration

In Default JOB_ABORTED Configuration, an event generates an alert if any report named
<jobname>* aborts.

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1\

=WARNING =Aborted =R3_Jobs \

=JOB_ABORTED =JOBNAME =I =CP = <jobname>*

l Customized JOB_ABORTED Configuration

In Customized JOB_ABORTED Configuration, an event generates an alert if jobs named SAP_
REORG_ABAPDUMPS or ITOTEST are aborted.

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1\

=WARNING =Aborted =R3_Jobs \

=JOB_ABORTED =JOBNAME =I =EQ =SAP_REORG_ABAPDUMPS =

AlertMonFun =ALL =ALL =ALL =ALL =JOBREPORT =1 \

=WARNING =Aborted =R3_Jobs\

=JOB_ABORTED =JOBNAME =I =EQ =ITOTEST =

TheOMi MP for SAP optional test transport includes a program that you can run to generate an ABAP
dump. You can use the generated dump to verify that the SAPABAP_BatJobMonMonitoring Template
is correctly configured to send amessage to OMi if a job aborts. Formore information about OMi MP for
SAP transports, see the transports read-me file on the OMi managed node. For more information about
importing and applying OMi MP for SAP transports, see the OMi MP for SAP Installation Guide.

After importing the transport, installed test program /HPOV/YSPI0004 can be viewed using the SAP
ABAP Object Navigator Transaction SE80.
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SAPABAP_CCMSIntegrationMon

The SAPABAP_CCMSIntegrationMonMonitoring Template enables monitoring the output of SAP
CCMS monitoring infrastructure.

This section provides detailed information about the contents of the SAPABAP_CCMSIntegrationMon
Monitoring Template.

Monitoring Conditions

Youmust define and enable the keywords———:—Severity<Level>, RFCTimeOut,
CCMSMonitorSet, and CCMSAcknowledgeMessage. All other keywords in the SAPABAP_
CCMSIntegrationMonMonitoring Template are optional.

CCMS Monitor Sets

The XAL interface allows the OMi MP for SAP to read, write, and reset CCMS alerts directly in the
CCMS alert-monitor tree. Themost obvious advantage of this feature is that you can use existing
CCMS monitor sets as templates to define your ownmonitor sets, which contain only those CCMS
alerts you want to monitor with the OMi MP for SAP.

Remember to logon to SAP and define the new CCMS monitor sets which you want the OMi MP for
SAP to use to generatemessages before you start the configuration of the SAPABAP_
CCMSIntegrationMonMonitoring Template.

Note: To create or modify items in the CCMS monitor tree, you need tomake sure that the
Maintenance Function for the CCMS monitor sets is switchedON. You can find the
Maintenance function option in theExtrasmenu, for example, Extras > Activate
Maintenance Function.

If you are not interested in receivingmessages concerning all the alerts present in the default monitor
set, for example, OperatingSystem, DatabaseClient, and so on, you can expand the individual
application-server item and select only the alerts which you want to use to generatemessages that will
be sent to OMi.

Make sure that the new monitor sets you define for the OMi MP for SAP are visible to and usable by the
OMi user. If you are logged into SAP as the definedOMi user, then you can see only the CCMS monitor
sets that aremarked “Public”. If you are logged into SAP as the administrator, you can see all available
monitor sets, in which case you have to ensure that youmake the new monitor sets you define for the
OMi MP for SAP are visible either to the definedOMi user or everyone by using the “Public” option.
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Note:Remember to use only ASCII characters when defining the name of a CCMS monitor set as
the OMi MP for SAP cannot currently interpret non-ASCII characters in monitor-set names.

One SAP System/SID can havemultiple monitor sets. If you need to definemultiple monitor sets for a
SAP System/SID, remember to include each new monitor set on a new line in themonitor-set section
of the SAPABAP_CCMSIntegrationMonMonitoring Template configuration, as illustrated in Configuring
Multiple Monitor Sets. The name you define in themonitor parameter must match the name of the
monitor set as it appears in the CCMS alert-monitor tree. The name of monitors must appear in the
configuration exactly as they are shown in SAP including, for example, forward slashes (/), as shown in
ConfiguringMultiple Monitor Sets.

Note that the combination of traditional long SAP names and the line break in the example configuration
shown in ConfiguringMultiple Monitor Sets disguises the name of themonitor. The complete name of
the last monitor is: =System / All Monitoring Segments / All Monitoring Contexts. Note that the names
you use do not have to be this long. In addition, if you want to associate multiple monitors with one,
single monitor set, you have to specify each individual monitor on a new line as shown by the first two
entries in ConfiguringMultiple Monitor Sets, where the OMi MP for SAP monitor set has twoMonitors;
System and DB_ALERT.

Configuring Multiple Monitor Sets

#----------------------------------------------------------------------------

--

# Monitor Set SAP SAP Monitor Set Monitor

# System Number

CCMSMonitorSet =WA1 =33 =MPSAP =System

CCMSMonitorSet =WA1 =33 =MPSAP =DB_ALE

RT

CCMSMonitorSet =SP6 =00 =SAP CCMS Technical Expert Monitors =System

/\

All Monitoring Segments / All Monitoring

Contexts

#----------------------------------------------------------------------------

--
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The default configuration of individual CCMS alert monitors does not always meet the demands of your
environment and, in some instances, you will need to change it. You can check and, if necessary,
modify amonitor’s properties in thePerformance Attribute tab of theMonitor: Properties and
Methods window. If you decide to change themonitor properties, you need to consider the following
points:

l Ensure that the severity level of the CCMS Alerts matches the severity level of the OMi messages,
which are generated by the CCMS Alerts.

l Ensure that severity-level thresholds configured for a given CCMS alert monitor are appropriate for
your needs.

To open theMonitor: Properties and Methodswindow for a specific CCMS monitor, browse to the
desiredmonitor in themonitor-set tree and either click theProperties button or double-click themonitor
you want to view.

CCMS Alert Monitors

Alerts are themost basic element of the strategy that SAP uses tomonitor the health of the SAP
Landscape. Alerts are associated with objects such as disks and CPUs, and objects have attributes
such as response times and usage statistics. The status of the object as well as its performance and
availability over time are important to the SAP System administrator. The SAP NetWeaver CCMS alert
monitor displays the configured alerts (along with any associated objects and attributes) as CCMS
monitors in amonitor tree, which you can browse.

Note: The public monitor sets are visible to (and usable by) all SAP users.

For ease of navigation, the CCMS monitors are grouped into pre-definedmonitor sets, for example, SAP
CCMS Technical Expert Monitors or SAP CCMS Admin Workplace. The pre-definedmonitor sets
contain a large number of sub sets andmonitors, which can generate thousands of alerts, some of
which you really do not need.

If you switch on themaintenance function for the CCMS monitor sets, you can create your ownCCMS
monitor sets, which contain only themonitors for the alerts you want to know about on a regular basis.
When you have created your ownmonitor sets, you can add them to themonitor-set tree and configure
the OMi MP for SAP tomonitor them. In this way, you can reduce the alerts you hear about and the
information you receive so that it is easier to manage.When a condition is reported in the SAP
NetWeaver CCMS monitor, themonitoring object and its attributes are included in the resulting alert.

CCMS Acknowledge Message

The CCMSAcknowledgeMessage feature determines whether SAPABAP_CCMSIntegrationMon
Monitoring Template tells SAP to automatically acknowledge (complete) CCMS Alerts, whichmatch
the defined conditions. Enabling the CCMSAutoAcknowledge feature in SAPABAP_
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CCMSIntegrationMonMonitoring Template is same as selecting the alert and clicking the [Complete
Alert] button in SAP CCMS.

Automatically Acknowledging CCMS Alerts

# Triggers auto-acknowledge of CCMS alerts

#------------------------------------------------------------

# CCMSAcknowledgeMessage SAP Ack. filtered Enable=1

# System Messages Disable=0

CCMSAcknowledgeMessage =ALL =0 =0

CCMSAcknowledgeMessage =SP6 =0 =0

#------------------------------------------------------------

You can enable or disable the auto-acknowledgment feature for specific SAP Systems defined on
individual lines in the SAPABAP_CCMSIntegrationMonMonitoring Template configuration. However,
note that if you disable the auto-acknowledgment feature (=0) for a specific SAP System, SAPABAP_
CCMSIntegrationMonMonitoring Template ignores the setting forAck. Filtered Messages defined on
the same line.

If you enable theAck. Filtered Messages keyword, messages that are filtered out (and not sent to
Operations Agent) by theAlerMonSyslog specifications (whichmeans, setting Disabled=0 in the
appropriate line) will be acknowledged in CCMS. Therefore, these alerts will not be visible in the OMi
message browser or in SAP CCMS anymore.

Note: If you enable theCCMSAcknowledgeMessage keyword, you also need tomake sure that
you enable the Severity<Level> keyword. The Severity<Level> keyword allows you to filter
CCMS alerts according to severity.

Environment Variables

The following table lists the environment variables, which you can use to configure the SAPABAP_
CCMSIntegrationMonMonitoring Template.

Environment Variable Description

SAPOPC_DRIVE The Windows drive where the Operations Agent is running, for 
example, E:\usr\...

SAPOPC_HISTORYPATH Path to the r3monal history file

SAPOPC_R3MONAL_
CONFIGFILE

Name of the r3monal configuration file
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SAPOPC_SAPDIR TheWindows drive where SAP NetWeaver is running, for example,
E:\usr\sap

SAPOPC_TRACEPATH Path to the r3monal trace file

File Location

The SAPABAP_CCMSIntegrationMonMonitoring Template uses the default files listed in the following
table:

File Name Description

r3monal (.exe) Executable for the SAP NetWeaver CCMS alert monitor

r3monal.cfg Configuration file for the CCMS alert monitor

r3monal.his History file for storing data after eachmonitor run

Remote Monitoring

The RemoteMonitoring keyword allows you to configure the OMi MP for SAP on local host to monitor
an SAP instance on a remote host. Note that SAP System and SAP Number are only required by
SAPABAP_CCMSIntegrationMonMonitoring Template.

Enabling Remote Monitoring

#---------------------------------------------------------

# Remote Host Localhost Remotehost SAP System SAP Number

RemoteMonitoring =hpspi003 =ovsdsap6 =SP6 =00

#-------------------------------------------------------

RFC Time Out

You use the RFCTimeout keyword to define themaximum amount of time in seconds before an RFC
XAL function call is canceled, for example: =120. You need to set a time-out which takes into account
the environment in which SAP is running. For example, if the RFC call takes longer than expected to
complete, that is, to receive a reply to the initial request, the SAP System is probably down or has a
serious performance problem. Note that after the RFC call completes and SAP allocates a free Dialog
process, the time limit no longer applies.

Setting the Time-out period for XAL Function Calls

#------------------------------------------------------------

# Max. time in sec. before a RFC XAL function call is

# canceled. If the RFC call takes longer than expected, the
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# system is probably down or has a major performance problem.

RFCTimeOut = 120

#------------------------------------------------------------

Severity Levels

The Severity Values section of the SAPABAP_CCMSIntegrationMonMonitoring Template defines
how you filter CCMS alerts in the CCMS monitor trees you aremanaging with SAPABAP_
CCMSIntegrationMonMonitoring Template andmap the severity level of the filtered CCMS Alerts to
the desired severity level for the corresponding OMi messages. You can use the keywords
SeverityWarning and SeverityCritical in combination with the CCMSAcknowledgeMessage keyword,
which is described inmore detail in "CCMS AcknowledgeMessage".

By adding a new line for individual combinations of SAP system ID and SAP number, you can restrict
the severity mapping between CCMS Alerts andOMi messages to a specific SAP System ID and SAP
Number.

Following is the Default settings for Severity Levels in SAPABAP_CCMSIntegrationMon:

#---------------------------------------------------------

#Severity SAP SAP Enabled=1 OpCSeverity

#Values System Number Disabled=0

SeverityWarning =ALL =ALL =0 =WARNING

SeverityCritical =ALL =ALL =1 =CRITICAL

#-------------------------------------------------------------

You can edit the severity levels in SAPABAP_CCMSIntegrationMonMonitoring Template in one of the
following ways:

l Enable or disable severity levels

If you want to disable (=0) the generation of messages for CCMS alerts with the severity warning,
add a new (or change the existing) SeverityWarning line as follows:

SeverityWarning =ALL =ALL =0 =WARNING

l Change how the OMi MP for SAP maps CCMS severity levels to message severity levels in
OMi

If you want the OMi MP for SAP to report all SeverityWarning events as critical, add a new (or
change the existing) SeverityWarning definition, as follows:
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SeverityWarning =ALL =ALL =1 =CRITICAL

l Define SID-Specific exceptions

If you want the OMi MP for SAP report as critical all Severity Warning events that occur on SAP
system LP2, leave the default settings for ALL systems and add the following line:

SeverityWarning =LP2 =ALL =1 =CRITICAL

Following is an example of Severity Levels in SAPABAP_CCMSIntegrationMon
Monitoring Template Configuration

# A Monitor Set defines the messages you want to forward to OMi.

#------------------------------------------------------------------------

# Monitor Set SAP SAP Monitor Set Monitor

# System Number

#CCMSMonitorSet =WA1 =33 =MPSAP =System

#CCMSMonitorSet =WA1 =33 =MPSAP=DB_ALERT

#CCMSMonitorSet =SP6 =00 =SAP CCMS Technical Expert Monitors

=System / All Monitoring Segments / All Monitoring Contexts

#------------------------------------------------------------------------

# Remote Host Localhost Remotehost SAP SAP

# System Number

#RemoteMonitoring =hpspi003 =ovsdsap6 =SP6 =00

#------------------------------------------------------------------------

# CCMSAcknowledgeMessage SAP Ack. filtered Enable=1

# System Messages Disable=0

CCMSAcknowledgeMessage =ALL =0 =0

CCMSAcknowledgeMessage =SP6 =0 =0

# XMI compatibility mode

# makes the r3monal send syslog messages r3monxmi style

#------------------------------------------------------------------------

# XmiSyslogMode Enabled =1
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# Disabled =0

XmiSyslogMode =0

# Syslog filtering

#------------------------------------------------------------------------

# Alert Classes SAP SAP SyslogId Enabled=1

# System Number From To Disabled=0

AlerMonSyslog =ALL =ALL =A00 =MZZ =1

AlerMonSyslog =ALL =ALL =N00 =ZZZ =0

AlerMonSyslog =LPO =01 =A00 =ZZZ =1

Trace Levels

Formore information about the trace levels the alert monitors used, in particular, the trace levels
available to the SAPABAP_CCMSIntegrationMonMonitoring Template, see "TraceLevel".

Alert Classes

In the alert-classes section of the SAPABAP_CCMSIntegrationMonMonitoring Template
configuration, you define how theOMi MP for SAP's CCMS alert monitor filters syslog events in the
SAP System; the filteringmechanism ensures that you extract and display only those syslog events
that you are interested in seeing. You filter the syslog events that you want to monitor by specifying
ranges of message numbers (syslog IDs). Each line of the alert-classes section of the SAPABAP_
CCMSIntegrationMonMonitoring Template configuration is set up in a particular way. Each entry
defines monitoring for a specified range of syslog events. You can specify which syslog events to
monitor by enabling or disabling ranges of syslog IDs either globally or for specified SAP systems and
instances.

In Syslog events in the SAPABAP_CCMSIntegrationMonMonitoring Template configuration, monitors
the syslog events with IDs A00 throughMZZ on all SAP Systems and SAP numbers but does not
monitor the syslog events with IDs N00 through ZZZ on all SAP Systems and numbers. Syslog event
monitoring is enabled on SAP System LPO for IDs A00 through ZZZ.

Syslog events in the SAPABAP_CCMSIntegrationMon Monitoring Template Configuration

# Syslog filtering

#-------------------------------------------------------------

# Alert Classes SAP SAP SyslogId Enabled=1

# System Number From To Disabled=0
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AlerMonSyslog =ALL =ALL =A00 =MZZ =1

AlerMonSyslog =ALL =ALL =N00 =ZZZ =0

AlerMonSyslog =LPO =01 =A00 =ZZZ =1

#--------------------------------------------------------------

Monitoring the CEN

The central monitoring system (CEN) is a single SAP system that you designate as the central point of
control for CCMS alerts originating from all over themonitored SAP landscape. The CEN concept
allows you to reduce the overhead of monitoring andmanagingmultiple SAP systems by making
essential information concerning problem alerts available in one, central location. After you configure
SAP to use the CEN for the central management of CCMS alerts, you can use the SAPABAP_
CCMSIntegrationMonMonitoring Template to intercept the CCMS alerts destined for the CEN and use
the alerts to generatemessages, which it forwards to the OMi message browser.

Testing the Configuration

TheOMi MP for SAP’s optional test transport includes a program that generates an ABAP dumpwhich
you can use to verify that the SAPABAP_CCMSIntegrationMonMonitoring Template checks the
syslog and sends amessage to OMi if a dump occurs in the SAP System. If the test completes
successfully, a message about the test dump appears in the OMi message browser. Note that this test
works only if you configure SAPABAP_CCMSIntegrationMonMonitoring Template tomonitor the
appropriate SAP CCMS monitor sets, for example: <SAPSID>/R3Abap/Shortdumps.

For more information about OMi MP for SAP transports, Transports readme file on the OMi managed
node. For more information about importing and applying OMi MP for SAP transports, see theOMi
Management Pack for SAP Installation Guide. After importing the transport, you can view the test
programs installed by using the SAP transaction SE80 to open the ABAP object navigator and
browsing to the report (or program) /HPOV/YSPI0004.

SAPABAP_CTSMon

The SAPABAP_CTSMonMonitoring Template enables monitoring of SAP Correction and Transport
System for different transport requests, tasks, and objects. Data collection is application-server
independent.

The SAPABAP_CTSMonMonitoring Template uses the following SAP elements as a reference:

l Transport requests and object lists created using SAP NetWeaver transaction SE01

l Tasks created using SAP NetWeaver transaction SE09
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Monitor Type

The SAPABAP_CTSMonMonitoring Template is of type time frame. Onemonitor run gathers only one
value set.

Alert Types

The CTS monitor has the following alert types:

l REQUEST_CREATED

Defines when new requests generate an alert

l REQUEST_RELEASED

Defines whether to generate an alert for a released request

l TASK_CREATED

Defines if new tasks should generate an alert

l TASK_RELEASED

Defines whether to generate an alert for released tasks

l OBJECT_USED

Defines whether objects used by a task or a request generate an alert

l OBJECT_RELEASED

Defines whether to generate an alert when a request or task releases an object

File Locations

The SAPABAP_CTSMonMonitoring Template uses the files listed in this table:

File Description

r3moncol (.exe) Collector executable for the CTS monitor

r3moncts.cfg Configuration file for the CTS monitor.

r3moncts.log Trace file for storing trace data.

The SAPABAP_CTSMonMonitoring Template do not write history information to a specific history file.
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Environment Variables

The SAPABAP_CTSMonMonitoring Template uses the environment variables described
in"Environment Variables".

Command-Line Parameters

The SAPABAP_CTSMonMonitoring Template uses the command line parameters described in
Command Line Parameters.

Remote Monitoring

Formore information about configuring the SAPABAP_CTSMonMonitoring Template tomonitor
another SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

Configuring SAPABAP_CTSMon Monitoring Template Alert

Types

You should keep inmind the following rules when configuring the alert-type parameters for the
SAPABAP_CTSMonMonitoring Template:

l By default, the OMi MP for SAP selects all data for each parameter.

l You can restrict data by specifying some or all of the parameters for the alert type.

l The SAPABAP_CTSMonMonitoring Template only considers the named parameters if you change
default values and overrides the default value ALL for the unspecified parameters.

Use the parameter TRFUNCTION to configure the REQUEST_CREATED, REQUEST_RELEASED,
TASK CREATED and TASK RELEASED alert types.

TRFUNCTION has request functions which you can specify using the letter codes indicated in the
following table:

Letter Code Function Description

A Request: Unclassified request becomes K, L orW with first object

C Transport with change authorization
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D Patch

K Request: Change request with destination consolidation layer

L Request: Local request without transport

R Task: Repair

S Task: Development/correction

T Request: Transport without originals

U Dummy

W Request: Customizing request with cons. layer destination

X Task: Unclassified task becomes S or R with first object

Z (task without request) SE09memory usage

Note: In the descriptions of the use of this parameter for each of the CTS alert types, only the letter
code is shown.

REQUEST_CREATED

Use the REQUEST_CREATED alert type to configure the Correction-and-Transport (CTS) alert
monitor SAPABAP_CTSMonMonitoring Template to generate amessage for any new request created
within the last specified time frame. For example, adding a new (or modifying an existing) function
module requires a change request. The following table lists the parameters that you can use to
configure the REQUEST_CREATED alert type and shows the value assigned to the parameters by
default.

The configuration of any of these parameters is optional.

Parameter
Name Description

Query
Conditions

Default
Value

TRFUNCTION The request function. = Sign: I, E I

Opt: CP, EQ CP

= Low:
A,K,L,W,C,T,
U, D a

*

= High:
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TARGET The target system for
which this request
was created.

Note: This must be a
SID.

= Sign I, E

= Opt: EQ,
CP

= Low:<name
of system>

= High

USERNAME The login name of the
SAP NetWeaver user
who created the
request.

= Sign I

= Opt: EQ,
CP

= Low:
<username
who created
this
request>

= High

aYou can only specify the listed functions (* means all).

In the Default REQUEST_CREATED Configuration, themonitor generates amessage if a new
request occurs within the last time frame.

The Default REQUEST_CREATED Configuration

AlertMonFun =ALL =ALL =ALL =ALL =CTS =1\

=WARNING =Request =R3_CTS\

=REQUEST_CREATED =USERNAME =I =CP =* =

REQUEST_RELEASED

Use the REQUEST_RELEASED alert type to configure the Correction-and-Transport (CTS)
Monitoring Template SAPABAP_CTSMon to generate amessage for any new request released within
the last specified time frame. The following table lists the parameters that you can use to configure the
REQUEST_RELEASED alert type and shows the value assigned to the parameters by default:

Note: The configuration of the parameters below is optional.
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Parameter
Name Description Query Conditions

Default
Value

TRKORR Request ID = Sign: I, E

= Opt: EQ

= Low: <Request ID>

= High:

TRFUNCTION The request function. = Sign: I, E

= Opt: EQ

= Low: K,L, W,C,T, U, D.
(You can only specify the
listed functions (* means all).)

= High:

TARGET The target system for which this
request was created. This must be a
SID.

= Sign I, E I

= Opt: EQ, CP CP

= Low: <name of system> *

= High

USERNAME The login name of the SAP NetWeaver
user who created the request.

= Sign I

= Opt: EQ,CP

= Low: <usernamewho
created this request>

= High

CUSTOMIZING Customizing Requests = Sign I,E

= Opt: EQ

= Low (Any entry other than
’X’ will be treated as space.)

= High

WORKBENCH Workbench Requests = Sign I, E

= Opt: EQ

= Low (Any entry other than
’X’ will be treated as space.)

= High
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In the Default REQUEST_RELEASED Configuration, an event generating an alert occurs if any
customizing request was released in the last time frame.

The Default REQUEST_RELEASED Configuration

AlertMonFun =ALL =ALL =ALL =ALL =CTS =1\

=WARNING =Request =R3_CTS\

=REQUEST_RELEASED =CUSTOMIZING =I =EQ =X

TASK_CREATED

Use the TASK_CREATED alert type to configure the CTS Monitoring Template SAPABAP_CTSMon
to generate amessage for any new task createdwithin the last specified time frame. The following
table lists the parameters that you can use to configure the TASK_CREATED alert type and shows the
value assigned to the parameters by default.

The configuration of any of these parameters is optional.

Parameter Name Description Query Conditions
Default
Value

TRFUNCTION The request function. = Sign: I, E I

= Opt: CP, EQ CP

= Low: X, S, R, Z a *

= High:

USERNAME The login name of the SAP
NetWeaver user who created
the request.

= Sign: I

= Opt: EQ, CP

= Low:<usernamewho
created this request>

= High:

In the Default TASK_CREATED Configuration, SAPABAP_CTSMonMonitoring Template generates a
message for any new task created within the last specified time frame.

The Default TASK_CREATED Configuration

AlertMonFun =ALL =ALL =ALL =ALL =CTS =1 \

=WARNING =Task =R3_CTS \

=TASK_CREATED =TRFUNCTION =I =CP =* =
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TASK_RELEASED

Use the TASK_RELEASED alert type to configure the CTS Monitoring Template SAPABAP_CTSMon
to generate amessage for any new task released within the last time frame. The following table lists
the parameters that you can use to configure the TASK_RELEASED alert type and shows the value
assigned to the parameters by default:

The configuration of the parameters below is optional.

Parameter
Name Description Query Conditions

Default
Value

TRKORR Request ID = Sign: I, E

= Opt: EQ

= Low: <Request ID>

= High:

TRFUNCTION The request function. = Sign: I, E I

= Opt: CP, EQ CP

= Low: R, S, Z a *

= High:

USERNAME The login name of the
SAP NetWeaver user
who created the
request.

= Sign: I

= Opt: EQ, CP

= Low: <usernamewho created this request>

= High

In the Default TASK_RELEASED Configuration, SAPABAP_CTSMonMonitoring Template generates
amessage for any new task released in the last time frame.

The Default TASK_RELEASED Configuration

AlertMonFun =ALL =ALL =ALL =ALL =CTS =1\

=WARNING =Task =R3_CTS\

=TASK_RELEASED =TRFUNCTION =I =CP =* =
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OBJECT_USED

Use theOBJECT_USED alert type to configure the CTS Monitoring Template SAPABAP_CTSMon to
generate amessage if a task or a request uses an object matching the defined configuration within the
last time frame. The following table lists the parameters that you can use to configure the OBJECT_
USED alert type and shows the value assigned to the parameters by default:

The configuration of the parameters below is optional.

Parameter
Name Description Query Conditions

Default
Value

PGMID Program ID = Sign: I, E

= Opt: EQ, CP

= Low: <Program ID>

= High:

OBJECT Object type of
element.

= Sign I, E

= Opt: EQ, CP

= Low: <Object type>

= High

OBJ_
NAME

Object Name in
object directory.

= Sign I, E I

= Opt: EQ, CP CP

= Low: <Object name> *

= High

OBJ_
FUNC

Special function
for an object
entry: D =
Delete, or M =
Delete and
recreate.

= Sign I, E

= Opt: EQ, CP

= Low

= High

IN_
REQUEST

Alert generated
if object
container is a
request.

= Sign I,E

= Opt: EQ

= Low

= High

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 121 of 308



Parameter
Name Description Query Conditions

Default
Value

IN_TASK Alert generated
if object
container is a
task.

= Sign I, E

= Opt: EQ

= Low

= High

In the Default OBJECT_USED Configuration, an event generating an alert occurs if any object with
Object Type LIMU is used by a task or a request.

The Default OBJECT_USED Configuration

AlertMonFun =ALL =SD1 =ALL =ALL =CTS =1\

=WARNING =Object =R3_CTS\

=OBJECT_USED =PGMID =I =EQ =LIMU =

OBJECT_RELEASED

Use theOBJECT_RELEASED alert type to configure the CTS Monitoring Template SAPABAP_
CTSMon to generate amessage if a request or a task released the specified object. The following table
lists the parameters that you can use to configure the OBJECT_USED alert type and shows the value
assigned to the parameters by default:

The configuration of the parameters below is optional.

Parameter
Name Description

Query
Conditions Default Value

TRKORR Request ID = Sign: I, E

= Opt: EQ, CP

=
Low:<Request
ID>

= High:
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Parameter
Name Description

Query
Conditions Default Value

PGMID Program ID = Sign: I, E

= Opt: EQ, CP

= Low:
<Program ID>

= High:

OBJECT Object type of element = Sign I, E

= Opt: EQ, CP

= Low:
<Object type>

= High

OBJ_
NAME

Object Name in object
directory

= Sign I I

= Opt: EQ, CP CP

= Low:
<Object
name>

*

= High

IN_
REQUEST

Alert generated if object
container is a request

= Sign I,E

= Opt: EQ

= Low (Any
entry other
than ’X’ will be
treated as
space.)

= High

IN_TASK Alert generated if object
container is a task.

= Sign I, E

= Opt: EQ

= Low (Any
entry other
than ’X’ will be
treated as
space.)

= High
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In the Default OBJECT_RELEASED Configuration, an event generating an alert occurs if any object is
released by a task.

The Default OBJECT_RELEASED Configuration

AlertMonFun =ALL =ALL =AL =ALL =CTS =1\

=WARNING =Object =R3_CTS\

=IN_TASK =I =EQ =X =

SAPABAP_DispMon

The SAPABAP_DispMonMonitoring Template enables monitoring of the size, content, and status of
various queues for different types of SAP work processes. The SAPABAP_DispMon
Monitoring Template monitors the queues which belong to the SAP instances defined in the OMi MP for
SAP and allows you tomanage SAP performance issues more pro-actively by avoiding bottlenecks
and helping to ensure that themonitored SAP Systems have enough work processes available to fulfill
all user requests, even when loads are typically very high.

This section contains information about the following topics:

l Prerequisites

l File Locations

l Integrating SAPABAP_DispMonMonitoring Template with OMi MP for SAP Monitors

l SAPABAP_DispMonMonitoring Template Configuration

Prerequisites

If SAPABAP_DispMonMonitoring Template is not able to find either the correct version of the SAP
executable dpmon or the profile of the SAP instance whose queues you want to monitor, it aborts its
run, writes an entry in its log file, and sends amessage to themessage browser. SAPABAP_DispMon
Monitoring Template requires a version of the dpmon executable, which recognizes the -s[snapshot]
option.

To check if the correct version of the dpmon executable is available on the SAP server which you want
to monitor with SAPABAP_DispMonMonitoring Template, log on to the SAP server as user <SID>adm
and run the dpmon commandwith the -help option. If the command output displays the -s[snapshot]
option as shown in Checking the snapshot option ON, you can configure and use the SAPABAP_
DispMonMonitoring Template.
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Checking the snapshot option

$>dpmon -help

Usage: dpmon <options>

with the following options:

-p[ing] check dispatcher with NI ping

-i[nfo] retrieve dispatcher info

-s[snapshot] show info and terminate

-t <trace_level> tracelevel (default:1)

-f <trace_file>] name of the tracefile (default: dev_dpmon)

-T <timeout> network time-out value in ms (default:500)

On both UNIX andWindows operating systems, the SAPABAP_DispMonMonitoring Template uses
the environment variables SAPOPC_DPMON_PATH_ <SID> and SAPOPC_PROFILE_<SID>_
<InstNr> to determine the location of dpmon and the SAP instance profile respectively. If the variables
are not set, SAPABAP_DispMonMonitoring Template uses the registry onWindows operating
systems to determine the path to dpmon and the profile-file for themonitored SAP instances.

On UNIX operating systems, SAPABAP_DispMonMonitoring Template does not require any special
interface to determine the location of dpmon or the profile-file for themonitored SAP instances: it
assumes they are in the default SAP location. If you know the profiles files are not in the default
location, or the name of the profile does not follow standard SAP naming conventions, youmust
indicate this in the SAPABAP_DispMonMonitoring Template configuration. The standard naming
convention for an SAP profile is:

<SID>_[D|DVEBMGS]<SysNr>_<hostname>

Formore information on configuring SAPABAP_DispMonMonitoring Template, see "SAPABAP_
DispMonMonitoring Template Configuration".

File Locations

The SAP System-security SAPABAP_DispMonMonitoring Template uses the files listed in the
following table:

File Description
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r3mondisp (.exe) Executable for the ABAP Dispatcher-queue
monitor

r3mondisp.cfg Configuration file for the ABAP dispatcher-queue
monitor.

r3mondisp.log File used to store trace data collected by the
ABAP dispatcher-queuemonitor.

Integrating SAPABAP_DispMon Monitoring Template with OMi

MP for SAP Monitors

To prevent the OMi MP for SAP from causing excessive and unnecessary load on the SAP System at
critical times, you can configure the SAPABAP_DispMonMonitoring Template to work together with
the other OMi MP for SAP monitors so that themonitors check the status of the ABAP dispatcher and
establish how full the dispatcher queues are before requesting a work process. OMi MP for SAP
monitors require a dialog work process to logon to SAP. To enable this integration feature, use the
EnableDPQueueCheck keyword in the SAPABAP_DispMonMonitoring Template configuration to check
the dispatcher status before starting.

For example, if you want the SAPABAP_DispMonMonitoring Template, to check the status of the
ABAP dispatcher before SAPABAP_CCMSIntegrationMon starts its monitor run, configure the
EnableDPQueueCheck keyword in the SAPABAP_DispMonMonitoring Template as illustrated in
"Checking the ABAP Dispatcher Before Startup". If SAPABAP_CCMSIntegrationMon’s request for a
work process violated a threshold for dialog work processes defined in theMonitoring Template
configuration, the SAPABAP_DispMonMonitoring Template would not start its monitor run; it would send
amessage to themessage browser indicating the reason why it did not start. You should consider
using this feature where SAP System performance could be further compromised as a result of a
request for an additional dialog work process by OMi MP for SAP monitor.

Note:SAPABAP_DispMonMonitoring Template is not affected by the thresholds defined for the
EnableDPQueueCheck keyword; theMonitoring Template continues to work normally even if other
monitors do not start as a result of a lack of available dialog work processes.

Checking the ABAP Dispatcher Before Startup

# EnableDPQueueCheck hostname SAP SAP Enable =1

# System Number Disable=0

#

EnableDPQueueCheck =ALL =ALL =ALL =1
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Formore information about the EnableDPQueueCheck keyword, see "EnableDPQueueCheck".

SAPABAP_DispMon Monitoring Template Configuration

The SAPABAP_DispMonMonitoring Template allows you to configure theMonitoring Template using
the keywords listed in this section tomeet the requirements of your particular SAP environment.
"Excerpt from a SAPABAP_DispMonMonitoring Template Configuration" shows an excerpt from the
Monitoring Template’s default configuration.

Note: If you configure the OMi MP for SAP ABAP Monitoring Templates to check the status of the
ABAP dispatcher before starting themonitor run, make sure theMonitoring Template has the
required privileges to access and read data.

You can use the following keywords in configuring the SAPABAP_DispMonMonitoring Template. For
more information, see allowed values for the parameters in the following list:

l TraceLevel

Set the trace level for SAPABAP_DispMonMonitoring Template when it runs on the specified SAP
server. The TraceLevel keyword accepts the following parameters:

TraceLevel =<hostname> =<TraceLevel>

l TraceFile

Set the name of the trace file, which SAPABAP_DispMonMonitoring Template uses to log entries.
The TraceFile keyword accepts the following parameters:

TraceFile =<hostname> =<filename> =<TraceMode> =<TracePeriod>

l DPQueueCheck

Manages the pro-activemonitoring of the ABAP dispatcher. If more than one thresholdmatches for
the samemanaged node and the samework-process, SAPABAP_DispMonMonitoring Template
only sends themessage with the highest severity. The DPQueueCheck keyword accepts the
following parameters:

DPQueueCheck =<hostname> =<SID> =<InstanceNr> \ =<disable/enable>\ =<OVO Msg
Group> =<OVO Msg Object> =<OVO Severity> \ =<WP-Type> =<Idle/Queue> =<Percentage
idle/full>

Since the status of queued work-process is, generally speaking, more important than the status of
idle work processes of the samework-process type, we recommend that the severity level
assigned tomessages concerning queued work processes is higher than the severity level you
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associate with messages about idle work processes. For example, you can assign the severity
level Warning tomessages about idle work processes and Critical to messages about queued work
processes.

l DisableMonitoringWithSeverity

Specify which SAPABAP_DispMonMonitoring Template message severity should trigger the
disabling of integrated OMi MP for SAP monitors to prevent themonitors increasing loads
unnecessarily by requesting additional dialog work processes from the SAP Systems, whose
dispatcher you aremonitoring with the OMi MP for SAP. The DisableMonitoringWithSeverity
keyword accepts the following parameters:

DisableMonitoringWithSeverity =<hostname> =<SID> \ =<InstanceNr> =<Severity>

The DisableMonitoringWithSeverity keywordmust be used in conjunction with keywords
DPQueueCheck, which you configure in the SAPABAP_DispMonMonitoring Template, and
EnableDPQueueCheck, which you define in the configuration of theMonitoring Template you want to
integrate with SAPABAP_DispMonMonitoring Template. For more information about the keyword
EnableDPQueueCheck, see "EnableDPQueueCheck".

l InstanceProfilePath

The path to the profile-configuration file for an SAP instance whose dispatcher you want to monitor;
the InstanceProfilePath keyword accepts the following parameters:

InstanceProfilePath =<hostname> =<SID> =<InstanceNr> \ =<path>

Excerpt from SAPABAP_DispMonMonitoring Template configuration shows how to configure the
monitoring template to send a warningmessage to themessage browser if less than 15 percent of
the total allocated dialog work processes for all SAP clients in all the SAP instances monitored by
the OMi MP for SAP are idle.

Excerpt from a SAPABAP_DispMon Monitoring Template Configuration

#------------------------------------------------------------

# TraceLevel hostname only error messages=1 info messages=2 debug

messages=3

# Disable=0

TraceLevel =ALL =0

#------------------------------------------------------------------------

# TraceFile hostname filename TraceMode TracePeriod

# (a=append/w=create(default)) (in mins)
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TraceFile =ALL =r3mondisp.log =w =60

#------------------------------------------------------------------------

#InstanceProfilePath =<host> =<SID> =<InstanceNr> =<Path>

#

InstanceProfilePath =ALL =ALL =ALL =default

#------------------------------------------------------------

#DisableMonitoringWithSeverity=<host>=<SID>=<InstanceNr>=<Severity>

#

DisableMonitoringWithSeverity=ALL=ALL=ALL=WARNING

#------------------------------------------------------------

The Excerpt from SAPABAP_DispMonMonitoring Template configuration also shows how to use
the keyword DisableMonitoringWithSeverity to configure SAPABAP_DispMon
Monitoring Template to prevent OMi MP for SAP monitors from starting if the start up requires a
dialog work process (for example, to logon to SAP) and the allocation of that work process would
violate a threshold for idle dialog work processes defined in the configuration file and, as a result,
generate amessage with the severity warning or higher.

Note that you have to use the EnableDPQueueCheck keyword to configure each individual OMi MP
for SAP monitor that logs on to SAP to check the dialog work-process queue before starting its run.
For more information about the keyword EnableDPQueueCheck, see "EnableDPQueueCheck".

SAPABAP_DmpMon

The SAPABAP_DmpMonMonitoring Template enables monitoring of the runtime errors that occur on
the SAP ABAP system. The check is performed once per monitor run for all application servers.

Dumps are usually runtime errors and hence they cannot always be detected by a static syntax check.
They can occur for many reasons andmay indicate serious problems. No dumps should occur on a
production system.

Here are two examples of actions which cause dumps to occur:

l division by zero

l a called functionmodel is not enabled

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 129 of 308



Since the system administrator generally has to do something to resolve problems associated with an
ABAP dump, themessages generated by the SAPABAP_DmpMonMonitoring Template include an
operator-initiated action that calls an ABAP program to display details of the dump.

The SAPABAP_DmpMonMonitoring Template references the SAP NetWeaver transaction ST22.

Monitor Type

The SAPABAP_DmpMonMonitoring Template is of type time frame. Onemonitor run gathers only one
value set.

Alert Types

The SAPABAP_DmpMonMonitoring Template has the following alert type:

l ABAP4_ERROR_EXIST

Each ABAP dump generates one alert.

File Locations

The SAPABAP_DmpMonMonitoring Template uses the files listed in this table.

File Description

r3moncol (.exe) Collector executable for ABAP-dumpmonitor

r3mondmp.cfg Configuration file for monitored application servers.

r3mondmp.log Trace file for storing trace data.

The alert-collector monitors do not write history information to a specific history file.

Environment Variables

The SAPABAP_DmpMonMonitoring Template uses the environment variables described in
"Environment Variables".
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Command-Line Parameters

The SAPABAP_DmpMonMonitoring Template uses the command line parameters described
"Command-Line Parameters".

Remote Monitoring

Formore information about configuring the SAPABAP_DmpMonMonitoring Template tomonitor
another SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

ABAP4_ERROR_EXIST

Use the ABAP4_ERROR_EXIST alert type to configure the SAPABAP_DmpMon
Monitoring Template, to generate an alert for each dump that occurred in the last time frame. The
Default ABAP4_ERROR_EXIST Configuration shows how you can use =MAX_ENTRIES to count the
number of dumps that have to occur before the OMi MP for SAP generates amessage. In addition, you
can specify a period of time in hours (=TIME_LIMIT)within which the defined number of dumps must
occur. In this example, the OMi MP for SAP generates amessage if ten dumps occur within twenty
four hours.

The Default ABAP4_ERROR_EXIST Configuration

AlertMonFun =ALL =ALL =ALL =ALL =ABAP4 =1\

=WARNING =ABAP_Dump =R3_ABAP-4\

=ABAP4_ERROR_EXIST

#AlertMonFun =ALL =ALL =ALL =ALL =ABAP4 =1 \

=WARNING =ABAP_Dump =R3_ABAP-4 =ABAP4_ERROR_EXIST\

=MAX_ENTRIES =I =GT =10 = \

=TIME_LIMIT =I =LT =24 =

TheOMi MP for SAP’s optional test transport includes a program that generates an ABAP dumpwhich
you can use to verify that the SAPABAP_DmpMonMonitoring Template correctly reports dumps to
OMi in the form of amessage. If the test completes successfully, a message about the test dump
appears in the OMi message browser. For more information about OMi MP for SAP transports, see the
transports read-me file /usr/sap/trans/readme on theOMi managed node; for more information about
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importing and applying OMi MP for SAP transports, see theOMi Management Pack for SAP
Installation Guide. After importing the transport, you can view the test programs installed by using the
SAP transaction SE80 to open the ABAP object navigator and browsing to the report (or program)
/HPOV/YSPI0004.

SAPABAP_IdocStatusMon

The SAPABAP_IdocStatusMonMonitoring Template enables you tomonitor the current status of
different iDocs on the SAP ABAP system.The SAPABAP_IdocStatusMonMonitoring Template, is
time-frame based and checks the status of existing iDOCs for errors using the transaction WE02 as the
data source. Themonitoring template is application-server independent and available for global (SAP
NetWeaver System-wide) use.

Monitor Type

The SAPABAP_IdocStatusMonMonitoring Template is of type time frame. Onemonitor run gathers
only one value set.

Alert Types

The SAPABAP_IdocStatusMonMonitoring Template has the following alert types:

"IDOC_CURRENT_STATUS"

Defines when to generate an alert concerning the current state of the iDOCs.

File Locations

The SAPABAP_IdocStatusMonMonitoring Template uses the files listed in this table.

File Description

r3moncol (.exe) Collector executable for the iDOC-status monitor

r3monale.cfg Configuration file for iDOC-status monitor

r3monale.log Trace file for storing trace data

The alert-collector monitors do not write history information to a specific history file.
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Environment Variables

The SAPABAP_IdocStatusMonMonitoring Template uses the environment variables described in
"Environment Variables". The environment variables for all the alert-collector monitors share the same
format, the only difference being that the name of theMonitoring Template varies tomatch each
specific monitor as indicated in "Environment Variables".

Command-Line Parameters

The SAPABAP_IdocStatusMonMonitoring Template uses the command-line parameters described in
"Command-Line Parameters". The command-line parameters for all the alert-collector monitors share
the same format, the only difference being that the name of theMonitoring Template must vary to
match each specific monitor for both the -cfgfile and -trace parameters as indicated in "Command-
Line Parameters".

Remote Monitoring

Formore information about configuring the SAPABAP_IdocStatusMonMonitoring Template tomonitor
another SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

Configuring SAPABAP_IdocStatusMon Monitoring Template

Alert Types

When configuring the IDOC_CURRENT_STATUS alert type for SAPABAP_IdocStatusMon
Monitoring Template, remember that youmust define at least one of the parameters listed in "IDOC_
CURRENT_STATUS Configuration Parameters" table.

IDOC_CURRENT_STATUS

The IDOC_CURRENT_STATUS alert type defines the current status of iDOCs, which you want to
monitor. Use the IDOC_CURRENT_STATUS alert type to configure the iDOC-status alert monitor
SAPABAP_IdocStatusMonMonitoring Template to generate an alert if the status of an iDOC matches
the status defined in the STATUS parameter. The following table lists the parameters that you can use
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to configure the IDOC_CURRENT_STATUS alert type and shows the value assigned to the
parameters by default. Note that ‘ ‘ in the Default Value column signifies an empty string.

IDOC_CURRENT_STATUS Configuration Parameters

Parameter
Name Description

Query
Conditions

Default
Value

DOCNUM iDOC number, for example:
“05” (error during translation)

= Sign: I, E ‘ ‘

= Opt: GE,
GT, LE, LT,
BT

‘ ‘

= Low ‘ ‘

= High: ‘ ‘

DOCTYP The basic iDOC type, for
example: DOCMAS01

= Sign: I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘

MESCOD Logical message code = Sign I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘

MESFCT Logical message function = Sign: I ‘ ‘

= Opt: CP,
EQ ‘ ‘

‘ ‘

= Low ‘ ‘

= High ‘ ‘

MESTYP Logical message type = Sign: I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘
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Parameter
Name Description

Query
Conditions

Default
Value

RCVPFC Partner function of receiver = Sign: I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘

RCVPRN Partner number of receiver = Sign: I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘

RCVPRT Partner type of receiver = Sign: I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘

SNDPFC Partner function of sender = Sign: I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘

SNDPRN Partner number of sender = Sign: I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘
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Parameter
Name Description

Query
Conditions

Default
Value

SNDPRT Partner type of sender = Sign: I ‘ ‘

= Opt: CP,
EQ

‘ ‘

= Low ‘ ‘

= High ‘ ‘

STATUS * Status of iDOC = Sign: I, E ‘ ‘

= Opt: GE,
GT, LE, LT,
BT

‘ ‘

= Low ‘ ‘

= High ‘ ‘

*Possible values: CHECK_INBOUND, CHECK_OUTBOUND, MAX_ENTRIES, TIME_LIMIT

In RemoteMonitoring, the SAPABAP_IdocStatusMonMonitoring Template checks the status of
inbound iDOCs. An event generating an alert occurs if the number of in-bound iDOCS specified in
IDOC_CURRENT_STATUS is greater than (GT) the value 4 (four) defined inMAX_ENTRIES.

IDOC_CURRENT_STATUS Configuration

AlertMonFun =ALL =ALL =ALL =ALL =ALL =1 \

=WARNING =ALE =R3_IDOC_STATUS \

=IDOC_CURRENT_STATUS =STATUS =I =EQ =CHECK_INBOUND \

=MAX_ENTRIES =I =GT =4

Checking the iDOC Status

Using the IDOC_CURRENT_STATUS alert type in conjunction with the STATUS parameter allows
you to check any one of the different iDOC statuses that are registered in SAP NetWeaver or a range of
statuses defined in a group.

In addition, the OMi MP for SAP provides two pre-defined groups that you can use to check for a range
of errors relating to incoming or outgoing iDOCs. For example, you can use the values CHECK_INBOUND
and CHECK_OUTBOUND to monitor a range of values:
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l CHECK_OUTBOUND

monitors iDOCs with status: 02, 04, 05, 25, 26, 29, 30, 32

l CHECK_INBOUND

monitors iDOCs with status: 51, 56, 60, 61, 62, 63, 64, 65, 66, 69

If you want to use the SAPABAP_IdocStatusMonMonitoring Template to check for a specific iDOC
status, replace the value =CHECK_INBOUND shown in "IDOC_CURRENT_STATUS Configuration"
with the iDOC status number listed in "Possible iDOC Status" table that corresponds to the iDOC
status you want to monitor. For example, to monitor the number of existing iDOCS, use =01. Note that
it is not currently possible to define your own ranges similar to the pre-defined ranges CHECK_INDOUND
and CHECK_OUTBOUND. Instead, you have to define a separate AlertMonFun entry for each additional
value, which you want to monitor.

The following table lists all the statuses that the OMi MP for SAP recognizes:

Possible iDOC Status

iDOC
Status Description

Check
Inbound

Check
Outbound

00 Not used, only for R/2

01 iDoc created

02 Error passing data to port ✓

03 Data passed to port OK

04 Error within control information of EDI
subsystem

✓

05 Error during translation ✓

06 Translation OK

07 Error during syntax check

08 Syntax check OK

09 Error during interchange handling

10 Interchange handling OK

11 Error during dispatch

12 Dispatch OK

13 Retransmission OK
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iDOC
Status Description

Check
Inbound

Check
Outbound

14 Interchange Acknowledgment positive

15 Interchange Acknowledgment negative

16 Functional Acknowledgment positive

17 Functional Acknowledgment negative

18 Triggering EDI subsystem OK

19 Data transfer for test OK

20 Error triggering EDI subsystem

21 Error passing data for test

22 Dispatch OK, acknowledgment still due

23 Error during retransmission

24 Control information of EDI subsystem OK

25 Processing despite syntax error (outbound) ✓

26 Error during syntax check of iDoc (outbound) ✓

27 Error in dispatch level (ALE service)

28 Not used

29 Error in ALE service ✓

30 iDoc ready for dispatch (ALE service) ✓

31 Error - no further processing

32 iDoc was edited ✓

33 Original of an iDoc which was edited

34 Error in control record of iDoc

35 iDoc reloaded from archive

36 Electronic signature not performed (time-out)

37 iDoc added incorrectly

38 iDoc archived

39 iDoc is in the receiving system (ALE service)

40 Application document not created in receiving
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iDOC
Status Description

Check
Inbound

Check
Outbound

system

41 Application document created in receiving
system

42 iDoc was created by test transaction

50 iDoc added

51 Error: Application document not posted ✓

52 Application document not fully posted

53 Application document posted

54 Error during formal application check

55 Formal application check OK

56 iDoc with errors added ✓

57 Test iDoc: Error during application check

58 iDoc-Copy from anR/2 connection

59 Not used

60 Error during syntax check of iDoc (Inbound) ✓

61 Processing despite syntax error (Inbound) ✓

62 iDoc passed to application ✓

63 Error passing iDoc to application ✓

64 iDoc ready for transfer to the application ✓

65 Error in ALE service

66 iDoc is waiting for predecessor iDoc
(serialization)

67 Not used

68 Error - no further processing

69 iDoc was edited ✓

70 Original of an iDoc which was edited

71 iDoc reloaded from archive

72 Not used, only for R/2
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iDOC
Status Description

Check
Inbound

Check
Outbound

73 iDoc archived

74 iDoc was created by test transaction

SAPABAP_LckChkMon

The SAPABAP_LckChkMonMonitoring Template enables monitoring of the Enqueue process which
manages the SAP ABAP logical locks for different SAP transactions and SAP reports. Obsolete locks
are defined as locks which are older than the time period you specify. The check is performed once per
monitor run for all application servers.

An object which is locked cannot be changed by anyone other than the user associated with it and can
cause severe problems. The operator can check the locks set for a specific instance in SM12. Here are
two examples of actions which cause locks to occur:

l Users switch off their computers without first logging off the SAP NetWeaver system - this is the
most common cause of locked objects.

l An entire SAP instance fails.

The SAPABAP_LckChkMonMonitoring Template references the SAP NetWeaver transaction SM12.

Messages generated by this alert monitor include an operator-initiated action that calls the SM12 Locks
Overview module. The operator can then check the locks set for a specific instance in SM12.

Monitor Type

The SAPABAP_LckChkMonMonitoring Template is of type snapshot and does not make use of alert
types or parameters. Onemonitor run gathers only one value set.

Alert Types

The SAPABAP_LckChkMonMonitoring Template has only one alert type:

"OLD_LOCKS"

Specifies when to define a lock as old, using the time period you specify in the parameter LOCK_
TIME.

File Locations

The SAPABAP_LckChkMonMonitoring Template uses the files listed in this table.
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File Description

r3moncol (.exe) Collector executable for the lock_check monitor

r3monlck.cfg Configuration file for the lock_check monitor.

r3monlck.log Trace file for storing trace data.

Environment Variables

The SAPABAP_LckChkMonMonitoring Template uses the environment variables described in
"Environment Variables".

Command-Line Parameters

The SAPABAP_LckChkMonMonitoring Template uses the command-line parameters described in
Command Line Parameters.

Remote Monitoring

Formore information about configuring the alert-collector monitors to monitor another SAP System
remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

OLD_LOCKS

The LOCK_TIME alert type specifies when to define a lock as “old”, using the time period you specify in
the parameter LOCK_TIME. Use the LOCK_TIME alert type to configure SAPABAP_LckChkMon
Monitoring Template to generate an alert when a job exceeds the time span defined in the parameter
LOCK_TIME.

The following table lists the parameters that you can use to configure the LOCK_TIME alert type and
shows the value assigned to the parameters by default:

Note: The configuration of the parameter below is mandatory.

Parameter
Name Description

Query
Conditions

Default
Value

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 141 of 308



LOCK_
TIME

The time
span (in
hours) after
which a lock
is
considered
old.

= Sign: I,E I

= Opt: EQ,
GT, GE,
LE, LT, BT

GT

= Low:
<time in
hours> 1

= High:2

1. Specify this parameter as a number. Otherwise themonitor ends with a dump.

2. Only for use when specifying a range.

In The Default OLD_LOCKS Configuration, an event generating an alert occurs if any lock exceeds a
time span of 24 hours.

The Default OLD_LOCKS Configuration

AlertMonFun =ALL =ALL =ALL =ALL =LOCK_CHECK =1\

=WARNING =Enqueue =R3_Enqueue\

=OLD_LOCKS =LOCK_TIME =I =GT =24 =

SAPABAP_PerfMon

The SAPABAP_PerfMonMonitoring Template enables you to collect SAP Performancemetrics from
different OMi MP for SAP Performancemonitors.

Overview

The OMi MP for SAP R/3 Performance Agent uses a selection of performance monitors to collect SAP 
performance data and store them either in the HPE Software Embedded Performance Component
(CODA) or the Performance Agent (Unix/Windows). You can use the Performance Manager to monitor, 
manage, and correlate data, together with data collected by any other application, database, system, 
and network Performance Agent. The data can then be used to compare trends between SAP business 
transactions and other system metrics. This section provides information about the following topics:

l Performancemonitoring with the OMi MP for SAP

l UsingOMi to install the OMi MP for SAP R/3 Performance Agent
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l Configuring the performancemonitors

Implemented ABAP-functionmodules inside SAP NetWeaver are accessed by means of an RFC-call.
The performancemonitors gather a snapshot of SAP-runtime performance data.

TheOMi MP for SAP R/3 Performance Agent can collect more than 130metrics in addition to those
collected by the SAP NetWeaver Performance alert monitor (ST03), which is part of the SAP
NetWeaver CCMS subsystem.

You can configure the OMi MP for SAP R/3 Performance Agent to specify whichmonitors should be
run on specified SAP NetWeaver instances and how frequently.

The Performance Agent runs inWindows operating systems as a service and in UNIX operating
systems as a daemon (background) process that runs independently of the OMi agent processes. To
start or stop the OMi MP for SAP R/3 Performance Agent processes, use the appropriate OMi MP for
SAP tool in the Tool Bank window. For more information, see "Managing the OMi MP for SAP R/3
Performance Agent".

Configuring the SAPABAP_PerfMon Monitoring Template

TheOMi MP for SAP provides a default configuration for the SAPABAP_PerfMonMonitoring Template;
the default configuration works without modification immediately after installation. However, if you
want to set up the SAPABAP_PerfMonMonitoring Template for your particular SAP environment, you
canmodify the configuration by enabling or disabling the keywords in the following list and, where
necessary, setting or modifying the appropriate parameters:

l TraceLevel

The TraceLevel keyword accepts the following parameters:

TraceLevel =<Hostname> =<TraceLevel>

Hostname:

=ALL Monitor all hosts with the OMi MP for SAP. This is the
default setting.

=<SAP_host> The name of an SAP server, where you want to
specify a trace level. Use a new line for each
individual host.

TraceLevel:

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 143 of 308



=0 Disable. This is the default setting.

=1 Log only error messages

=2 Log all messages

=3 Log only debugmessages. Note that this trace level logs a lot of information and could very
quickly lead to a very large trace file.

l TraceFile:

The TraceFile keyword accepts the following parameters:

Tracefile =<Hostname> =<Filename>

Hostname:

=ALL Monitor all SAP servers with the OMi MP for SAP. This is the default setting.

=<SAP_
host>

The name of a specific host where tracing is enabled and you want to specify a
trace level.

Filename:

=r3perfmon.log - This is the default setting, which writes the log file to the default log file directory.
Alternatively, you can specify the name of the file to which you want to write the trace log and, if
necessary, the path. The path can be either absolute or relative to the working directory.

l AgentHostname

Make sure that the AgentHostname keyword set to ALL.

l SyncBack

The SyncBack keyword accepts the following parameters:

SyncBack =<Enable|Disable> =<SyncBack Threshold>

Enable/Disable:

=0 Disable the scheduler
synchronization.

=1 Enable the scheduler
synchronization. This is the default
setting.

SyncBack Threshold:
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=<n>
mins

The difference inminutes between defined and actual schedules. If the SyncBack
threshold is reached, for example, when the scheduler is nminutes behind schedule, the
scheduler restarts to return to the defined schedule. The SyncBack threshold should be
higher than the Message Threshold value set in association with the
BehindSyncMessage keyword so that you receive amessage warning about schedule
problems before the scheduler restarts.

l BehindSyncMessage

The BehindSyncMessage keyword accepts the following parameters:

BehindSyncMessage =<Enable|Disable> =<OpC Severity> \

=<OpC Object> =<OpC MsgGroup> =<Message Threshold>

Enable/Disable:

=0 Disable the sending of a behind-schedulemessage

=1 Enable the sending of a behind-schedulemessage. This is the default setting.

OpC Severity:

=WARNING The severity of the behind-schedulemessage sent. This is the
default value.

OpC Object:

=r3perfagent The HPOM forWindows object to associate with the behind-
schedulemessage. This is the default value.

OpC MsgGroup:

=R3_
General

The HPOM forWindows message group to which the behind-schedule
message belongs. This is the default value.

Message Threshold:

=<n>
mins

The elapsed time inminutes before a behind-schedulemessage is sent to
the HPOMmanagement server. Themessage-threshold value should be
less than the SyncBack Threshold value set in association with the
SyncBack keyword so that you receive amessage warning about schedule
problems before the scheduler restarts.

l RemoteMonitoring

The RemoteMonitoring keyword accepts the following parameters:
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RemoteMonitoring =<LocalHost> =<RemoteHost>

LocalHost:

This is the name of the host where the OMi MP for SAP software is running and whose performance
agent will be used to remotely monitor the SAP server defined inRemotehost.

RemoteHost:

This is the name of the remoteSAP server that you want to monitor using the OMi MP for SAP on
the SAP server defined in Localhost. Although the remote host is not usually an OMi managed
node and does not have Agent installed.

l PerfMon

The Perfmon keyword requires a value for the following parameters:

PerfMon =<SAP Hostname> =<SAP System> =<SAP Number> \

=<SAP Client> =<RFC FUNCTION> =<Enable|Disable> \

=<Polling Interval> =<Hold Connection>

SAP Hostname:

=ALL Monitor all SAP hosts with the OMi MP for
SAP. This is the default setting.

=<SAP_
host>

The host name of a specific SAP server
whose performance you want to monitor. Use
a new line for each individual host.

SAP System:

=ALL Monitor all SAP Systems with the OMi MP for SAP. This is the
default setting.

=<SAP_
SID>

The ID of a SAP System whose performance you want to monitor,
for example, DEV. Use a new line for each individual SID.

SAP Number:

=ALL Monitor all SAP numbers with the OMi MP for SAP. This is the
default setting.

=<Instance> The number of a specific SAP instance whose performance you
want to monitor, for example, 00, 99. Use a new line for each new
SAP number.

SAP Client:
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=ALL Monitor all SAP clients with the OMi MP for SAP. This is the
default setting.

=<ClientID> The number of a specific SAP client whose performance you want
to monitor, for example, 099. Use a new line for each SAP client.

RFC FUNCTION:

=<metricname>_PERF, where metricname refers to the specific metric list you want the
performancemonitor to use, for example, DBINFO_PERF or SAPMEMORY_PERF. For more
information about the possible values you can use, see "OMi MP for SAP PerformanceMonitors ".

Enable/Disable:

=0 Disable the performancemonitor

=1 Enable the performancemonitor. This is the default setting.

Polling Interval:

=nn nn is the time inminutes between each run of the
performancemonitor.

Hold Connection:

=0 Disable:Close the RFC connection after the call has completed.
This is the default setting.

=1 Enable: Keep the RFC connection open after the call has completed.

Managing the OMi MP for SAP R/3 Performance Agent

You can control the OMi MP for SAP R/3 Performance Agent using command-line options, which differ
according to the platform and operating system. You canmanage theOMi MP for SAP R/3
Performance Agent either by using command-line options or the tools that are installed by the OMi MP
for SAP.

OMi MP for SAP R/3 Performance Agent Command Line Syntax

You an use the following options with the r3perfagent command from the instrumentation directory
on UNIX managed nodes to control the OMi MP for SAP R/3 Performance Agent from the command
line:
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l r3mon-perl -S SAPMP_Tool.pl Start

l r3mon-perl -S SAPMP_Tool.pl Stop

l r3mon-perl -S SAPMP_Tool.pl Status

Status option is available only for SAP UNIX nodes.

You can use the following syntax with the r3perfagent command onWindows managed nodes to
control the OMi MP for SAP R/3 Performance Agent from the command line:

l r3mon-perl -S SAPMP_Tool.pl Start

l r3mon-perl -S SAPMP_Tool.pl Stop

You can also use the Services option in theWindows Control Panel to control Windows services.

OMi MP for SAP R/3 Performance Agent

TheOMi MP for SAP R/3 Performance Agent requires access to SAP to collect SAP-relatedmetrics,
which it then uses to generate reports and graphs. Youmust provide the combination of SAP user-
name and password in the SAPABAP_PerfMonMonitoring Template. It is particularly important for the
OMi MP for SAP R/3 Performance Agent, which reads the SAP log-in information in the SAPABAP_
PerfMonMonitoring Template configuration only once, during startup, and will not start if it cannot log in
to SAP. TheOMi MP for SAP R/3 Performance Agent attempts to log in to SAP and, if it fails, sends a
message to OMi indicating that it was unable to start as a result of authorization problems.

If you change the SAP user name-password combination that the OMi MP for SAP uses to log in to
SAP, you need tomake sure that the changes are reflected in the SAPABAP_PerfMon
Monitoring Template Parameters and, in addition, that the OMi MP for SAP components which use the
information in the SAPABAP_PerfMonMonitoring Template configuration are restarted tomake them
aware of the changes.

Stop the SAP/Performance Agent before you change the SAP user/password which the OMi MP for
SAP needs for access to SAP, as follows:

1. Stop the SAP/Performance Agent

Stop the SAP/Performance Agent on all OMi MP for SAP managed nodes where it is running. On
eachmanaged node, enter:

r3mon-perl -S SAPMP_Tool.pl Stop

2. Login to SAP
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Login to SAP as the administrator and change the user-password combination that OMi MP for
SAP uses to log in to SAP as required.

Note:SAP requires you to change the password for dialog users more frequently than other
types of SAP users.

3. Update SAPABAP_PerfMon Monitoring Template configuration

Configure SAP ABAP Application Server CI using SAPABAP_PerfMonMonitoring Template. You
must provide the User Name, Password, and Client Number.

4. Restart the SAP/Performance Agent

Restart the SAP/Performance Agent on each of the OMi MP for SAP managed nodes where the
SAP/ Performance Agent is running. On eachmanaged node, enter:

r3mon-perl -S SAPMP_Tool.pl Start

Note: TheOMi MP for SAP cannot collect performancemetrics during the period when the
SAP/ Performance Agent is not running.

SAP/Performance Agent Tools

The following table shows tools available for the SAP/Performance Agent with OMi MP for SAP—SAP
R/3 NT or SAP R/3 UNIX.

Tool Name SAP R/3 NT SAP R/3 UN*X

Start ✓ ✓

Stop ✓ ✓

Status ✓

OMi MP for SAP Performance Monitors

TheOMi MP for SAP performancemonitors can be one of two types: snapshot or time-frame. A
snapshot monitor runs once and gathers only one set of values. Snapshot monitors need to run on a
regular basis to create a comprehensive picture of the performance of the SAP NetWeaver
environment. Time-framemonitors run, as the name suggests, over a period of time.

The following performancemonitors are available with the OMi MP for SAP and are explained in greater
detail in the individual sections that follow:
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l "DBINFO_PERF"

Monitors database-performance analysis values

l "DOCSTAT_PERF"

Collects the document volume statistics for the last full hour

l "EP_PERF"

Monitors the status and performance of the SAP Enterprise Portal

l "ICMSTAT_PERF"

Monitors the status and performance of the SAP Internet CommunicationManager

l "JOBREP_PERF"

Counts the number of jobs per state (scheduled, running)

l "SAPBUFFER_PERF"

Returns values for the use of SAP buffers for a SAP instance

l "SAPABAP_PerfMon"

Monitors SAP memory use by SAP users for a SAP instance

l "SPOOL_PERF "

Counts the number of spool requests in different states

l "SYSUP_PERF "

Monitors the status of the SAP NetWeaver instances

l "UPDATE_PERF"

Monitors the number of update processes

l "STATRECS_PERF"

Monitors the statistical records of SAP Transaction

l "USER_PERF "

Monitors the number of users and user sessions per SAP client

l "WLSUM_PERF "

Collects the performance-workload statistics hourly

l "WP_PERF"
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Monitors the number of users/sessions per SAP client for an SAP application server.

DBINFO_PERF

The DBINFO_PERF performancemonitor returns a set of values as they are displayed in the SAP
database-performance analysis page. This information can be used to detect database performance
problems and assess whether database tuning could improve database performance.

Note: The DBINFO_PERF performancemonitor works only with Oracle database data structures.
It does not work with data structures from other database products.

Type

The DBINFO_PERF performancemonitor is of type snapshot. Onemonitor run gathers only one value
set.

Frequency

It is recommended to run the DBINFO_PERF performancemonitor once every 15minutes.

Datasource

The DBINFO_PERF performancemonitor uses the SAP transaction ST04 (DB performance overview)
as its data source.

Metrics

The following table shows the values in the performance table returned by the DBINFO_PERF
performancemonitor.

Order Metric Name Description
%
Value Cumulation

1 CPUUSAGE Database CPU usage No

2 BUFPREADS Physical reads Yes

3 BUFPWRITES Physical writes Yes

4 BUFQUAL Quality of data base buffer pool % No

5 BUFSIZE Database buffer pool size Static

6 BUFWAITS Buffer busy waits Yes

7 BUFWTIME Buffer busy wait time Yes
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Order Metric Name Description
%
Value Cumulation

8 DICTSIZE Dictionary cache size Static

9 DDQUAL Quality of Data Dictionary cache % No

10 LOGBLOCKS Redo log blocks written Yes

11 LOGENTRIES Redo log buffer entries Yes

12 LOGSIZE Redo log buffer size Static

13 LOGFAULT Allocation error rate of redo log
buffer

% No

14 LOGALLOC Redo log buffer allocation retries Yes

15 ROLLBACKS Rollbacks Yes

16 SCANLONG Long table scans Yes

17 SORTDISK Sort disk Yes

18 SORTMEM Sort memory Yes

19 SORTROWS Sort rows Yes

DOCSTAT_PERF

The performancemonitor, DOCSTAT_PERF, collects statistics relating to the volume of documents
generated and processed for the last full hour. You can only configure this monitor once for every SAP
NetWeaver System that you want to monitor.

Type

The DOCSTAT_PERF performancemonitor is of type snapshot. Onemonitor run gathers only one
value set.

Frequency

It is recommended to run the DOCSTAT_PERF performancemonitor hourly.

Data Source

The DOCSTAT_PERF performancemonitor uses the SAP transaction ST07 (quantity structure) as its
data source.

Metrics
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The following table shows the values in the performance table returned by the DOCSTAT_PERF
performancemonitor.

Order Metric Name Description

1 SID The SAP System ID

2 DESCRIPTION Description of an application-monitor object

3 CNTHEADER Document headers

4 CNTITEM Document items

5 CNTDIV Document division

6 CNTTOTAL Total number of records

7 CNTLINE Number of line items

8 CNTCHGDOC The number of changed documents

9 CNTTEXT Text

EP_PERF

The performancemonitor, EP_PERF, monitors the status and performance of the SAP Enterprise
Portal (EP) including (but not limited to) all the J2EE components on which it relies.

Note:EP_PERF is applicable wherever Enterprise Portal is available.

Type

The EP_PERF performancemonitor is of type time-frame. Onemonitor run gathers only one value set.

Frequency

It is recommended to run the EP_PERF performancemonitor approximately once every fifteen
minutes.

Datasource

The EP_PERFmonitor uses the CCMS as its data source.

Metrics

The following table shows the values in the performance table returned by the EP_PERF performance
monitor.
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Order Metric Name Description

1 SID_EP ID of the SAP System hosting the Enterprise Portal

2 HOSTNAME_EP Name of the system hosting the Enterprise Portal

3 START_TIME_EP The time at which the EP-monitor run starts

4 NO_REQ_EP Number of requests to the Enterprise Portal

5 AVG_RESP_TIME_EP Average time to respond to requests to the
Enterprise Portal

6 AVG_CPU_TIME_EP* Average CPU time required to respond to requests
to the Enterprise Portal

7 REQ_PER_SEC_EP Number of requests per second to the Enterprise
Portal

8 AVG_OUTBND_DATA_EP Average amount of out-bound data per request to
the Enterprise Portal

9 ACC_RESP_TIME_EP Accumulated response time of requests to the
Enterprise Portal

10 ACC_CPU_TIME_EP* Accumulated CPU time required to respond to EP
requests

11 OUTBND_DATA_REQ_EP Requests providing outbound data

12 ACC_OUTBND_DATA_EP Amount of accumulated outbound data (in bytes)

13 NO_COMPCALLS_REQ_EP Number of component calls by all requests to the
Enterprise Portal

14 AVG_CMPCALLPERREQ_EP Average number of component calls per EP request

15 VALID_MONDATA_REQ_EP EP requests providing correct monitor data

16 REQ_NOT_CORR_CLSD_EP EP requests with components that were not
correctly closed

17 REQCLSD_TOOMNYCMP_EP Number of EP requests that were closed because of
toomany components

18 REQS_RUNLEVEL_0_EP EP requests running with level 0

19 REQS_RUNLEVEL_1_EP EP requests running with level 1

20 REQS_RUNLEVEL_2_EP EP requests running with level 2

21 USRS_SINCE_1_REQ_EP Number of users making EP requests since the first
request

22 USRS_SINCE_LSTRST_EP Number of users making EP requests since the last
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Order Metric Name Description

user reset

23 LST_REQ_RST_TSTMP_EP Time of the last EP-request reset

24 LST_CMPREQ_TSTMP_EP Time of the last component reset

25 LST_USRREQ_TSTMP_EP Time of the last EP-user reset

*Applicable only for SAP NetWeaver portal version 7.0

Note: If the performancemonitor EP_PERF cannot find any data or it encounters a null string in
SAP CCMS, it logs some performancemetrics as '0' (zero); this behavior is expected.

ICMSTAT_PERF

The performancemonitor, ICMSTAT_PERF, monitors the status and performance of the SAP Internet
CommunicationManager (ICM).

Type

The ICMSTAT_PERF performancemonitor is of type snapshot. Onemonitor run gathers only one
value set.

Frequency

It is recommended to run the ICMSTAT_PERF performancemonitor approximately once every fifteen
minutes.

Datasource

The ICMSTAT_PERFmonitor uses the SAP transaction SMICM (ICMmonitor) as its data source.

Metrics

The following table shows the values in the performance table returned by the ICMSTAT_PERF
performancemonitor:

Order Metric Name Description

1 ICM_Status The status of the Internet CommunicationManager

2 Max_Threads The definedmaximum number of open threads allowed by the ICM

3 Peak_
Threads

Peak number of open threads in the ICM in a given period
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Order Metric Name Description

4 Cur_Threads Number of currently open threads in the ICM

5 Max_
Connections

The definedmaximum number of open connections allowed by the
ICM

6 Peak_
Connections

Peak number of connections in the ICM in a given period

7 Cur_
Connections

Number of current connections in the ICM

8 Max_
QueueEntries

Themaximum number of queued requests allowed by the ICM
defined in: icm/req_queue_len

9 Peak_
QueueEntries

Peak number of queued requests in the ICM in a given period

10 Cur_
QueueEntries

Number of currently queued requests in the ICM

11 Running_
Threads

Number of work threads waiting for a request (idle)

12 Dead_
Threads

Number of work threads in a problematic state, for example, dead
or hanging

13 Processed_
Threads

Number of work threads currently processing a request

JOBREP_PERF

The JOBREF_PERF performancemonitor counts the jobs per state in the time period between the end
date and time of the last monitor run and the start date and time of the actual monitor run.

Type

The JOBREF_PERFmonitor is of type time-frame. Onemonitor run gathers only one value set.

Frequency

It is recommended to run the JOBREF_PERF performancemonitor between once an hour and once a
day.

Datasource

The JOBREF_PERFmonitor uses the SAP transaction SM37 (background job overview) as its data
source.

Metrics
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The following table shows the values in the performance table returned by the JOBREF_PERF
performancemonitor:

Order Metric Name Description

1 RUNNING The number of jobs with status running since the last monitor
run

2 READY The number of jobs with status ready since the last monitor
run

3 SCHEDULED The number of jobs with status scheduled since the last
monitor run

4 RELEASED The number of jobs with status released since the last
monitor run

5 ABORTED The number of jobs with status aborted since the last monitor
run

6 FINISHED The number of jobs with status finished since the last monitor
run

7 PUT_ACTIVE The number of jobs with status put_active since the last
monitor run

8 UNKNOWN_
STATE

The number of jobs with status unknown since the last
monitor run

SAPBUFFER_PERF

The SAPBUFFER_PERF performancemonitor returns values for the use of SAP memory buffers by
SAP users for a given instance, for example, hit ratios, buffer quality, free space available and so on in
the NetWeaver repository, programs, and database tables.

Type

The SAPBUFFER_PERFmonitor is of type time frame.

Frequency

It is recommended to run the SAPBUFFER_PERF performancemonitor once every fifteenminutes.

Data Source

The SAPBUFFER_PERFmonitor reads information from the SAP- buffers transaction ST02.

Metrics
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The following table shows the values in the performance table returned by the SAPBUFFER_PERF
performancemonitor.

Order Metric Name Description

1 BUFFER_
NAME

The name of
the buffer

2 HITRATIO Buffer
object reads
/ logical
requests.
The buffer
hit ratio
appears as
a
percentage

3 ALLOCATED_
SIZE

The amount
of space
allocated to
the buffers 1

4 FREE_
SPACE

The amount
of free
space (KB)
available in
the buffer

5 FREE_
SPACE_
PERCENT

Available
free buffer
space as a
percentage
of total

6 MAXDIR_
ENTR

The number
of
directories
available for
the buffer 2

7 FREEDIR_
ENTR

Number of
free
directories
available for
the buffer

8 FDIR_ENTR_
PERCENT

Free
directories
available for
the buffer as
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Order Metric Name Description

a
percentage

9 BUFFER_
SWAPS

Swap
activity both
inwards and
outwards
since
System
start 3

10 BUFFER_
SWAPS_
DELTA

Difference
between the
number of
buffer
swaps
measured in
the current
and
previous
monitor runs

11 DB_
ACCESSES

The number
of database
accesses
since
System
start 4

12 DB_
ACCESSES_
DELTA

Difference
between the
number of
database
accesses
measured in
the current
and
previous
monitor runs

1. Buffer size and “available buffer size” differ, because part of the buffer space is used for buffer
management.

2. The buffer directories point to the location of the objects stored in the buffer.

3. Buffers swap objects out of the buffer to load a new object in, if insufficient free space or free
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directories exist.

4. Database access occurs when an object cannot be read from the buffer.

Type

The SAPMEMORY_PERFmonitor is of type snapshot: onemonitor run gathers one value set.

Frequency

It is recommended to run the SAPMEMORY_PERF performancemonitor once every fifteenminutes.

Data source

The SAPMEMORY_PERFmonitor reads information from the SAP- buffers transaction ST02.

Metrics

The following table shows the values in the performance table returned by the SAPMEMORY_PERF
performancemonitor:

Order
Metric
Name Description

1 MEMORY_
AREA

The type of memory buffer

2 CURRENT_
USE_
PERCENT

The amount of space currently used expressed
as a percentage of the total available

3 CURRENT_
USE

The amount of space currently used in KB

4 MAX_USE Themaximum value (max. use) since system
startup

5 IN_
MEMORY

The amount of space used in sharedmemory

6 ON_DISK The amount of space used on the disk

SPOOL_PERF

The SPOOL_PERF performancemonitor counts the number of spool requests present in different
states.

Type
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The SPOOL_PERF performancemonitor is of type time frame and does not make use of alert types or
parameters. Onemonitor run gathers only one value set. The SPOOL_PERF performancemonitor
collects SID-relatedmetrics and should run only once per monitored SID, that is: either on the SAP
central instance or on one application server.

Frequency

It is recommended to run the SPOOL_PERF performancemonitor once every 10 to 30minutes.

Data Source

The SPOOL_PERF performancemonitor uses the SAP transaction SP01 (output controller) as its data
source.

Metrics

The following table shows the values in the performance table returned by the SPOOL_PERF
performancemonitor.

Order
Metric
Name Description

1 ALL_SJ Total number of
spool jobs

2 SJ_
ARCHIVE

Number of spool
jobs in status
archive

3 PRINT_
REQ

Total number of
print requests

4 OPEN_PR Number of open
print requests

5 SUCCESS_
PR

Number of
successfully
processed print
requests

6 ERROR_
PR

Number of Print
requests with
errors

7 FAILED_PR Number of failed
print requests
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SYSUP_PERF

The SYSUP_PERF performancemonitor is used to determine whether the SAP NetWeaver system is
available or not.

Type

The SYSUP_PERF performancemonitor is of type snapshot. Onemonitor run gathers only one value
set.

Frequency

The SYSUP_PERF performancemonitor runs once aminute; the run frequency cannot bemodified.

Data Source

The SYSUP_PERF performancemonitor uses internal SAP RFC calls as its data source.

Metrics

The following table shows the values in the performance table returned by the SYSUP_PERF
performancemonitor.

Metric Name Description

SYSTEM_
STATUS

Status of the System (UP/DOWN) on the basis of the
following values:

l SAP System available

l SAP System logon failure

l SAP System communication problems

l SAP System unknown

Indicates that the performance agent was not running
and could not collect any data.

UPDATE_PERF

The UPDATE_PERF performancemonitor is used to determine whether update errors are occurring.

When the SAP NetWeaver system is behaving well, no update errors should occur. However, an
update error can occur, if an update is performed on a database table record that has previously been
deleted. A normal update process should not have to wait in status INIT for more than 5minutes for an
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update task. If a greater number of work processes exist with the status INIT the reason could be that a
table space is full.

Type

The UPDATE_PERFmonitor is of type snapshot. Onemonitor run gathers only one value set.

Frequency

It is recommended you configure the UPDATE_PERF performancemonitor to run once aminute.

Data Source

The UPDATE_PERFmonitor uses the SAP transaction SM13 (update records) as its data source.

Metrics

The following table shows the values in the performance table returned by the UPDATE_PERF
performancemonitor:

Order Metric Name Description

1 ALL Number of all VB-update tasks

2 INITIAL Number of initial VB-update tasks

3 ERRONEOUS Number of erroneous VB-update tasks

4 VB1 Number of update tasks having V1 executed

5 VB2 Number of update tasks having V2 executed

STATRECS_PERF

The SAPABAP_StatRecMonMonitoring Template reads the statistical records and returns the average
response time per transaction.

The SAPABAP_StatRecMonMonitoring Template uses the alert types RESPONSE_TIME and the
parameter TRANSACTION to restrict the data selected. The transactions monitored are specified in
the parameter TRANSACTION. If this parameter is not specified, the average response time is
reported for each transaction in the local statistics file for the specified time frame. For more
information, see "SAPABAP_StatRecMon" Monitoring Template.
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USER_PERF

The USER_PERF performancemonitor provides important information about the number of users and
user sessions per SAP client for a given SAP application server.

Type

The USER_PERFmonitor is of type snapshot.

Frequency

It is recommended to run the USER_PERF performancemonitor once every fiveminutes.

Data source

The USER_PERF performancemonitor the SAP transaction SM04 (overview of users) as its data
source.

Metrics

The following table shows the values in the performance table returned by the USER_PERF
performancemonitor:

Order Metric Name Description

1 USER_
CLIENT

The SAP client number
associated with the users

2 USER_CNT The number of users logged in
per client

3 SESSION_
CNT

The total number of user
sessions per client

WLSUM_PERF

The performancemonitor, WLSUM_PERF, collects the performance workload statistics for the last full
hour. You can display the workload statistics for all task types, for example, dialog, background, RFC,
ALE, or update. TheWLSUM_PERF performancemonitor is mandatory; youmust configure it for
every application server that you want to monitor.

Note: The data collection for theWLSUMmonitor is based on the internal SAP job COLLECTOR_
FOR_PERFORMANCEMONITOR. This jobmust run with the same frequency as specified for
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WLSUM_PERF in SAPABAP_PerfMonMonitoring Template. WLSUM_PERF will then pick up
the data collected by the last run of COLLECTOR_FOR_PERFORMANCEMONITOR.

Type

TheWLSUM_PERF performancemonitor is of type time-frame. Onemonitor run gathers only one
value set.

Frequency

Due to the way in which the performancemonitor, WLSUM_PERF, measures and records time, it is
mandatory to configure theWLSUM_PERF performancemonitor to run once an hour.

Data source

TheWLSUM_PERF performancemonitor uses the SAP transaction ST03 (workload analysis) as its
data source.

Metrics

The following table shows the values in the performance table returned by theWLSUM_PERF
performancemonitor:

Order Metric Name Description

1 Hostname The SAP System hostname

2 SID The SAP System ID

3 INSTANCE The SAP instance number, if SAP version < 4.6x

4 TASKTYPE Type of SAP NetWeaver task (RFC, dialog)

5 CNT The number of dialog steps

6 DBACTIVCNT Counter for database-active dialog steps

7 RESPTI Time that elapses between a dialog sending a
request to the dispatcher and receiving a response

8 CPUTI CPU time used in the work process

9 QUEUETI The time an unprocessed dialog step waits in the
dispatcher queue for a free work process

10 LOADGENTI Time taken loading and generating objects such as
ABAP source code and screen information from the
database

11 COMMITTI Time required for commit to complete
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Order Metric Name Description

12 DDICTI Time required for Data Dictionary

13 QUETI Time required for batch-input queue

14 CPICTI Time required for RFC and CPI-C

15 ROLLINCNT Number of roll-ins (rolled-in user contexts)

16 ROLLINTI Processing time for roll-ins

17 ROLLOUTCNT Number of roll-outs (rolled-out user contexts)

18 ROLLOUTTI Processing time for roll-outs

19 READDIRCNT Number of direct read accesses

20 READDIRTI Time for direct read access

21 READSEQCNT Number of sequential read attempts

22 READSEQTI Time for sequential read accesses

23 CHNGCNT Number of modified database accesses

24 CHNGTI Time for modified database accesses

25 BYTES Number of bytes

26 GUITIME Total time taken for the dispatcher to execute aGUI
request

27 GUICNT Count of GUI steps

28 GUINETTIME Time taken for the application server to respond to a
request from the SAP GUI

WP_PERF

TheOMi MP for SAP performance agent uses theWP_PERFmonitor to detect performance problems
concerning SAP work processes. For example, WP_PERF can detect and report on the following
situations:

l Work processes need to wait for semaphores

l Work processes are in privatemode

l A dialog work-process does not return to idle after use/release

Type
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TheWP_PERFmonitor is of type snapshot. Onemonitor run gathers only one value set.

Frequency

It is recommended that you configure theWP_PERF performancemonitor to run once every 15
minutes.

Data Source

TheWP_PERF performancemonitor uses SAP transaction SM50 (work- process overview) as its data
source.

Metrics

The following table shows the values in the performance table returned by the performancemonitor:

Order Metric Name Description

1 ALL_WP Number of all work processes

2 SEMAPHORE_
WP

Number of work processes
waiting on a semaphore

3 DEBUG_WP Number of work processes in
debugmode

4 LONG_
RUNNING

Number of long running dialog wp

5 PRIVAT_WP Number of dialog wp in private
mode

6 NOSTART_WP Number of dialog wpwith no
restart capability

7 DIA_IDLE Number of idle dialog work
processes

8 DIA_ALL Number of dialog work processes

9 DIA_
RUNNING

Number of running dialog wp

10 BTC_IDLE Number of idle batch work
processes

11 BT_ALL Number of batch work processes

12 BTC_
RUNNING

Number of running batch wp

13 SPO_IDLE Number of idle spool work
processes
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Order Metric Name Description

14 SPO_ALL Number of spool work processes

15 SPO_
RUNNING

Number of running spool wp

16 ENQ_IDLE Number of idle enqueue work
processes

17 ENQ_ALL Number of enqueue work
processes

18 ENQ_
RUNNING

Number of running enqueue wp

19 UPD_IDLE Number of idle update work
processes

20 UPD_ALL Number of update work
processes

21 UPD_
RUNNING

Number of running update wp

22 UPD2_IDLE Number of idle update2 work
processes

23 UPD2_ALL Number of update2 work
processes

24 UPD2_
RUNNING

Number of running update2 work
processes

Removing the OMi MP for SAP R/3 Performance Agent

To remove theOMi MP for SAP R/3 Performance Agent from themanaged node, you need to perform
the following steps in the order indicated:

1. Before starting the process of removing the OMi MP for SAP Performance Agent from the
managed node, make sure that you stop the performance agent. You can stop the OMi MP for
SAP R/3 Performance Agent by following any of the followingmethod:
a. To stop OMi MP for SAP R/3 Performance Agent using SAP ABAP Application Server - Stop

Performance Agent tool, follow these steps:
i. Go to the Assignments & Tuning pane:

On BSM, click Admin > Operations Management > Monitoring > Assignments &
Tuning
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OnOMi, click Administration > Monitoring > Assignments & Tuning

ii. From Browse Views tab, select SAP_DeploymentView. Select the
SAP ABAP Application Server or SAP J2EE Application Server on which you want to
stop the performance agent.

iii. Right-click, select Launch Tool.

iv. Select Stop Performance Agent tool and click Run Tool.

For ABAP:

SAP ABAP Application Server - Stop Performance Agent

For J2EE:

SAP J2EE Application Server - Stop Performance Agent

OMi MP for SAPPerformance Agent is stopped on the selected SAP Application Server.

b. To stop OMi MP for SAP R/3 Performance Agent using command line, Use the following
command as root user in the command line:

r3mon-perl -S SAPMP_Tool.pl Stop

OMi MP for SAP Performance Agent is stopped on the selected SAP CI.

2. Launch SAP ABAP Application Server - Remove Performance Package. To launch the tool follow
these steps:
a. Go to the Assignments & Tuning window:

On BSM, click Admin > Operations Management > Monitoring > Assignments &
Tuning

OnOMi, click Administration > Monitoring > Assignments & Tuning

b. From Browse Views tab, select SAP_DeploymentView. Select the
SAP ABAP Application Server or SAP J2EE Application Server from which you want to
remove the performance agent.

c. Right-click, select Launch Tool.

d. Select Remove Performance Package tool and click Run Tool.

For ABAP:

SAP ABAP Application Server - Remove Performance Package

For J2EE:

SAP J2EE Application Server - Remove Performance Package

OMi MP for SAP Performance Agent is removed from the selected SAP Application Server.
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SAPABAP_ProcMon

The SAPABAP_ProcMonMonitoring Template enables themonitoring of different SAP ABAP
processes.

This section contains information about the following topics:

l "File Locations"

l "Environment Variables "

l "Monitoring Conditions"

l "Sample Configuration"

File Locations

The SAPABAP_ProcMonMonitoring Template contains the files listed in the following table:

File Description

r3monpro (.exe) Executable for the process monitor.

r3monpro.cfg Configuration file for the process monitor.

r3monpro.his History file for storing data after eachmonitor run.

Environment Variables

The SAPABAP_ProcMonMonitoring Template uses the environment variables listed in the following
table:

Environment Variable Description

SAPOPC_DRIVE TheWindows drive where the HPOM agent is running, for
example, E:\usr\...

SAPOPC_HISTORYPATH Path to the r3monpro history file

SAPOPC_R3MONPRO_
CONFIGFILE

Name of the r3monpro configuration file

SAPOPC_SAPDIR TheWindows drive where SAP NetWeaver is running, for
example: E:\usr\sap
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SAPOPC_TRACEPATH Path to the r3monpro trace file

Monitoring Conditions

Monitoring conditions for SAPABAP_ProcMonMonitoring Template are specified in the template
configuration. Individual rows definemonitoring conditions for specific processes. You can use the
SAPABAP_ProcMonMonitoring Template to set the rules which define how the number of processes
running should bemeasured and what severity level should be assigned to the alert that is generated if
the number of processes exceeds the limits you define.

You can set monitoring conditions for a specific process to any of the followingmodes:

l Exact

The number of processes running on amanaged nodemust be equal to the specified number.

l Min

The number of processes running on amanaged nodemust not be less than the specified number.

l Max

The number of processes running on amanaged nodemust not bemore than the specified number.

l Delta

SAPABAP_ProcMonMonitoring Template triggers an alert if there is any change in the number of
processes running on amanaged node or if the specific amount of allowed change in the number of
instances of the same process exceeds the defined limit. This mode enables you to recognize
changes without having to define an absolute number of processes for amanaged node.

For example, if Delta =2, then a difference of 2 or more between the number of processes (n) found
in the previous and current monitor run on amanaged node triggers an alert. Note that if SAPABAP_
ProcMonMonitoring Template triggers an alarm, it resets n to the number of processes discovered
in themost recent monitor run, and calculates the new Delta on the basis of the new number of
processes found running.

Sample Configuration

The first row of the following example shows how tomonitor the saposcol process on all configured
hosts. Note that exactly one such process should run at any given time. Any violation of this number is
critical. It affects the OMi process saposcol. The associated OMi MP for SAP message group is R3_
State.
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The last row of the same example specifies that eight or fewer instances of the dw.sapSID process
should run on all hosts. If the number is larger than eight, themonitor generates a warningmessage
associated with OMi MP for SAP object dw.sap andOMi MP for SAPmessage group R3_State.

The string SID has special meaning in this context. SIDwill be replaced by the SAP system name on
themanaged node. This enables global definitions for different SAP Systems.

AlertInstMonPro =ALL =00 =saposcol =1 =Exact=1 =CRITICAL =saposcol =R3_State

AlertInstMonPro =C01 =00 =explorer =1 =Max =1 =CRITICAL =explorer =R3_State

AlertInstMonPro =T11 =00 =dw.sapSID =1 =Min =8 =WARNING =dw.sap =R3_State

It is also possible to ensure that a process is not running. To do so, use themode Exact and enter 0 as
the number.

Note:On servers running the UNIX operating system, SAPABAP_ProcMonMonitoring Template
can identify processes at the instance level. On servers running theWindows operating system,
you need to define on a single line the total number of work processes on the node. For example, if
there are two SAP instances, each with four (4) work processes, the total number of processes is
eight (8).

For SAP servers running on UNIX operating systems, you can configure the SAPABAP_ProcMon
Monitoring Template tomonitor the specific SAP-gateway read process gwrd associated with
individual SAP SIDs, which is especially useful in amulti-SID environment. If you havemultiple
instances of SAP running in the same SID, you can configure SAPABAP_ProcMon
Monitoring Template tomonitor the specific SAP-gateway read process gwrd assigned to each,
individual instance, too. For more information about how to configure SAPABAP_ProcMon
Monitoring Template tomonitor individual gwrd processes in an environment wheremultiple SAP
instances or multiple SAP SIDs are running on the same SAP server, have a look at the following
examples:

l "Monitoring SAP-Gateway Read Processes per SID"

l "Monitoring SAP-Gateway Read Processes per SAP Instance"

Monitoring SAP-Gateway Read Processes per SID shows how to configure SAPABAP_ProcMon
Monitoring Template tomonitor the individual gwrd processes associated with specific SIDs on a SAP
server hostingmultiple SAP SIDs.

Monitoring SAP-Gateway Read Processes per SID

AlertInstMonPro =Q12 =ALL =gwrd -dp pf=/usr/sap/

SID* =1 =Exact =1 =CRITICAL \

=gwrd =R3_State
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AlertInstMonPro =Q22 =ALL =gwrd -dp pf=/usr/sap/

SID* =1 =Exact =1 =CRITICAL \

=gwrd =R3_State

AlertInstMonPro =Q32 =ALL =gwrd -dp pf=/sapmnt/

SID* =1 =Exact =1 =CRITICAL \

=gwrd =R3_State

AlertInstMonPro =Q52 =ALL =gwrd -dp pf=/usr/sap/

SID* =1 =Exact =1 =CRITICAL \

=gwrd =R3_State

Monitoring SAP-Gateway Read Processes per SAP Instance shows how to configure SAPABAP_
ProcMonMonitoring Template tomonitor the individual gateway processes associated with specific
SAP instances on a SAP server hostingmultiple SAP instances per SAP SID.

Monitoring SAP-Gateway Read Processes per SAP Instance

AlertInstMonPro =Q12 =12 =gwrd -dp pf=/usr/sap/

SID* =1 =Exact =1 =CRITICAL \ =gwrd =R3_State

AlertInstMonPro =Q22 =21 =gwrd -dp pf=/usr/sap/Q22/SYS/profile/

Q22_D21_sap2ap1 \ =1 =Exact =1 =CRITICAL =gwrd =R3_State

AlertInstMonPro =Q22 =22 =gwrd -dp pf=/usr/sap/Q22/SYS/profile/

Q22_D22_sap2ap1 \ =1 =Exact =1 =CRITICAL =gwrd =R3_State

AlertInstMonPro =Q32 =32 =gwrd -dp pf=/sapmnt/

SID* =1 =Exact =1 =CRITICAL \ =gwrd =R3_State

AlertInstMonPro =Q52 =52 =gwrd -dp pf=/usr/sap/

SID* =1 =Exact =1 =CRITICAL \ =gwrd =R3_State

In the SAPABAP_ProcMonMonitoring Template configuration, the path to the SAP-instance profile
defined in the pf parameter is case-sensitive. To avoid problems, make sure that the path to the SAP-
instance profile defined in the SAPABAP_ProcMonMonitoring Template configurationmatches the
path displayed in the output of the ps command, for example:

[root@accra]# ps -eaf | grep gwrd
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Q22adm 15691 15688 0 Jun 6 ? 52:54 gwrd -dp \ pf=/usr/sap/Q22/SYS/profile/Q22_D21_
sap2ap1

root 20756 20599 0 10:22:58 pts/tb 0:00 grep gwrd

SAPABAP_RFCDestMon

The SAPABAP_RFCDestMonMonitoring Template enables monitoring of failed SAP RFC
destinations based on the connection type and name of the SAP RFC destinations. The SAPABAP_
RFCDestMonMonitoring Template, references the RFC destinations, which you can display, create,
andmaintain by means of the SAP NetWeaver transaction SM59.

Monitor Type

The SAPABAP_RFCDestMonMonitoring Template is of type snapshot. Onemonitor run gathers only
one value set.

Alert Types

The SAPABAP_RFCDestMonMonitoring Template has the following alert type, which uses a
snapshot report type:

CHECK

Defines alert conditions for failed SAP-RFC connections.

File Locations

The SAPABAP_RFCDestMonMonitoring Template uses the files listed in this table.

File Description

r3moncol (.exe) Collector executable for the SAP-RFC monitor.

r3monrfc.cfg Configuration file for the SAP-RFC monitor.

r3monrfc.log Trace file for storing trace data.

The SAPABAP_RFCDestMonMonitoring Template do not write history information to a specific
history file.

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 174 of 308



Environment Variables

The SAPABAP_RFCDestMonMonitoring Template uses the environment variables described in
"Environment Variables".

Command-Line Parameters

The SAPABAP_RFCDestMonMonitoring Template uses the command-line parameters described in
Command Line Parameters.

Remote Monitoring

Formore information about configuring the SAPABAP_RFCDestMonMonitoring Template tomonitor
another SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

Configuring RFC-destination Alert Types

Youmust configure the parameters CONNECTION_TYPE and NAME for all alert types for SAPABAP_
RFCDestMonMonitoring Template, the RFC-destinationmonitor. Note the general rules below on
exclude and include parameters for SAPABAP_RFCDestMonMonitoring Template.

Parameter Values

This section describes how the SAPABAP_RFCDestMonMonitoring Template interprets the include
and exclude parameter values for an alert type entry. The SAPABAP_RFCDestMon
Monitoring Template compares values in different parameters using ‘and’; the SAPABAP_
RFCDestMonMonitoring Template compares values in the same parameter as follows:

l Include:Use ‘or’ to compare the parameters

l Exclude:Use ‘and’ to compare the parameters

TheOMi MP for SAP evaluates include values before exclude values.
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CHECK

CHECK is a snapshot alert type for SAPABAP_RFCDestMonMonitoring Template, the OMi MP for
SAP’s RFC-destinationmonitor. Snapshot alert types take a picture of the SAP System at themoment
themonitor runs.

The CHECK alert type defines alert conditions for failed SAP-RFC connections. Use the CHECK alert
type to configure SAPABAP_RFCDestMonMonitoring Template to generate an alert if the RFC
connection test for the target system fails. The following table lists the parameters that you can use to
configure the CHECK alert type and shows the value assigned to the parameters by default.

The parameter CHECK is required. The following tables provides youmore information about the
meaning of the query conditions in the alert-collector monitor configuration files:

Parameter Name Description
Query
Conditions

Default
Value

CONNECTION_
TYPE

Type of SAP RFC connection tomonitor, for
example: 1, 3, M, T... Type 1= App. Server, 3= SAP
NetWeaver System, M= CMC, T =TCP/IP, G=
HTTP connection to external server, H= HTTP
connections to SAP NetWeaver system.

= Sign I, E I

= Opt: EQ EQ

= Low 3

= High

NAME Name you assigned to the SAP-RFC connection as
shown in the transaction /NSM59.

= Sign: I, E I

= Opt: EQ,
CP

EQ

= Low:
<SID>

**

= High:

The Default Check-RFC_DESTINATION Configuration

In The Default Check-RFC_DESTINATION configuration, an event generating an alert occurs
whenever the RFC_DESTINATION test fails for any one of the type 3 SAP-RFC destinations.

AlertMonFun =ALL =ALL =ALL =ALL =RFC_DESTINATION =1 \

=WARNING =RFC_Destinations =R3_RFC \

=CHECK =CONNECTION_TYPE =I =EQ =3 =

Check-RFC_DESTINATION Configuration
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In the following example of Check-RFC_DESTINATION Configuration, an event generating an alert
occurs whenever RFC_DESTINATION test fails for the single SAP-RFC destination namedOV_C01_
099.

AlertMonFun =ALL =ALL =ALL =ALL =RFC_DESTINATION =1 \

=WARNING =RFC_Destinations =R3_RFC \

=CHECK =NAME =I =CP =OV_C01_099 =

SAPABAP_SecMon

The SAPABAP_SecMonMonitoring Template enables monitoring of the SAP ABAP Security
parameters like the privileges and authorizations of important SAP users, parameters that affect the
overall SAP.

In addition to the other SAP user roles and authorizations required by the OMi MP for SAP, you also
have to assign the authorizations defined in the SAP user role /HPOV/SAPSPI_SECURITY_MON to
the OMi user under which SAPABAP_SecMonMonitoring Template runs before SAPABAP_SecMon
Monitoring Template starts; the user role /HPOV/SAPSPI_SECURITY_MON includes authorizations
(such as S_TCODE or S_USER_AUT) that are needed to execute the SAP reports, which SAPABAP_
SecMonMonitoring Template calls by means of the SAP RFC interface.

This section contains information about the following topics:

l "File Locations"

l "Alert Types"

l "RemoteMonitoring using SAPABAP_SecMonMonitoring Template "

File Locations

The SAPABAP_SecMonMonitoring Template uses the files listed in the following table:

File Description

r3monsec (.exe) Executable for the SAP System-security monitor.

r3monsec.cfg Configuration file for the SAP System-security monitor.

r3monsecpw.msg Contains encrypted passwords for standard Oracle users in an SAP
environment.

r3monsec.log File used to store trace data collected by the SAP System-security monitor.
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Alert Types

The SAPABAP_SecMonMonitoring Template uses the following alert types:

l "SAP_PARAMETERS"

Monitors security-related parameters such as those defined in the SAP report RSPFPAR.

l "DEFAULT_USERS"

Monitors settings for passwords defined for SAP andOracle users to ensure that insecure default
passwords are not in use.

l "PRIVILEGED_USERS"

Monitors any special privileges granted to SAP users or being requested by users who are not
normally entitled.

TheOMi MP for SAP interprets include and exclude parameter values for an alert-type entry according
to whether the values appear in the same parameters or in different parameters. TheOMi MP for SAP
compares values in different parameters using ‘and’; the OMi MP for SAP compares values in the same
parameter as follows.

l Include: use ‘or’ to compare the parameters

l Exclude: use ‘and’ to compare the parameters

TheOMi MP for SAP evaluates include values before it evaluates exclude values.

Note that the OMi MP for SAP ignores include and exclude parameters for the SAPABAP_SecMon
Monitoring Template alert types SAP_PARAMETERS and DEFAULT_USERS; however, youmust
use include and exclude parameters for the alert type PRIVILEGED_USERS.

SAP_PARAMETERS

Use the SAP_PARAMETERS alert type to configure the SAPABAP_SecMonMonitoring Template to
monitor the settings of (and any changes to) security-related SAP parameters. The SAP_
PARAMETERS alert type compares the values you define in the SAPABAP_SecMon
Monitoring Template with the contents of the SAP report RSPFPAR, which contains security-related
parameters for the SAP instances you aremonitoring.

The default settings for the alert type SAP_PARAMETERS reflect a small selection of the parameters
defined in the SAP report RSPFPAR; you can change the contents of the SAP_PARAMETERS
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section of the SAPABAP_SecMonMonitoring Template to suit the needs of your SAP environment by
adding, modifying, or removing values accordingly.

Note: The alert type SAP_PARAMETERS ignores the include (=I) and exclude (=E) parameter.

Example SAP_PARAMETERS settings

"Example SAP_PARAMETERS settings" shows how to configure SAPABAP_SecMon
Monitoring Template tomonitor the SAP parameter, which defines whether SAP should automatically
unlock locked SAP users at midnight. The example configuration tells SAPABAP_SecMon
Monitoring Template to check that the automatic unlocking of locked SAP users is disabled in SAP
(=EQ =0). In this example, SAPABAP_SecMonMonitoring Template would generate amessage with the
severity level “critical” if it is found that the parameter was enabled in SAP and assign the generated
message to the OMi message group R3_Security.

AlertMonFun =ALL =ALL =ALL =ALL =SECURITY =1\

=CRITICAL =SAP_PARAMETERS =R3_Security\

=SAP_PARAMETERS =login/failed_user_auto_unlock =I =EQ =0 =

"Default Settings for SAP_PARAMETERS" shows the default settings for the SAP_PARAMETERS
alert type; if your SAP Systems are configured differently, SAPABAP_SecMonMonitoring Template
will generate alerts. For example, in the default configuration, SAP user passwords must have 6
characters or more and contain at least 4 letters and 2 integers. If you configure your SAP instance to
allow passwords which do not conform to the rules defined in SAPABAP_SecMonMonitoring Template
configuration, for example: passwords which contain only five characters or do not contain any
integers, SAPABAP_SecMonMonitoring Template sends amessage to themessage browser.

Note that SAPABAP_SecMonMonitoring Template does not read or check the SAP passwords
themselves; SAPABAP_SecMonMonitoring Template compares the rules you define in the policy
configuration for the length and form of SAP passwords with the rules defined in SAP itself for
password creation. If the rules for password creation, form, or length in the SAPABAP_SecMon
Monitoring Template differ in any way from the rules for passwords defined in SAP, the OMi MP for
SAP sends amessage to themessage browser.

Default Settings for SAP_PARAMETERS

Parameter Default Value

login/failed_user_auto_unlock 0 (0=disabled; 1=enabled)

login/fails_to_session_end 3

login/fails_to_user_lock 5
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Parameter Default Value

login/min_password_diff 3

login/min_password_lng 6

login/min_password_letters 4

login/min_password_digits 2

login/min_password_specials 0

login/no_automatic_user_sapstar 1

login/password_max_new_valid 10

login/password_max_reset_valid 2

login/password_expiration_time 30

login/disable_password_logon 0 (0=disabled; 1=enabled)

login/disable_multi_gui_login 0 (0=disabled; 1=enabled)

login/disable_cpic 0 (0=disabled; 1=enabled)

login/system_client 100

login/disable_multi_rfc_login 0 (0=disabled; 1=enabled)

rdisp/gui_auto_logout 1800

DEFAULT_USERS

Use the DEFAULT_USERS alert type to configure the SAPABAP_SecMonMonitoring Template, to
check the passwords for standard SAP or Oracle database users and determine whether any well-
known, default passwords are still in use. Standard SAP users include SAP*, DDIC, SAPCPIC, and
EARLYWATCH. The DEFAULT_USERS alert typemakes use of the SAP report RSUSR003.

The SAPABAP_SecMonMonitoring Template configuration provides default settings for the alert type
DEFAULT_USERS. Note that the include (=I) and exclude (=E) parameter is ignored for the alert type
DEFAULT_USERS.

Default Settings

AlertMonFun =ALL =ALL =ALL =ALL =SECURITY =1\

=CRITICAL =DEFAULT_USERS =R3_Security\

=DEFAULT_USERS
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The default configuration for the DEFAULT_USERS alert type enables the SAP andOracle user
check, whichmeans themonitor generates an alert if it finds a default password in use.

PRIVILEGED_USERS

Use the PRIVILEGED_USERS alert type to configure the SAPABAP_SecMonMonitoring Template,
to check the authorizations granted to SAP users in the Systems you aremonitoring with the OMi MP
for SAP. The PRIVILEGED_USERS alert type compares the values defined in the SAPABAP_
SecMonMonitoring Template configuration with the contents of the SAP report RSUSR005, which
lists information concerning the critical authorizations granted to SAP users. The SAPABAP_SecMon
Monitoring Template generates an alert for any SAP user who has critical authorizations but is not
defined in the SAPABAP_SecMonMonitoring Template configuration.

Note: The SAP report RSUSR005 is SAP-client dependent; SAPABAP_SecMon
Monitoring Template monitors only the users for the SAP clients defined inMonitoring Template
Configuration.

The SAPABAP_SecMonMonitoring Template does not provide any default settings for the alert type
PRIVILEGED_USERS; you have to decide which user authorizations you want to monitor in SAP and
insert the strings that define them into themonitor template-configurationmanually. You can use the
report RSUSR005 to find the strings defining the authorizations you want to monitor, for example: “All
rights for background jobs”, as illustrated in"Example Settings for PRIVILEGED_USERS". Note that
you need to use a new line for each user authorization that you want to monitor.

After you have determined which user authorizations you want to monitor, set the include (=I) or
exclude (=E) parameter to specify which SAP users you want to check for the use (or misuse) of the
defined authorization "Example Settings for PRIVILEGED_USERS" shows how to exclude SAP user
KWAME from the check to determine which users have permission to execute external operating-
system commands.

Example Settings for PRIVILEGED_USERS

AlertMonFun =ALL =ALL =ALL =ALL =SECURITY =1\

=CRITICAL =PRIVILEGED_USERS =R3_Security\

=PRIVILEGED_USERS =All rights for background jobs =I =EQ =ALL =

AlertMonFun =ALL =ALL =ALL =ALL =SECURITY =1\

=CRITICAL =PRIVILEGED_USERS =R3_Security\

=PRIVILEGED_USERS =Execute external operating system commands\

=E =EQ =KWAME =
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Note that the string you paste into the SAPABAP_SecMonMonitoring Templatemust match an
existing string in SAP. If the string you paste into the SAPABAP_SecMonMonitoring Template
configuration does not exist in SAP, for example because it contains a typo or is only a sub-set of a
known SAP user-authorization string, nomatch occurs and the SAPABAP_SecMonMonitoring
Template does not send any message to themessage browser. For example: “Execute external
operating” would not match, since it is only a part of the complete user-authorization string “Execute
external operating system commands” defined in the SAPABAP_SecMonMonitoring Template.

Remote Monitoring using SAPABAP_SecMon Monitoring

Template

Tomake use of the remote-monitoring feature provided by the SAPABAP_SecMonMonitoring
Template, for example, to monitor security on an SAP server running on an operating system that is not
supported by the OMi MP for SAP or on an SAP node where the Operations Agent is not installed, you
need to enable the RemoteMonitoring keyword (by removing the leading hash symbol “#”) in the
SAPABAP_SecMonMonitoring Template configuration.

You also need to specify the name of the local host, which you want to perform themonitoring and the
name of the remote SAP server, whose security settings you want to monitor. Note that youmust add
a new line for each additional SAP server, which you want to monitor remotely.

Default SAPABAP_SecMon Monitoring Template Configuration

#------------------------------------------------------------

# TraceLevel hostname Disable=0 only error messages=1

# info messages=2 debug messages=3

#

TraceLevel =ALL =0

#---------------------------------------------------------------------------

# TraceFile hostname filename TraceMode TracePeriod

# (a=append/w=create(default)) (in mins)

TraceFile =ALL =r3monsec.log =w =60

#--------------------------------------------------------------------------

# History hostname path

# Path
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#

HistoryPathUnix =ALL =default

HistoryPathAIX =ALL =default

HistoryPathWinNT =ALL =default

#--------------------------------------------------------------------------

# Remote Local Remote

# Monitoring Host Host

RemoteMonitoring =sap1 =sdsap

#--------------------------------------------------------------------------

# AlertMonFun SAP SAP SAP SAP Alertmonitor Enable =1/

\

# Hostname System Number Client Disable=0

\

#

# OpC OpC OpC \

# Severity Object MsgGroup \

#

# Alerttype RFC Parameter

# =Parameter =Sign =Opt =Low =High

# [=Param =Sign =Opt =Low =High] ...

AlertMonFun =ALL =ALL =ALL =ALL =SECURITY =1\

=CRITICAL =SAP_PARAMETERS =R3_Security\

=SAP_PARAMETERS =login/failed_user_auto_unlock =I =EQ =0 =

AlertMonFun =ALL =ALL =ALL =ALL =SECURITY =1\

=CRITICAL =DEFAULT_USERS =R3_Security\

=DEFAULT_USERS = = = = =

AlertMonFun =ALL =ALL =ALL =ALL =SECURITY =1\

=CRITICAL =PRIVILEGED_USERS =R3_Security\
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=PRIVILEGED_USERS =All rights for background jobs =I =EQ =ALL =

SAPABAP_SplMon

The SAPABAP_SplMonMonitoring Templatemonitors the following entries in the print requests:

l Spooler entries: The number of spool requests which would generate an alert.

l Error generating spool requests: The number of error-generating spool requests that would generate
an alert

l Erroneous spooler entries: A specified printer has received erroneous spool requests.

The SAPABAP_SplMonMonitoring Template references output tasks in SAP NetWeaver transaction
SP01 and report sources in SAP NetWeaver transaction SE38.

Monitor Type

The SAPABAP_SplMonMonitoring Template is of type snapshot. Onemonitor run gathers only one
value set.

Alert Types

The SAPABAP_SplMonMonitoring Template has the following alert types:

l "SPOOL_ENTRIES_RANGE"

This defines the number of spool requests which, if exceeded, would cause an alert.

l "SPOOL_ERROR_RANGE"

This defines the number of error-generating spool requests which, if exceeded, would cause an
alert.

l "PRINT_ERROR_EXISTS"

This specifies the name(s) of printers for which an alert would be generated if a spool error exists.

File Locations

The SAPABAP_SplMonmonitor uses the files listed in this table.

File Description

r3moncol (.exe) Collector executable for the spooler monitor

r3monspl.cfg Configuration file for the spooler monitor.

r3monspl.log Trace file for storing trace data.
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The SAPABAP_SplMonMonitoring Template does not write history information to a specific history
file.

Environment Variables

The SAPABAP_SplMonMonitoring Template uses the environment variables described in
"Environment Variables".

Command-Line Parameters

The SAPABAP_SplMonMonitoring Template uses the command line parameters described in
Command Line Parameters.

Remote Monitoring

Formore information about configuring the SAPABAP_SplMonMonitoring Template tomonitor another
SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

Configuring Alert Types

You can configure SAPABAP_SplMonMonitoring Template, the spooler monitor, for each of the alert
types and then define exceptions for different monitoring conditions. For more detailed information, see
the alert-type tables which give the parameters and configuration for each alert type.

SPOOL_ENTRIES_RANGE

The SPOOL_ENTRIES_RANGE alert type defines the number of spool requests which, if exceeded,
would generate an alert. Use the SPOOL_ENTRIES_RANGE alert type to configure SAPABAP_
SplMonMonitoring Template to generate an alert if the number of spool entries exceeds the range
specified. The following table lists the parameters that you can use to configure the SPOOL_
ENTRIES_RANGE alert type and shows the value assigned to the parameters by default:

The configuration of the RANGE parameter is mandatory.

Parameter
Name Description

Query
Conditions

Default
Value

RANGE The number of spool entries outside of which an
alert will be generated.

Note that, despite its name, you do not need to
specify this parameter as a select-option range.

= Sign: I, E I

= Opt: EQ, GT,
GE, LE, LT, BT

GT

= Low: * 50

= High:
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*Specify this parameter as a number. Otherwise themonitor ends with a dump.

In the Default SPOOL_ENTRIES_RANGE Configuration, an event generating an alert occurs if there
aremore than 50 spooler entries.

The Default SPOOL_ENTRIES_RANGE Configuration

AlertMonFun =ALL =ALL =ALL =ALL =SPOOLER =1\

=CRITICAL =Spool =R3_Spooler \

=SPOOL_ENTRIES_RANGE =RANGE =I =GT =50 =

SPOOL_ERROR_RANGE

The SPOOL_ERROR_RANGE alert type defines the number of erroneous spool requests which, if
exceeded, would generate an alert. Use the SPOOL_ERROR_RANGE alert type to configure
SAPABAP_SplMonMonitoring Template to generate an alert if the number of erroneous spool entries
exceeds the range specified. The following table lists the parameters that you can use to configure the
SPOOL_ERROR_RANGE alert type and shows the value assigned to the parameters by default:

Note: The configuration of the RANGE parameter is mandatory.

Parameter Name Description
Query
Conditions Default Value

RANGE The number of erroneous spool requests
outside of which an alert will be
generated.

Note that, despite its name, you do not
need to specify this parameter as a
select option range.

= Sign: I, E I

= Opt: EQ, GT,
GE,LE, LT, BT

GT

= Low: * 50

= High:

*Specify this parameter as a number; otherwise themonitor ends with a dump.

In the Default SPOOL_ERROR_RANGE Configuration, an event generating an alert occurs if there are
more than 50 erroneous spool requests.

The Default SPOOL_ERROR_RANGE Configuration

AlertMonFun =ALL =ALL =ALL =ALL =SPOOLER =1\

=CRITICAL =Spool =R3_Spooler \

=SPOOL_ERROR_RANGE =RANGE =I =GT =50 =
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PRINT_ERROR_EXISTS

The PRINT_ERROR_EXISTS alert type defines the printers to monitor for spool errors. Use the
PRINT_ERROR_EXISTS alert type to configure SAPABAP_SplMonMonitoring Template to generate
an alert if a spool error exists for the specified printer. The following table lists the parameters that you
can use to configure the PRINT_ERROR_EXISTS alert type and shows the value assigned to the
parameters by default.

The SAPABAP_SplMonMonitoring Template generates an alert if a spool error exists for a specified
printer. The configuration of the PRINTER parameters is mandatory.

Parameter
Name Description

Query
Conditions

Default
Value

PRINTER The printer(s) which should be checked for spool
entries of state error.

= Sign: I, E I

= Opt: CP

= Low: *

= High:

In the Default PRINT_ERROR_EXISTS Configuration, SAPABAP_SplMonMonitoring Template
generates an alert if any printer has a spool entry-state error.

The Default PRINT_ERROR_EXISTS Configuration

AlertMonFun =ALL =ALL =ALL =ALL =SPOOLER =1\

=WARNING =Spool =R3_Spooler \

=PRINT_ERROR_EXISTS =PRINTER =I =CP =* =

SAPABAP_StatRecMon

The SAPABAP_StatRecMonMonitoring Template reads the statistical records and returns the average
response time per transaction.

The SAPABAP_StatRecMonMonitoring Template uses the alert types RESPONSE_TIME and the
parameter TRANSACTION to restrict the data selected. The transactions monitored are specified in
the parameter TRANSACTION. If this parameter is not specified, the average response time is
reported for each transaction in the local statistics file for the specified time frame.

Type
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The SAPABAP_StatRecMonMonitoring Template is time-frame based. Each run gathers only one
value set. To collect a set of values, themonitor must be scheduled on a regular basis. Since various
monitors have different requirements, you have to specify the interval for eachmonitor individually.
This monitor uses the time frame between the last start and the current start times and considers only
those transactions which complete within the specified time-frame.

The SAPABAP_StatRecMonMonitoring Template collects application-server-specific metrics; it
should run on each application server whose performance you want to monitor.

Frequency

It is recommended that you configure the SAPABAP_StatRecMonMonitoring Template to run once a
minute.

Data Source

The SAPABAP_StatRecMonMonitoring Template uses the following SAP transaction as its data
source:

l For SAP 7.0 and higher: STAD

Metrics

The following table shows the values in the performance table returned by the SAPABAP_StatRecMon
Monitoring Template.

Order Metric Name Description

1 SAP_TCODE Transaction code associated with
themeasured transaction.

This metric is only visible with the
HP PerformanceManager.

2 SAP_RESPONSE_TIME Time SAP takes to respond.

3 SAP_NET_TIME Net Time.

4 SAP_REC_COUNT The number of times themeasured
transaction occurs.

SAPABAP_StatusMon

The SAPABAP_StatusMonMonitoring Template enables monitoring of the SAP ABAP Application
Server's Availability Status.
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The SAPABAP_StatusMonMonitoring Template is of type time frame. It runs every twominutes and
compares the current value with the previous value stored in the history file and generates amessage if
it finds a difference, which it needs to report.

Note: The lack of response from SAP could be due to a problem which does not mean that the
System is down. For example, SAP would not respond if all available dialog work processes were
allocated. For more information about how SAPABAP_StatusMonMonitoring Template interprets
the responses it receives from SAP, see "Establishing the SAP Status".

File Locations

Th following table lists the files used by the SAPABAP_StatusMonMonitoring Template.

File Description

r3status (.exe) Executable for the SAPABAP_StatusMonMonitoring Template

r3status.log The SAPABAP_StatusMonMonitoring Template creates a log/trace file after each
run of themonitor. The trace file is stored in the standard OMi MP for SAP Agent
log directory.

r3itosap.cfg The SAPABAP_StatusMonMonitoring Template uses the initial user name and
password in the r3itosap.cfg to determine which SAP instances it is supposed
tomonitor.

r3status.cfg The SAPABAP_StatusMonMonitoring Template uses information in template
configuration to determine history paths, trace levels, and which SAP instances it
is supposed tomonitor on remote SAP servers.

r3status.his History file for storing data after each run of the SAPABAP_StatusMon
Monitoring Template. The SAPABAP_StatusMonMonitoring Template uses
information in this file to determine whether a change of status has occurred. For
more information, see "History File".

Environment Variables

The following table lists the environment variables used by the SAPABAP_StatusMonMonitoring
Template:

Environment Variable Description

SAPOPC_RFC_TIMEOUT Set time out value for RFC connections -
default is 20 seconds.

SAPOPC_HISTORYPATH Path to the r3status.his history file.

SAPOPC_R3STATUS_CONFIGFILE Name of the configuration file, which the
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Environment Variable Description

SAPABAP_StatusMon
Monitoring Template uses.

SAPOPC_R3ITOSAP_CONFIGFILE Name of the general configuration file,
which contains information used by the
OMi MP for SAP.

SAPOPC_TRACEPATH Path to the SAPABAP_StatusMon
Monitoring Template trace file.

History File

The first time the SAPABAP_StatusMonMonitoring Template runs, it writes its findings to the history
file, r3status.his. The next time the SAPABAP_StatusMonMonitoring Template runs, it uses the
information in the r3status.his file to determine whether a change of status has occurred since the
last time themonitor ran and, as a consequence, which if any message it has to send to the OMi.

The SAPABAP_StatusMonMonitoring Template updates the entries in the r3status.his file at the
end of each time it runs, with the current timestamp and the current status of eachmonitored SAP
instance.

The following excerpt from the r3status.his file shows the format and contents of the r3status.his
file.

Excerpt from the r3status.his file

021028-11:18:29

#---------------------------------------------------------------

021028-11:18:29 #Keyword SAP SAP SAP State

021028-11:18:29 # System Number Instance

021028-11:18:29 #

021028-11:18:29 ConfiguredInstance =DEV =00 =DVEBMGS00 =UP

021028-11:18:29 ConfiguredInstance =PKR =99 =DVEBMGS99 =DOWN

-----------------------------------------------------------------------------

---
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Configuring SAPABAP_StatusMon Monitoring Template

You can configure the SAPABAP_StatusMonMonitoring Template using the keywords listed below to
change the configuration from default settings tomeet the requirements of your particular environment.
Where appropriate, possible values for a given keyword are also specified. The default SAPABAP_
StatusMonMonitoring Template configuration shows a completeMonitoring Template configuration,
whichmonitors the status of both local and remote SAP Systems.

The following standard keywords work as expected in the context of the SAPABAP_StatusMon
Monitoring Template:

l TraceLevel

l TraceFile

l HistoryPath [Unix | AIX |WinNT]

The following keywords require special attention when used in the context of the OMi MP for
SAPSAPABAP_StatusMonMonitoring Template:

l EnableDPQueueCheck

SAPABAP_StatusMonMonitoring Template requires a dialog work process to log on to SAP and
determine the System’s status. Enable the EnableDPQueueCheck keyword (=1) if the SAP
System whose status you aremonitoring is experiencing performance problems and you want
SAPABAP_StatusMonMonitoring Template to check the size and status of the ABAP dispatcher
before starting its monitor run. If there are no, or too few, dialog work processes available,
SAPABAP_StatusMonMonitoring Template sends amessage to themessage browser indicating
that it did not start due to the violation of a threshold defined for dialog processes. The command
disables themonitor run only for the SIDs where the threshold violation for the dialog work
processes occurred.

If you use the EnableDPQueueCheck keyword in the SAPABAP_StatusMonMonitoring Template,
remember to configure the keywords DPQueueCheck and DisableMonitoringWithSeverity in the
SAPABAP_DispMonMonitoring Template configuration, too. For more information about
monitoring the SAPABAP_DispMonMonitoring Template, see "SAPABAP_DispMon"
Monitoring Template.

The default run interval for SAPABAP_StatusMonMonitoring Template is twominutes. If your SAP
landscape consists of large numbers of SAP instances running onmultiple hosts, network
congestion or a slow response from SAP might prevent EnableDPQueue from checking the status
of the ABAP dispatchers on all the configured SAP instances before SAPABAP_StatusMon
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Monitoring Template starts its next run. In the unlikely event that this happens, the old instance of
SAPABAP_StatusMonMonitoring Template aborts without reporting the status of any dispatchers
that it has not yet checked. To avoid this problem re-occurring, increase the run interval for
SAPABAP_StatusMonMonitoring Template.

l RemoteMonitoring

SAPABAP_StatusMonMonitoring Template cannot check the status of the ABAP dispatcher on a
SAP System, which the OMi MP for SAP is monitoring remotely.

Establishing the SAP Status

When the SAPABAP_StatusMonMonitoring Template checks the availability of an SAP System, it
reports the status as: Up, Down, or Connection time-out. Although themeaning of “Up” and “Down” is
clear, the status of the connection time-out status requires some explanation. The time-out status
could occur if the SAP System is hanging, in which case the problem could be due to an RFC time out,
which itself needs investigating and is a good example to show how difficult it can be sometimes to
establish the exact state of the SAP System theOMi MP for SAP is monitoring.

The SAPABAP_StatusMonMonitoring Template, considers an SAP instance as “not available” if the
SAP instance does not respond within 60 seconds. However, the lack of response from SAP could be
due to a problem which does not mean that the System is down, for example: all available dialog work
processes are allocated, or all available SAP gateway connections are busy. TheOMi MP for SAP's,
SAPABAP_StatusMonMonitoring Template, reports the status of the SAP System it is monitoring
according to the following rules:

l Available:

SAPABAP_StatusMonMonitoring Template reports an SAP System as available if it can log on to
the SAP instance and, in addition, start and receive a response from the SAP functionmodule
RFC_SYSTEM_INFOwithin 60 seconds.

l Not Available:

SAPABAP_StatusMonMonitoring Template reports an SAP System as not available if the SAP
instance does not respond within 60 seconds or the functionmodule RFC_SYSTEM_INFO could
not start, for example: due to the fact that the instance is down.
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Monitoring SAP Remotely

Tomake use of the remote-monitoring feature provided by the OMi MP for SAP, for example, to monitor
a SAP server running on an operating system that is not supported by the OMi MP for SAP, youmust
enable the RemoteMonitoring keyword (by removing the leading hash symbol “#”) in the SAPABAP_
StatusMonMonitoring Template. Next, on the same line, define the name of the local host, which you
want to use for monitoring the remote SAP server. Finally, you have to define the name of the remote
SAP server, which you want to monitor. Youmust define a new line to the Default SAPABAP_
StatusMonMonitoring Template configuration for each additional SAP server, which you want to
monitor remotely.

Note:You can associate multiple remote SAP servers with one single local host or you can
associate single remote hosts with individual different local hosts. Default SAPABAP_StatusMon
Monitoring Template configuration shows amixed approach where one local host “sap1” is used to
monitor two remote hosts; “sdsap” and “sapwolf ”. A third local host “sap2” remotely monitors the
remote host “triosap”.

For more information about the contents of the SAPABAP_StatusMonMonitoring Template’s
configuration including the keywords and parameters you use to define local and remote server names,
see the entry concerning “RemoteMonitoring” in "Configuring SAPABAP_StatusMon
Monitoring Template".

Default SAPABAP_StatusMon Monitoring Template Configuration

#----------------------------------------------------------------------

# TraceLevel hostname Disable=0 only error messages=1

# info messages=2 debug messages=3

#

TraceLevel =ALL =0

#-----------------------------------------------------------------------

# TraceFile hostname filename TraceMode TracePeriod

# (a=append/w=create(default)) (in mins)

TraceFile =ALL =r3status.log =w =60

#----------------------------------------------------------------------

# History hostname path
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# Path

#

HistoryPathUniX =ALL =default

HistoryPathAIX =ALL =default

HistoryPathWinN =ALL =default

#------------------------------------------------------------

# Check the ABAP dispatcher before a connection to SAP is

# opened. If the dialog queue is too full or not enough

# free work processes are available, monitoring is disabled.

#

# This feature should only be enabled in special cases. For

# regular dispatcher monitoring, use the r3mondisp.

#

# EnableDPQueueCheck hostname SAP SAP Enable=1/

System Number Disable=0

EnableDPQueueCheck =ALL =ALL =ALL =0

#----------------------------------------------------------

# Remote Local Remote

# Monitoring Host Host

RemoteMonitoring =sap1 =sdsap

RemoteMonitoring =sap1 =sapwolf

RemoteMonitoring =sap2 =triosap

#------------------------------------------------------------

SAPABAP_SysChgOptMon

The SAPABAP_SysChgOptMonMonitoring Template enables monitoring of the SAP ABAP System
Change options based on the global edit Status flag, namespaces, and software components.
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SAPABAP_SysChgOptMonMonitoring Template double-checks the SAP system change options
using the SAP NetWeaver transaction SE06 as a reference.

Monitor Type

The SAPABAP_SysChgOptMonMonitoring Template is of type snapshot and does not make use of
alert types or parameters. Onemonitor run gathers only one value set.

Alert Types

The SAPABAP_SysChgOptMonMonitoring Template has only one alert type:

CHANGE_OPT

Monitors and double-checks the SAP System change options and generates an alert if the option
matches the configuration.

File Locations

The SAPABAP_SysChgOptMonMonitoring Template uses the files listed in the following table:

File Description

r3moncol (.exe) Collector executable for the system change optionmonitor.

r3monchg.cfg Configuration file for system change optionmonitor.

r3monchg.log Trace file for storing trace data.

The SAPABAP_SysChgOptMonMonitoring Template does not write history information to a specific
history file.

Environment Variables

The SAPABAP_SysChgOptMonMonitoring Template uses the environment variables described in
"Environment Variables".

Command-Line Parameters

The SAPABAP_SysChgOptMonMonitoring Template uses the command line parameters described in
Command Line Parameters.

Remote Monitoring

Formore information about configuring the SAPABAP_SysChgOptMonMonitoring Template tomonitor
another SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 195 of 308



Configuring SAPABAP_SysChgOptMon Monitoring Template

Alert Types

The general rules mentioned in the following section concern the use of exclude and include parameter
values. The rules are particularly important for SAPABAP_SysChgOptMonMonitoring Template alert
types.

Parameter Values

This section describes how theOMi MP for SAPinterprets include and exclude parameter values for an
alert type entry. TheOMi MP for SAP compares values in different parameters using ‘and’; the OMi MP
for SAP compares values in the same parameter as follows:

l Include: use ‘or’ to compare the parameters

l Exclude: use ‘and’ to compare the parameters

Note that the OMi MP for SAP evaluates include values before exclude values, as shown in the
following table:

Select
Options

Alert Type: CHANGE_OPT (SAP 4.6x) Example
Configuration of Select Options Comparison

1 =SYSTEM_CHANGE_OPTION =1 =WARNING
=SystemChange =R3_Security = NSP_EDTFLAG =I = CP=
/0* =

OR

2 =SYSTEM_CHANGE_OPTION =1 =WARNING
=SystemChange = =R3_Security = NSP_EDTFLAG =I =EQ
=/SAPQUERY/ =

OR

3 =SYSTEM_CHANGE_OPTION =1 =WARNING
=SystemChange =R3_Security = NSP_EDTFLAG =E =EQ
=LOCAL =

AND

CHANGE_OPT

The CHANGE_OPT alert typemonitors and double-checks the SAP system change options and
generates an alert if the settings for the flag parameters allow editing. The configuration of all
parameters is mandatory. Multiple parameter entries on a single line are not allowed; use a new line to
specify each one of any multiple configurations. For more information about themeaning of the query
conditions in theMonitoring Template configuration, see "Parameters and Delimiters ". The following
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table lists the parameters that you can use to configure the CHANGE_OPT alert type and shows the
value assigned to the parameters by default:

Parameter Name Description
Query
Conditions

Default
Value

EDTFLAG Flag indicating
if an object can
be edited.

= Sign: I I

= Opt: EQ EQ

= Low: ON,
OFF,
PATCH
(PATCH=set
to patch
system)

PATCH

= High:

NSP_EDTFLAG Flag indicating
which specified
name space(s)
to set to ON.

= Sign: I I

= Opt: EQ,
CP

CP

= Low (See
list of name
space
change
options for
SAP 4.6. X
in Table 30.)

*

= High:

SWC_EDTFLAG Flag indicating
which specified
software
components to
set to ON.

= Sign: I I

= Opt: EQ,
CP

CP

= Low:
<specified
software
component>
(See list of
name space
change
options for
SAP 4.6. X
in Table 30.)

*

= High:
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In the Default CHANGE_OPT Configuration, an event generating an alert occurs when the global
system change is OFF or the specified name space is Local Objects (/0LOCAL/), or the specified
software component is Local Developments (no automatic transport).

The Default CHANGE_OPT Configuration

AlertMonFun =ALL =ALL =ALL =ALL =SYSTEM_CHANGE_OPTION =1\

=WARNING =SystemChange =R3_Security \

=CHANGE_OPT =NSP_EDTFLAG =I =EQ =/0LOCAL/ =

AlertMonFun =ALL =ALL =ALL =ALL =SYSTEM_CHANGE_OPTION =1\

=WARNING =SystemChange =R3_Security \

=CHANGE_OPT =SWC_EDTFLAG =I =EQ = LOCAL =

AlertMonFun =ALL =ALL =ALL =ALL =SYSTEM_CHANGE_OPTION =1\

=WARNING =SystemChange =R3_Security \

=CHANGE_OPT =EDTFLAG =I =EQ =OFF =

The Customized CHANGE_OPT Configuration

AlertMonFun =ALL =ALL =ALL =SYSTEM_CHANGE_OPTION =1\

=WARNING =SystemChange =R3_Security \

=CHANGE_OPT =NSP_EDTFLAG =I =EQ =/SAPQUERY/ =

AlertMonFun =ALL =ALL =ALL =ALL =SYSTEM_CHANGE_OPTION =1\

=WARNING =SystemChange =R3_Security \

=CHANGE_OPT =SWC_EDTFLAG =I =EQ = SAP_HR =

AlertMonFun =ALL =ALL =ALL =ALL =SYSTEM_CHANGE_OPTION =1 \

=WARNING =SystemChange =R3_Security \

=CHANGE_OPT =EDTFLAG =I =EQ =OFF =

In the Customized CHANGE_OPT Configuration, an event generating an alert occurs when theGlobal
Change option is OFF or the system space change optionABAP query /SAP is ON, or the software
component change option for HumanResources is ON.

Software Components Change Options
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Technical ID Description

HOME Customer developments

LOCAL Local developments (no automatic transport)

SAP_ABA Cross-Application Component

SAP_APPL Logistics and Accounting

SAP_BASIS SAP Basis Component

SAP_HR HumanResources

Name System Change Options for SAP 6.x

Technical ID Description

/0CUST/ Customer name range

/0SAP/ General SAP name range

/1BCABA/ ABAP & GUI tools

/1BCDWB/ Development Workbench

/1BCDWBEN/ Enqueue function groups

/1COPA/ Generated objects in CO-PA

/1ISRWP/ IS-R merchandise and assortment controlling

/1ISU/ Generation namespace for CIC (Customer Interaction Center)

/1PAPA/ Personnel administration

/1PAPAXX/ Personnel administration - general

/1PSIS/ Project Information System - Logical database PSJ

/1PYXXFO/ PY-XX Form tool: Generated objects

/1SAP1/ General SAP generation namespace

/1SDBF12L/ Generation of pricing report

/BI0/ Business InformationWarehouse: SAP namespace

/BIC/ Business InformationWarehouse: Customer namespace

/SAPQUERY/ ABAP query /SAP

/SAPRRR/ Ready-to-Run SAP

/SAPSMOSS/ Interface: SAP messages to the SAP Online Service System

/SAPTRAIN/ SAP training

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 199 of 308



SAPABAP_TraceMon

The SAPABAP_TraceMonMonitoring Template enables monitoring of all the SAP Trace and Log files
for "ERROR". SAPABAP_TraceMonMonitoring Templatemonitors only what has occurred since its
previous run. Any error within a trace file generates only a single alert. The file monitor scans the
following directories, where <SID> refers to the SAP system ID and <InstanceNumber> refers to the
SAP instance number of themonitored SAP System:

l UNIX/Linux: /usr/sap/<SID>/<InstanceNumber>/work/

l Windows: <drive:>\usr\sap\<SID>\<InstanceNumber>\work

Messages generated by this monitor include an operator-initiated action, which calls the vi editor. vi
displays a list of all trace files and log files and prompts you to select a file from the list and display its
contents.

File Locations

The SAPABAP_TraceMonMonitoring Template includes files listed in the following table:

File Description

r3mondev (.exe) Executable for the file monitor.

r3mondev.cfg Configuration file for monitored files

r3mondev.his History file that stores data for eachmonitor run

Environment Variables

The SAPABAP_TraceMonMonitoring Template uses environment variables listed in the following
table:

Environment Variable Description

SAPOPC_DRIVE TheWindows drive where the HPOM agent is running, for example,
E:\usr\...

SAPOPC_HISTORYPATH Path to the r3mondev history file

SAPOPC_R3MONDEV_
CONFIGFILE

Name of the r3mondev configuration file

SAPOPC_SAPDIR TheWindows drive where SAP NetWeaver is running, for example:
E:\usr\sap

SAPOPC_TRACEPATH Path to the r3mondev trace file
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Monitoring Conditions

This section of the SAPABAP_TraceMonMonitoring Template enables you to specify the device
monitoring details for the OMi MP for SAP.

For more information about the entries in the SAPABAP_TraceMonMonitoring Template including
keywords and their possible values along with a description of each editable parameter, see the
following excerpt:

#----------------------------------------------------------------------------

-

# TraceLevel hostname only error messages=1 info messages=2 debug

messages=3

# Disable=0

TraceLevel =ALL =0

#----------------------------------------------------------------------------

-

# TraceFile hostname filename TraceMode TracePeriod

# (a=append/w=create(default)) (in mins)

TraceFile =ALL =r3moncts.log =w =60

#---------------------------------------------------------------------------

# History hostname path

# Path

#

HistoryPathUnix =ALL =default

HistoryPathAIX =ALL =default

HistoryPathWinNT =ALL =default

#------------------------------------------------------------

# AlertDevMon SAP SAP Enable =1 Filemask Severity Opc OpC

# Sys Number Disable=0 Object MsgGro

up

#AlertDevMon =ALL =ALL =1 =dev_* =WARNING =r3mondev =R3_Trace
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#AlertDevMon =ALL =ALL =1 =std* =CRITICAL =r3mondev =R3_Trace

#Dispatcher trace file

AlertDevMon =ALL =ALL =1 =dev_disp =WARNING =r3mondev =R3_Trace

#Workprocess trace file for workprocess with number 0

AlertDevMon =ALL =ALL =1 =dev_w0 =WARNING =r3mondev =R3_Trace

#message server trace file

AlertDevMon =ALL =ALL =1 =dev_ms =WARNING =r3mondev =R3_Trace

#screen processor trace file

AlertDevMon =ALL =ALL =1 =dev_dy0 =WARNING =r3mondev =R3_Trace

#tp process trace file

AlertDevMon =ALL =ALL =1 =dev_tp =WARNING =r3mondev =R3_Trace

-----------------------------------------------------------------------------

---

Themonitoring conditions section of the SAPABAP_TraceMonMonitoring Template includes the
following default settings:

# AlertDevMon SAP SAP Enable =1 Filemask Severity OpcObject OpCMsgGroup

# System Number Disable=0

#AlertDevMon =ALL =ALL =1 =dev_* =WARNING =r3mondev =R3_Trace

#AlertDevMon =ALL =ALL =1 =std* =MAJOR =r3mondev =R3_Trace

Configuring SAPABAP_TraceMon Monitoring Template

You can edit the SAPABAP_TraceMonMonitoring Template configuration in the following ways:

l Disable messages

If you do not want to receive any messages relating to dev_* files for any of the SAP systems you
aremonitoring using the OMi MP for SAP, change the first line of the SAPABAP_TraceMon
Monitoring Template configuration file as follows:

AlertDevMon =ALL =ALL =0 =dev_* =WARNING =r3mondev =R3_Trace

l Change a message’s severity level
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If you want to reduce the severity of all messages relating to std* files from critical to warning,
change the second line of the SAPABAP_TraceMonMonitoring Template configuration file as
follows:

AlertDevMon =ALL =ALL =1 =std* =WARNING =r3mondev =R3_Trace

l Define exceptions to general rules

If you want to increase the severity of messages relating to dev_* files on SAP system LP2 from
warning to critical, leave the default settings as they are and add the following line:

AlertDevMon =LP2 =ALL =1 =dev_* =CRITICAL =r3mondev =R3_Trace

Note:Wildcards are only allowed at the end of the string. Only SAP trace files located in the work
directory are relevant and the names of these files must begin with either dev or std.

SAPABAP_TransMon

The SAPABAP_TransMonMonitoring template enables monitoring of the successfully
imported/exported SAP ABAP transports, failed imports/exports, availability of confirmed/unconfirmed
repairs and connections/tptests to the configured systems.

The SAPABAP_TransMonMonitoring template is application-server independent and is used to check
the following parts of the transport system:

l Successful or failed imports and exports for themonitored system

l The presence of confirmed and unconfirmed repairs in themonitored system

l Connections that use a connection test (PING) to the configured systems

l TP-Tests of the configured systems

The SAPABAP_TransMonMonitoring template references transport routes in SAP NetWeaver
transactions STMSand SE01.

Monitor Type

The SAPABAP_TransMonMonitoring template is of type snapshot. Onemonitor run gathers only one
value set.

Alert Types

The transport alert monitor has the following alert types, which use amixture of snapshot and time-
frame report types:
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l TRANS

Defines alert conditions for successful and failed transport exports and imports.

l REPAIR

Defines alert conditions for confirmed and unconfirmed repairs.

l RFCONNECT

Defines alert conditions for the RFC connections between the systems.

l TPTEST

Defines alert conditions concerning the TP interface with the database. It includes a connection test
(PING), TP call to the connected database, check of the TP interface (version, transport directory,
TPPARAM path, file check, and TPLOG check).

File Locations

The SAPABAP_TransMonMonitoring template uses the files listed in the following table:

File Description

r3moncol (.exe) Collector executable for the transport monitor

r3montra.cfg Configuration file for the transport monitor.

r3montra.log Trace file for storing trace data.

The SAPABAP_TransMonMonitoring Template does not write history information to a specific history
file.

Environment Variables

The SAPABAP_TransMonMonitoring Template uses the environment variables described in
"Environment Variables".

Command-Line Parameters

The SAPABAP_TransMonMonitoring Template uses the command-line parameters described in
"Command Line Parameters".

Remote Monitoring

Formore information about configuring the SAPABAP_TransMonMonitoring Template tomonitor
another SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".
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Configuring Transport-Monitor Alert Types

Youmust configure the parameter ALERT_THRESHOLD for all alert types for SAPABAP_TransMon
Monitoring Template. All other parameters are optional. Note the general rules below on exclude and
include parameters for SAPABAP_TransMonMonitoring Template.

Parameter Values

This section describes how theOMi MP for SAP interprets include and exclude parameter values for an
alert type entry. TheOMi MP for SAP compares values in different parameters using ‘and;’ OMi MP for
SAP compares values in the same parameter as follows.

l Include:Use ‘or’ to compare the parameters

l Exclude:Use ‘and’ to compare the parameters

TheOMi MP for SAP evaluates include values before exclude values.

TRANS

TRANS is a time-frame based alert type for SAPABAP_TransMonMonitoring Template.The
SAPABAP_TransMonMonitoring Template generates an alert if the number of failed or successful
transport imports and exports exceeds a defined threshold. Note that the parameter USERNAME is
mandatory for the TRANS alert type.

The following table lists the parameters that you can use to configure the TRANS alert type and shows
the value assigned to the parameters by default.

Parameter
Name Description

Query
Conditions Default Value

ALERT_
THRESHOLD

The return code of the transport state above which
an alert occurs. For example, 4 (warning).

= Sign: I, E I

= Opt: GT,
GE, LT, LE

GT

= Low: 1 4

= High:
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Parameter
Name Description

Query
Conditions Default Value

E_SUCCESS Filtering option to include all successfully exported
transports.

= Sign: I, E I

= Opt: EQ EQ

= Low: 2 X

= High:

E_FAILURE Filtering option to include all failed exported
transports.

= Sign: I, E I

= Opt: EQ EQ

= Low: 2 X

= High:

I_SUCCESS Filtering option to include all successfully imported
transports.

= Sign: I, E I

= Opt: EQ EQ

= Low: b X

= High:

I_FAILURE Filtering option to include all failed imported
transports.

= Sign: I, E I

= Opt: EQ EQ

= Low 2 X

= High:

USERNAME The login name of the SAP NetWeaver user 3. This
parameter is mandatory.

= Sign I, E I

= Opt:
EQ,CP

EQ

= Low:
<username>

ddic 4

= High:

1. Specify as a number, otherwise themonitor ends with a dump.

2. Any entry other than the default is treated as space.

3. Since requests/tasks are user dependent, you can use it to restrict data.

4. SAP user name for database-administration tasks.

In The Default TRANS Configuration, an event generating alert occurs if the threshold for imported
or exported transports is greater than four (4).
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Note: The number “4” defined in the threshold for the parameter ALERT_THRESHOLD does not
refer to the total number of imports. It refers to the SAP return code associated with the import. In
this example, transport imports with return codes of 4 (warning) and above (GT=4) would generate
an alert. For more information about import return codes, refer to the SAP product documentation.

The Default TRANS Configuration

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1\

=WARNING =Trans =R3_Transport\

=TRANS =I_FAILURE =I =EQ =X =\

=USERNAME =I =EQ =ITOUSER =\

=ALERT_THRESHOLD =I =GT =4 =

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1\

=WARNING =Trans =R3_Transport\

=TRANS =I_SUCCESS =I =EQ =X =\

=USERNAME =I =EQ =ITOUSER =\

=ALERT_THRESHOLD =I =GE =4 =

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1\

=WARNING =Trans =R3_Transport\

=TRANS =E_FAILURE =I =EQ =X =\

=USERNAME =I =EQ =ITOUSER =\

=ALERT_THRESHOLD =I =GT =4

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1\

=WARNING =Trans =R3_Transport\

=TRANS =E_SUCCESS =I =EQ =X =\

=USERNAME =I =EQ =ITOUSER =\

=ALERT_THRESHOLD = I = GT = 4 =
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REPAIR

REPAIR is a time-frame based alert type for SAPABAP_TransMonMonitoring template. The
SAPABAP_TransMonMonitoring template generates an alert if the number of confirmed or
unconfirmed repairs exceeds a specified threshold.

The following table lists the parameters that you can use to configure the REPAIR alert type and shows
the value assigned to the parameters by default. Note that the parameter ALERT_THRESHOLD is
mandatory.

Parameter Name Description Query Conditions Default Value

R_CONFIRM Filtering option to include all
confirmed repairs.

= Sign: I, E I

= Opt: EQ EQ

= Low:1 X

= High:

R_UNCONFIR Filtering option to include all
unconfirmed repairs.

= Sign: I, E I

= Opt: EQ

= Low: 1 X

= High:

USERNAME The login name of the SAP
NetWeaver user 2. This
parameter is mandatory.

= Sign I, E I

= Opt: EQ,CP EQ

= Low: <username> ddic 3

= High:

ALERT_THRESHOLD The number of the allowed
repair state above which an
alert occurs.

= Sign I, E I

= Opt: GT, GE, LT, LE GT

= Low: 4 4

= High:

1. Any entry other than the default is treated as space.

2. Since requests/tasks are user dependent, you can use it to restrict the data.

3. SAP user name for database-administration tasks.

4. Specify the parameter as a number or themonitor ends with a dump.
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In the Default REPAIR Configuration, an event generating an alert occurs if the alert threshold of four
(=GT =4) R_CONFIRM or R_UNCONFIR errors is exceeded for the specified target System.

The Default REPAIR Configuration

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1 \

=WARNING =Repair =R3_Transport \

=REPAIR =R_CONFIRM =I =EQ =X = \

=ALERT_THRESHOLD =I =GT =4 =

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1 \

=WARNING =Repair =R3_Transport \

=REPAIR =R_UNCONFIR =I =EQ =X = \

=ALERT_THRESHOLD =I =GT =4 =

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1 \

=WARNING =Repair =R3_Transport \

=REPAIR =USERNAME =I =CP =* =\

=ALERT_THRESHOLD =I =GT =4 = =

RFCONNECT

RFCONNECT is a snapshot alert type for SAPABAP_TransMonMonitoring Template. Snapshot alert
types take a picture of the system at themoment themonitor runs. SAPABAP_TransMon
Monitoring template generates an alert if the number of RFC-connect errors to the target system
exceeds the specified alert threshold.

The following table lists the parameters that you can use to configure the RFCONNECT alert type and
shows the value assigned to the parameters by default. Note that the parameter ALERT_
THRESHOLD is mandatory. All other parameters are optional.
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Parameter Name Description Query Conditions Default Value

ALERT_
THRESHOLD

Number of
reconnect
errors above
which an
alert occurs.

= Sign I, E I

= Opt: GT, GE, LT, LE GT

= Low: # 4

= High:

CHECKSYSTEM System ID
of the
system you
are
monitoring.

= Sign: I, E I

= Opt: EQ, CP EQ

= Low: <SID> '*'

= High:

#Specify this parameter as a number; otherwise themonitor ends with a dump.

In the Default RFCONNECT Configuration, an event generating an alert occurs if the alert threshold of
four RFC-connect errors is exceeded for the specified target system.

The Default RFCONNECT Configuration

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1\

=WARNING =RfcConnect =R3_Transport\

=RFCCONNECT =CHECKSYSTEM =I =CP =* =\

=ALERT_THRESHOLD =I =GT =4 =

TPTEST

TPTEST is a snapshot alert type for SAPABAP_TransMonMonitoring template. Snapshot alert types
take a picture of the System at themoment themonitor runs. SAPABAP_TransMon
Monitoring template generates an alert if the number of TPTEST errors to the target system exceeds a
defined threshold.

The following table lists the parameters that you can use to configure the TPTEST alert type and shows
the value assigned to the parameters by default. Note that the parameter ALERT_THRESHOLD is
mandatory. All other parameters are optional.
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Parameter Name Description Query Conditions Default Value

ALERT_
THRESHOLD

Number of
TPTEST errors
above which an
alert occurs.

= Sign I, E I

= Opt: GT, GE, LT, LE GT

= Low: * 4

= High:

CHECKSYSTEM ID of the system
which you are
testing or
monitoring.

= Sign: I, E I

= Opt: EQ, CP EQ

= Low: <SID> ''

= High:

* Specify this parameter as a number; otherwise themonitor ends with a dump.

In the Default TPTEST Configuration, an event generating an alert occurs if the alert threshold of four
TPTEST errors is exceeded for the specified target system.

The Default TPTEST Configuration

AlertMonFun =ALL =ALL =ALL =ALL =TRANSPORT =1\

=WARNING =TpTest =R3_Transport\

=TPTEST =CHECKSYSTEM =I =EQ =<SID> =\

=ALERT_THRESHOLD =I =GT =4 =

SAPABAP_UpdProcMon

The SAPABAP_UpdProcMonMonitoring Template enables monitoring of different conditions of SAP
ABAP Update processes like inactive status and errors.

The SAPABAP_UpdProcMonMonitoring Template monitors the status of both active updates and
updates that have been stopped by a SAP user or by the System. The SAPABAP_UpdProcMon
Monitoring Template references update errors and update status in SAP NetWeaver transaction SM13.

Monitor Type

The SAPABAP_UpdProcMonMonitoring Template is of type snapshot. Onemonitor run gathers only
one value set.

Alert Types

The updatemonitor has the following alert types.
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l UPDATE_ACTIVE

Get information about the status of update processes and sends an alert if a process is not active.

l UPDATE_ERRORS_EXIST

Get information about update processes that have errors.

File Locations

The SAPABAP_UpdProcMonMonitoring Template uses the files listed in the following table:

File Description

r3moncol (.exe) Collector executable for the updatemonitor.

r3monupd.cfg Configuration file for the updatemonitor.

r3monupd.log Trace file for storing trace data.

The SAPABAP_UpdProcMonMonitoring Template do not write history information to a specific history
file.

Environment Variables

The SAPABAP_UpdProcMonMonitoring Template uses the environment variables described in
"Environment Variables".

Command-Line Parameters

The SAPABAP_UpdProcMonMonitoring Template uses the command-line parameters described in
Command Line Parameters.

Remote Monitoring

Formore information about configuring the SAPABAP_UpdProcMonMonitoring Template tomonitor
another SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

Configuring Update-Monitor Alert Types

No parameters are used to configure alert types for SAPABAP_UpdProcMonMonitoring Template.
You do not need to edit or customize the configuration.

UPDATE_ACTIVE
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UPDATE_ACTIVE is an alert type for SAPABAP_UpdProcMonMonitoring Template. SAPABAP_
UpdProcMonMonitoring Template generates an alert if the UPDATE task is inactive. The following
example illustrates the default configuration for the UPDATE_ACTIVE alert type.

In the Default UPDATE_ACTIVE Configuration, an event generating an alert occurs if any update is
stopped.

The Default UPDATE_ACTIVE Configuration

AlertMonFun =ALL =ALL =ALL =ALL =UPDATE =1\

=CRITICAL =UpdActive =R3_Update =UPDATE_ACTIVE

UPDATE_ERRORS_EXIST

UPDATE_ERRORS_EXIST is an alert type for SAPABAP_UpdProcMonMonitoring Template.
SAPABAP_UpdProcMonMonitoring Template generates an alert if any update errors exist. The
following example illustrates the default configuration for the UPDATE_ERRORS_EXIST alert type.

In the Default UPDATE_ERRORS_EXIST Configuration, an event generating an alert occurs if any
update error occurs.

The Default UPDATE_ERRORS_EXIST Configuration

AlertMonFun =ALL =ALL =ALL =ALL =UPDATE =1\

=CRITICAL =UpdError =R3_Update =UPDATE_ERRORS_EXIST

SAPABAP_UsrMon

The SAPABAP_UsrMonMonitoring Template enables monitoring of the SAP ABAP logged-in Users.
The SAPABAP_UsrMonMonitoring Template identifies and reports the number of logged-in users. The
check is performed for each application server. A very high number of users could indicate that
performance problems might occur. The alert can then be used to decide whether it is necessary to ask
or even force users to log out. The SAPABAP_UsrMonMonitoring Template references the SAP
NetWeaver transaction SM04.

Monitor Type

The SAPABAP_UsrMonMonitoring Template is of type snapshot. Onemonitor run gathers only one
value set.

Alert Types

The SAP-user monitor has only one alert type:

USER_LOGGEDIN_MAX
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Define themaximum number of logged in users.

File Locations

The SAPABAP_UsrMonMonitoring Template uses the files listed in this table.

File Description

r3moncol (.exe) Collector executable for the user monitor.

r3monusr.cfg Configuration file for the user monitor.

r3monusr.log Trace file for storing trace data.

The SAPABAP_UsrMonMonitoring Template do not write history information to a specific history file.

Environment Variables

The SAPABAP_UsrMonMonitoring Template uses the environment variables described in
"Environment Variables".

Command-Line Parameters

The SAPABAP_UsrMonMonitoring Template uses the command-line parameters described in
"Command-Line Parameters".

Remote Monitoring

Formore information about configuring the SAPABAP_UsrMonMonitoring Template tomonitor another
SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

USER_LOGGEDIN_MAX

USER_LOGGEDIN_MAX is an alert type for SAPABAP_UsrMonMonitoring Template. SAPABAP_
UsrMonMonitoring Template generates an alert if themaximum number of SAP users exceeds a
defined threshold. The following table lists the parameters that you can use to configure the USER_
LOGGEDIN_MAX alert type and shows the value assigned to the parameters by default. The
configuration of the parameter MAX is mandatory.

The APSERVER parameter allows you to set the application-server- dependent monitors, r3monwpa,
r3monusr, and r3monoms to monitor a specific application server. You need to configure APSERVER in
the followingmanner, where <hostname> is the name of the application server you aremonitoring as it
appears in the list of application servers displayed in transaction SM51:

=APSERVER =I =CP =<hostname>_<SID>_<Instance_Number> =
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Wealso recommend that you explicitly define the host name of the SAP NetWeaver central instance
whose application server(s) you want to specify with APSERVER, as illustrated in the following
example:

Specifying an Application Server

AlertMonFun =<Central_Inst_Hostname> =ALL =ALL =ALL =USER =1 \

=WARNING =Login =R3_WP \

=USER_LOGGEDIN_MAX =MAX =I =GT =30 = \

=APSERVER =I =CP =hpdev01_MP3_00 =

The remainder of this section describes the specific configuration requirements for this alert monitor.

Parameter
Name Description Query Conditions

Default
Value

APSERVER Specifies the application server to monitor = Sign: I, E

= Opt: CP

= Low :
<AppServer_ID>

= High:

MAX The number of logged in users before an alert
occurs. a

= Sign: I, E

= Opt: GT, GE I

= Low: GT

= High: 5

a. Youmust specify the parameter value as a number, otherwise themonitor ends with a dump.

In The Default USER_LOGGEDIN_MAX Configuration, an event generating an alert occurs if the
number of users logged in exceeds thirty.

The Default USER_LOGGEDIN_MAX Configuration

AlertMonFun =ALL =ALL =ALL =ALL =USER =1\

=WARNING =Login =R3_User\

=USER_LOGGEDIN_MAX =MAX =I =GT =30 =
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SAPABAP_WPMon

The SAPABAP_WPMonMonitoring Template enables monitoring of the running work processes,
waiting work process, and checking the various Status of work process like Debug/Private/No Restart.

The SAPABAP_WPMonMonitoring Template references the SAP NetWeaver transaction SM50 and
reports the following conditions for work processes running on each of the application servers:

l Reports the number of runningwork processes for each work-process type configured in the profile
of the current operationmode.

l Reports the number of waitingwork processes for each work-process type configured in the profile
of the current operationmode.

l Compares the number of activework processes with the number of configuredwork processes (of
the samework process type) in the profile of the current operationmode.

l Checks the status of the work processes, as follows:
o D (Debug)

No processes run on live systems.

o P (Private)

Processes run usingmaximum available system resources.

o R (No Restart)

Failed processes do not restart, whichmeans that dependent jobs also fail.

The SAPABAP_WPMonMonitoring Template can only monitor alerts from an enqueuework process
that is part of a central instance; it cannot monitor the alerts from an enqueuework process belonging to
a stand-alone enqueue server. Tomonitor stand-alone enqueuework processes, use the SAPABAP_
CCMSIntegrationMonMonitoring Template to check for SAP CCMS alerts generated by the enqueue
server.

Monitor Type

The SAPABAP_WPMonMonitoring Template is of type snapshot. Onemonitor run gathers only one
value set.

Alert Types

The work-process alert monitor has the following alert types.
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l WP_AVAILABLE

TheWP_AVAILABLE alert type defines alert conditions for the number of expected work processes
running.

l WP_IDLE

TheWP_IDLE alert type defines alert conditions for the number of idle work processes waiting.

l WP_CHECK_CONFIGURED

TheWP_CHECK_CONFIGURED alert type defines alert conditions for comparing the actual
number of running work processes with the number of configured work processes in the profile of
the current operationmode. Themonitor check only compares work processes of the same type.

l WP_STATUS

TheWP_STATUS alert type defines alert conditions for work processes which themonitor finds in
a problematic state, for example: D (Debug), P (Private) or R (No Restart).

File Locations

The SAPABAP_WPMonMonitoring Template has the files listed in the following table:

File Description

r3moncol (.exe) Collector executable for theWorkProcess monitor.

r3monwpa.cfg Configuration file for theWorkProcess monitor.

r3monwpa.log Trace file for storing trace data.

The SAPABAP_WPMonMonitoring Template does not write history information to a specific history
file.

Environment Variables

The SAPABAP_WPMonMonitoring Template uses the environment variables described in
"Environment Variables".

Command-Line Parameters

The SAPABAP_WPMonMonitoring Template uses the command-line parameters described in
Command Line Parameters.

Remote Monitoring

Formore information about configuring the SAPABAP_WPMonMonitoring Template tomonitor another
SAP System remotely, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".
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Configuring Work-Process Monitor Alert Types

This section helps you to configure alert types for SAPABAP_WPMonMonitoring Template. Note the
general rules below concerning the use of the exclude and include parameter values; the rules are of
particular importance for these alert types.

Parameter Values

This section describes how theOMi MP for SAP interprets include and exclude parameter values for an
alert type entry. TheOMi MP for SAP compares values in different parameters using ‘and’. TheOMi
MP for SAP compares values in the same parameter as follows.

l Include: use ‘or’ to compare the parameters

l Exclude: use ‘and’ to compare the parameters

TheOMi MP for SAP evaluates include values before exclude values, as shown in the following table:

Select
Options

Alert Type: WP_
AVAILABLE Example
Configuration of Select
Options Comparison

1 =DIA =I =BT =50 =100
=OPMODE =I =CP =DAY

OR

2 =DIA =I =GT =5 =OPMODE
=I =CP =NIGHT

OR

3 =DIA = E =LT =60 AND

WP_AVAILABLE

WP_AVAILABLE is an alert type for SAPABAP_WPMonMonitoring Template. SAPABAP_WPMon
Monitoring Template generates an alert if the number of running work processes for each, selected
work-process type is outside the specifiedmaximum (or minimum) threshold. The following table lists
the parameters that you can use to configure theWP_AVAILABLE alert type and shows the value
assigned to the parameters by default. The configuration of the parameters listed for theWP_
AVAILABLE alert type is mandatory. Youmust specify all threshold parameters as a number otherwise
themonitor ends with a dump.

The APSERVER parameter allows you to set the application-server- dependent monitors, r3monwpa,
r3monusr, and r3monoms to monitor a specific application server. You need to configure APSERVER
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in the followingmanner, where <hostname> is the name of the application server to monitor as it
appears in the list of application servers displayed in transaction SM51:

=APSERVER =I =CP =<hostname>_<SID>_<Instance_Number> =

Wealso recommend that you explicitly define the host name of the SAP NetWeaver central instance
whose application server(s) you want to specify with APSERVER, as illustrated in the Specifying an
Application Server.

Specifying an Application Server

AlertMonFun =<Centr_Instance_Hostname> =ALL =ALL =ALL =WP =1 \

=WARNING =Availability =R3_WP \

=WP_AVAILABLE =DIA =I =GT =50 = \

=APSERVER =I =CP =hpdev01_MP3_00 =

Rest of this section describes the specific configuration requirements for this alert monitor.

Parameter
Name Description Query Conditions

Default
Value

APSERVER Specifies an application
server to monitor

= Sign: I, E

= Opt: CP

= Low : <AppServer_ID>

= High:

BTC Threshold for batch
work processes

= Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

DIA Threshold for dialog
work processes

= Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:
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Parameter
Name Description Query Conditions

Default
Value

ENQ Threshold for enqueue
work processes

= Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

OPMODE Defines the operation
mode for this parameter
*

= Sign I, E I

= Opt: CP, EQ= Low: <operation_mode> EQ

= Low: <operation_mode> current

= High:

SPO Threshold for spool work
processes

= Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

UPD Threshold for update
work processes

= Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

UP2 Threshold for update2
work processes

= Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

* A critical alert occurs if you specify a non-existent mode.

In the Default WP_AVAILABLE Configuration, an event generating an alert occurs if the number of
available dialog work processes is less than fifty.

The Default WP_AVAILABLE Configuration

AlertMonFun =ALL =ALL =ALL =ALL =WP =1\

=WARNING =Availability =R3_WP\

=WP_AVAILABLE =DIA =I =LT =50 =
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Note:Check that the work-process types you want to monitor with SAPABAP_WPMon
Monitoring Template are correctly configured in the SAP instance profile.

The SAPABAP_WPMonMonitoring Template can only monitor work-process types that are configured
in the SAP instance profile. If the DIA work-process type is not configured in the SAP instance profile
(or "rdisp/wp_no_dia = 0"), then no DIA work processes are started. Since zero (0) DIA work
processes is clearly less than theminimum allowed (50) specified in the default configuration for the
WP_AVAILABLE alert type shown in The Default WP_AVAILABLE Configuration would generate an
alert under normal circumstances.

However, if the DIA work-process type is not configured in the SAP instance profile, r3monwpa cannot
monitor the number of DIA work processes that are running at any given point in time and, as a
consequence, does not generate an alert. You can check discrepancies between the SAP instance
profile and the SAPABAP_WPMonMonitoring Template configuration file with the alert typeWP_CHECK_
CONFIGURED.

WP_IDLE

WP_IDLE is an alert type for SAPABAP_WPMonMonitoring Template. SAPABAP_WPMon
Monitoring Template generates an alert if the number of waiting work processes for each, selected
work-process type is outside the specifiedmax (or min) threshold.

The following table lists the parameters that you can use to configure theWP_IDLE alert type and
shows the value assigned to the parameters by default. The configuration of the parameters for the
WP_IDLE alert type is mandatory. Youmust specify all threshold parameters as a number otherwise
themonitor ends with a dump.

The APSERVER parameter allows you to set the application-server- dependent monitors, r3monwpa,
r3monusr, and r3monoms to monitor a specific application server. You need to configure APSERVER in
the followingmanner, where <hostname> is the name of the application server to monitor as it appears
in the list of application servers displayed in transaction SM51:

=APSERVER =I =CP =<hostname>_<SID>_<Instance_Number> =

It is also recommended to define explicitly the host name of the SAP NetWeaver central instance
whose application server(s) you want to specify with APSERVER, as illustrated in the Specifying an
Application Server.

Specifying an Application Server

AlertMonFun =<Centr_Instance_Hostname> =ALL =ALL =ALL =WP =1 \

=WARNING =Idle =R3_WP \
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=WP_IDLE =BTC =I =GT =20 = \

=APSERVER =I =CP =hpdev01_MP3_00 =

The following table lists the configuration parameters forWP_IDLE:

Parameter
Name Description Query Conditions

Default
Value

APSERVER Specifies an application server to monitor = Sign: I, E

= Opt: CP

= Low : <AppServer_
ID>

= High:

BTC Threshold for batch work processes = Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

DIA Threshold for dialog work processes = Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

ENQ Threshold for enqueue work processes = Sign: I, E

= Opt: GT, GE, LT, LE

= Low:

= High:

OPMODE Defines the operationmode for this
parameter.1

= Sign I, E I

= Opt: CP, EQ EQ

= Low: <operation_
mode>

current

= High:
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Parameter
Name Description Query Conditions

Default
Value

SPO Threshold for spool work processes = Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

UPD Threshold for update work processes = Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

UP2 Threshold for update 2 work processes = Sign: I, E

= Opt: GT, GE, LT, LE

= Low: <number>

= High:

1. If a non-existent mode is specified, a critical alert occurs.

In the Default WP_IDLE Configuration, an event generating an alert occurs if the number of idle Dialog
work processes is less than ten.

The Default WP_IDLE Configuration

AlertMonFun =ALL =ALL =ALL =ALL =WP =1\

=WARNING =Idle =R3_WP\

=WP_IDLE =DIA =I =LT =10 =

Note:Check that the work-process types you want to monitor with SAPABAP_WPMon
Monitoring Template are correctly configured in the SAP instance profile.

The SAPABAP_WPMonMonitoring Template can only monitor work-process types that are configured
in the SAP instance profile. If the DIA work-process type is not configured in the SAP instance profile
(or “rdisp/wp_no_dia = 0”), then no DIA work processes are started. Since zero (0) DIA work processes
is clearly less than theminimum allowed (10) specified in the default configuration for theWP_IDLE
alert type shown in The Default WP_IDLE Configuration, this would, under normal circumstances,
generate an alert.
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However, if the DIA work-process type is not configured in the SAP instance profile, SAPABAP_
WPMonMonitoring Template cannot monitor the number of DIA work processes that are running at any
given point in time and, as a consequence, does not generate an alert. You can check discrepancies
between the SAP instance profile and the SAPABAP_WPMonMonitoring Template with the alert type
WP_CHECK_CONFIGURED.

WP_CHECK_CONFIGURED

TheWP_CHECK_CONFIGURED is an alert type for SAPABAP_WPMonMonitoring Template. The
WP_CHECK_CONFIGURED alert typemakes a comparison between the actual number of running
work processes and the number of configured work processes in the profile of the current operation
mode. Note that themonitor only compares work processes of the same type, for example: DIA, BTC.

The APSERVER parameter allows you to set theMonitoring Template SAPABAP_WPMon,
SAPABAP_UsrMon,and so on tomonitor a specific Application Server. You need to configure
APSERVER in the followingmanner, where <hostname> is the name of the application server to
monitor as it appears in the list of application servers displayed in transaction SM51:

=APSERVER =I =CP =<hostname>_<SID>_<Instance_Number> =

Wealso recommend that you explicitly define the host name of the SAP NetWeaver central instance
whose application server(s) you want to specify with APSERVER, as illustrated in the Specifying an
Application Server.

Specifying an Application Server

AlertMonFun =<Centr_Instance_Hostname> =ALL =ALL =ALL =WP =1 \

=WARNING =Check =R3_WP \

=WP_CHECK_CONFIGURED \

=APSERVER =I =CP =hpdev01_MP3_00 =

The following table lists the parameters that you can use to configure theWP_CHECK_
CONFIGURED alert type and shows the value assigned to the parameters by default:

Parameter
Name Description Query Conditions Default Value

APSERVER Specifies an
application
server to
monitor

= Sign: I, E

= Opt: CP

= Low: <AppServer_ID>

= High:
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In the Default WP_CHECK_CONFIGURED Configuration, SAPABAP_WPMonMonitoring Template
generates an alert if the number of running work processes does not match the number of configured
work processes for a given work-process type.

The Default WP_CHECK_CONFIGURED Configuration

AlertMonFun =ALL =ALL =ALL =ALL =WP =1\

=WARNING =Check =R3_WP\

=WP_CHECK_CONFIGURED \

=APSERVER =I =CP =ALL =

WP_STATUS

TheWP_STATUS is an alert type for SAPABAP_WPMonMonitoring Template. WP_STATUS defines
alert conditions for work processes which themonitor finds in a problematic state, for example: D
(Debug), P (Private), or R (No Restart). SAPABAP_WPMonMonitoring Template generates an alert if
the work processes running in the SAP Systems you aremonitoring with the OMi MP for SAP match
the conditions defined in the parameters below. The configuration of the parameter below is optional.

The APSERVER parameter allows you to set the application-server- dependent monitors, SAPABAP_
WPMon, SAPABAP_UsrMon, etc. to monitor a specific Application Server. You need to configure
APSERVER in the followingmanner, where <hostname> is the name of the application server to
monitor as it appears in the list of application servers displayed in transaction SM51:

=APSERVER =I =CP =<hostname>_<SID>_<Instance_Number> =

Wealso recommend that you explicitly define the host name of the SAP NetWeaver central instance
whose application server(s) you want to specify with APSERVER, as illustrated in the Specifying an
Application Server.

Specifying an Application Server

AlertMonFun =<Centr_Instance_Hostname> =ALL =ALL =ALL =WP =1 \

=WARNING =WP_Status =R3_WP \

=WP_STATUS =STATUS =I =GT =30 = \

=APSERVER =I =CP =hpdev01_MP3_00 =

The following table lists the parameters that you can use to configure theWP_STATUS alert type and
shows the value assigned to the parameters by default:
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Parameter
Name Description Query Conditions

Default
Value

APSERVER Specifies an application server to
monitor

= Sign: I, E

= Opt: CP

= Low: <AppServer_
ID>

= High:

STATUS 1 The status which is monitored = Sign: I, E

= Opt:

= Low: 2

= High:

1. Possible additional values: MAX_ENTRIES

2. Possible values: D=Debug, P=Private, R=Restart (no alert).

In the Default WP_STATUS Configuration, an event generating an alert occurs if the status of a
running workprocess is critical. The Default WP_STATUS Configuration also shows how you can use
=MAX_ENTRIES to define the number of work processes with a defined status that have to exist
before the OMi MP for SAP generates amessage.

The Default WP_STATUS Configuration

AlertMonFun =ALL =ALL =ALL =ALL =WP =1\

=CRITICAL =WP_Status =R3_WP\

=WP_STATUS =STATUS =I =CP =* =

TempSeqFileMon

Monitoring the TemSe file

To save runtime costs, the OMi MP for SAP monitors the consistency of SAP’s Temporary Sequential
file (TemSe), using a report you set up in SAP. However, you still need to assign the SAPABAP_
TempSeqFileMonMonitoring Template to themanaged nodes.

Monitor Type
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The TemSemonitor is of type snapshot. Onemonitor run gathers only one value set.

Report Description

The TemSe report references the SAP NetWeaver transaction SP12. Any inconsistency found in the
TEMSE database is serious, use the log in SP12 to correct the cause of the inconsistency. For
example a disk failure.

Running the TemSe Monitor

To run the TemSemonitor, you need to set up a job in SAP NetWeaver which references a report
named /HPOV/ZHPSPIT1.

Note:You can only use the report with SAP version 4.6 and later.

To set up the report:

1. Logon toSAP NetWeaver.

2. Set up a job using transaction SM36.

3. In the job, specify the following details:
a. Date on which the report should start.

b. Frequency with which the report should run.

Customizing SAP ABAP Monitoring Templates

This section provides reference information you can use for customizing ABAP Monitoring Templates
to suit your monitoring requirements.

Note:Youmust increment the Version of corresponding SAP ABAP Aspects and
SAP ABAP Management Templates after configuring or customizing
SAP ABAP Monitoring Templates. For more information on SAP ABAP Aspects and
corresponding SAP ABAP Monitoring Templates, see "SAP ABAP Monitoring Templates,
Monitoring Template Configuration Files, and History Files".

SAP ABAP Monitoring Templates, Monitoring Template

Configuration Files, and History Files

OMi MP for SAP's ABAP Monitoring Template uses SAP Monitors to monitor different functionalities of
your SAP ABAP Application Server. Some SAP monitors store data in a history file for accessing
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certain information after each run. This section provides reference information about
SAP ABAP Monitoring Templates, their corresponding SAP ABAP Aspects, and different
SAP monitors and History Files used by the SAP ABAP Monitoring Templates.

SAP ABAP Aspect SAP ABAP Monitoring Template

Monitoring
Template
Configuration
File (cfg) History File

SAP ABAP Batch Job
Health

SAPABAP_BatJobMon r3monjob

SAP CCMS Integration SAPABAP_CCMSIntegrationMon r3monal r3monal.his

SAP ABAP Correction
and Transport System
Status

SAPABAP_CTSMon r3moncts

SAP ABAP Processes
and Dispatcher Status

SAPABAP_DispMon r3mondisp

SAP ABAP Dump
Status

SAPABAP_DmpMon r3mondmp

SAP ABAP Idoc Status SAPABAP_IdocStatusMon r3monale

SAP ABAP Lock Status SAPABAP_LckChkMon r3monlck

SAP ABAP Performance
Monitor

SAPABAP_PerfMon r3perfagent

SAP ABAP Processes
and Dispatcher Status

SAPABAP_ProcMon r3monpro r3monpro.his

SAP ABAP RFC
Destination Status

SAPABAP_RFCDestMon r3monrfc

SAP ABAP Security
Status

SAPABAP_SecMon r3monsec

SAP ABAP Spool Health SAPABAP_SplMon r3monspl

SAP ABAP Performance
Monitor

SAPABAP_StatRecMon r3perfstat

SAP System Health SAPABAP_StatusMon r3status r3status.his

SAP ABAP System
ChangeOption Status

SAPABAP_SysChgOptMon r3monchg

SAP Temporary
Sequential File
Monitoring

SAPABAP_TempSeqFileMon r3monaco
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SAP ABAP Aspect SAP ABAP Monitoring Template

Monitoring
Template
Configuration
File (cfg) History File

SAP System Health SAPABAP_TraceMon r3mondev r3mondev.his

SAP ABAP Transport
Status

SAPABAP_TransMon r3montra

SAP ABAP Update
Tasks Health

SAPABAP_UpdProcMon r3monupd

SAP ABAP User Health SAPABAP_UsrMon r3monusr

SAP ABAPWork
Process Health

SAPABAP_WPMon r3monwpa

History Path

The HistoryPath[Unix | AIX |WinNT] keyword in the ABAP Monitoring Template configuration file
accepts the following parameters:

HistoryPath<Unix|Aix|WinNT> <HostName> =<Path>

l Hostname:

=ALL - Monitor all hosts with the SPI for SAP. This is the default setting.

=<SAP_host>Name of a SAP server, where you want to specify the path to themonitor history file.
Use a new line for each individual host.

l Path:

UNIX: =default

AIX: =default

Windows: =default

The =default value is associated with the default path to the history files which the OMi MP for SAP
Monitoring Templates write.

Some ABAP Monitoring Templates like SAPABAP_IdocStatusMon or SAPABAP_DmpMon do not
write history information to amonitor-specific history file. Instead, any information relating to SAP
alerts which come to the notice of the OMi MP for SAP alert-collector monitors is written directly to the
SAP database, where it can be found by the ABAP Monitoring Template collector. At the start of each
monitor run, ABAP Monitoring Template reads the relevant tables and uses the information to
determine if any events the OMi management server has already been notified about and whether to
generate further messages or not.
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For SAP ABAP Monitoring Templates that use a History File, youmust specify the history path, which
is the directory path used to locate aMonitoring Template's history file. SAP ABAP Monitoring
Template include the following default paths for UNIX, AIX, andWindows servers:

HistoryPathUnix =ALL =default

HistoryPathAIX =ALL =default

HistoryPathWinNT =ALL =default

Note:You can configure the ABAP Monitoring Templates to use a specific history path on
Windows managed nodes rather than the default: =default, for example: %OvAgentDir%\Tmp. For
more information, see the SAPOPC_HISTORYPATH environment variable and the alert-monitor
configuration-file keyword.

Each SAP ABAP Monitoring Template creates its own history file. Each time an SAP ABAP Monitoring
Templatemonitor completes a run, it adds a new section to its history file. This feature enables the
SAP ABAP Monitoring Template monitor to check for changes since the previous run.

Note:Do not edit any of themonitor history (*.his) files. Editing themonitor history file could
compromise the accuracy and consistency of your records. Themonitor uses its history file to
determine which, if any, events have occurred since the last run and whether to send any
messages.

Following in an excerpt from SAP ABAP Monitoring Template configuration:

#---------------------------------------------------------------------------

# History hostname path

# Path

#

HistoryPathUnix =ALL =default

HistoryPathAIX =ALL =default

HistoryPathWinNT =ALL =default

#------------------------------------------------------------
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Keywords and Parameters

Keyword
Keyword
Parameter/Configuration Fields Description

TraceLevel Tracelevel =<HostName> =<Trace
Level>

Hostname:
=ALL -Monitor all SAP hosts with
the SPI for SAP. This is the default
setting.

=<SAP_host> -The name of a SAP
server, where you want to specify a
trace level. Use a new line for each
individual host.

Trace level:

=0 -Disable logging. This is the
default setting for all configuration
files.

=1-Log only error messages

=2 -Log all messages

=3-Log everything including debug
messages

TraceFile Tracefile =<HostName>
=<FileName> =<TraceMode>
=<TracePeriod>

Hostname:
=ALL -Monitor all SAP servers with
the SPI for SAP. This is the default
setting.

=<SAP_host> -Name of a specific
host where tracing is enabled and
you want to specify a trace level.
Use a new line for each individual
host.

Filename:

=r3mon<alert_monitor_
name>.log, for example,
r3mondev.log, or r3mondmp.log.
This is the default setting.
Alternatively, you can specify the
name of the file to which you want
to write the trace log. By default,
monitor trace files are located in the
following directories:
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Keyword
Keyword
Parameter/Configuration Fields Description

l UNIX: /var/opt/OV/log

l AIX:

HTTPS: /var/opt/OV/log

l Microsoft Windows:

HTTPS: %OvDataDir%\log

TraceMode:

=w -default value

=a -append

TracePeriod:

Monitor verifies whether the
existing file's the time period has
elapsed the time periodmentioned
in the ABAP Monitoring Template.
If the time period has elapsed, a
new file will be created. Otherwise
new trace log entries will be
appended into the already existing
file.

RFCTimeOut RFCTimeOut
=%%RFCTimeOutInterval%%

RFCTimeOut defines themaximum
amount of time, in seconds, before
an RFC XMI/XAL function call is
canceled, for example: =120. If the
RFC call takes longer than
expected to complete, that is; to
receive a reply to the initial request,
the System is probably down or has
a serious performance problem.

EnableDPQueueCheck EnableDPQueueCheck
=<Hostname> =<SAP SID>
=<SAP Number> \
=<Enable/Disable>

Hostname:
Name of the SAP Server where the
instance is running whose ABAP
dispatcher you want the OMi MP for
SAP to check before starting:

=ALL -All the hosts which the OMi
MP for SAP monitors. This is the
default setting.

=<SAP_host> -Name of a SAP
server, where you want to enable
checking of the dispatcher-queue.
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Keyword
Keyword
Parameter/Configuration Fields Description

Use a new line for each individual
host.

SAP SID:

SAP System ID of the instance
whose ABAP dispatcher you want
the OMi MP for SAPmonitors to
check before starting:

=ALL -All System IDs which the
OMi MP for SAPmonitors. This is
the default setting.

=<SAP_SID> -SAP System ID of the
instance whose ABAP dispatcher
you want to check, for example:
“SP1”.

SAP Number:

Number of the SAP instance whose
ABAP dispatcher you want the OMi
MP for SAP monitors to check
before starting:

=ALL -All instances which the OMi
MP for SAP monitors. This is the
default setting.

=<SAP_InstNr> -Number the SAP
instance whose ABAP dispatcher
you want the OMi MP for SAP
monitors to check, for example:
“45”.

Enable/Disable:

Enable (=1) or disable (=0) - is a
particular monitor to monitor the
ABAP dispatcher for the defined
SAP instance, for example: 1. The
default is Disable (=0). You have to
enable the OMi MP for SAP
monitors individually.

RemoteMonitoring RemoteMonitoring =<LocalHost>
=<RemoteHost>

LocalHost:
Name of the host which the OMi
MP for SAP is already monitoring
and whose Agent will be used to
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Keyword
Keyword
Parameter/Configuration Fields Description

remotely monitor the SAP server
defined in Remotehost.

RemoteHost:

Name of the remoteSAP server
that you want to monitor using the
OMi MP for SAPon SAP server
defined in “Localhost”.

AlertMonFun AlertMonFun =<SAP Hostname>
=<SAP System> =<SAP Number> \
=<SAP Client>
=<AlertMonitor>
=<Enable/Disable> \ =<OpC
Severity> =<OpC Object> =<OpC
MsgGroup> \ =<Alerttype>
=<RFC Parameter>

For detailed information about
parameters/fields supported by
AlertMonFun, see
"Configuration Fields in
ABAP Monitoring Templates".

Query Conditions for Monitoring Templates

The data for eachMonitoring Template is split into a number of alert types. For example, the
JOBREPORTMonitor has four alert types: JOB_MAX_RUN-TIME, JOB_MIN_RUN_TIME, START_
PASSED and JOB_ABORTED. For each alert monitor’s defined alert types you have to:

l Specify which SAP NetWeaver systems should be checked

l Enter selection criteria which defines under what circumstances an alert will be raised. This is
described inmore detail below.

Parameter Data Types

Parameters in themonitoring-conditions section of the ABAP Monitoring Template associated with
each alert type define the conditions, which generate an alert. There are two general types of parameter
data:

l Name

Parameter name describes the attributes of the SAP NetWeaver System for which you define the
monitoring conditions. For example: MAX_RUNTIME and JOBNAME are the names of parameters
for the alert type JOB_MAX_RUN_TIME, which is associated with the JOBREPORTmonitor.

l Delimiters
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Parameter delimiters are used to specify the “select” options for each parameter. The parameter
delimiters define the circumstances under which an alert should be generated. A message will be
sent for each event that matches your specified conditions. There are four types of Parameter
Delimiters, whichmust appear in the following order: SIGN, OPT(ION), LOW, and HIGH.

Specifying Query Conditions

The following points apply generally when using parameter delimiters to specify query conditions:

o All possible and reasonable conditions can be used to configure the query condition, within the
limitations given below.

o Messages which are excluded by your defined conditions will not appear in the OMi message
browser.

The following table lists the parameter delimiters used to configure the ABAP Monitoring
Templates:

Note: The order of the parameter delimiters for the query conditions must match the order
shown in following table, such as: SIGN, OPTION, LOW, HIGH.

Parameters and Delimiters

Parameter
Delimiters Description

SIGN I: Include

E:Exclude

OPT The standard SAP operators NE (Not Equal to), NB (Not Between... and...), and NP
(does Not contain Pattern) cannot be used to configure the alert types described in
this section. You should only use the following operators:

l EQ: equal to

l BT: between... and

l CP: contains pattern

l LE: less than or equal to

l GE: greater than or equal to

l GT: greater than

l LT: less than

LOW l A comparison value such as a string when used with the operator CP.

l The lower value of a range when used in conjunction with the operator BT.

HIGH A numeric comparison value to specify the higher value of a range. This parameter
delimiter should only be used in conjunction with the operator BT.

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 235 of 308



Configuration Fields in ABAP Monitoring Templates

The following table lists different user configurable fields in SAP ABAP Monitoring Template and their
descriptions:

Fields Description

#AlertMonFun Name of the keyword used tomonitor a certain job.

=<SAP
Hostname>

Hostname of the SAP server you want to monitor

=<SAP System> ID of the SAP system you want to monitor.

=<SAP Number> Number of SAP Instance you want to monitor.

=<SAP Client> Client ID of SAP client you want to monitor.

=<AlertMonitor> Alert Type to use for monitoring.

=<Enable/Disable> Enable or Disable monitoring.

=<OpC Severity> Severity level of themessage you want to map the SAP alert to.

=<OpC Object> MP Object associated with the generatedmessage.

=<OpC
MsgGroup>

Name of themessage group theOMi message belongs to.

=<Alerttype> Name of the Alert Type.

=<RFC
Parameter>

Name of a parameter for a given Alert Type.

Environment Variables

This section describes the environment variables for all Monitoring Template. The configuration is
identical for all SAP ABAP Monitoring Templates except the name of theMonitoring Template.

Environment Variable Description

SAPOPC_ <R3MONNAME>*_CONFIGFILE Configuration-file name

SAPOPC_R3ITOSAP_CONFIGFILE General SAP NetWeaver login
configuration file

SAPOPC_TRACEPATH Trace path config. file
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*Where <R3MONNAME> is the name of themonitor whoseMonitoring Template configuration file
location you want to change. For example, SAPOPC_R3MONDMP_CONFIGFILE.

Command-Line Parameters

The command line parameters for all the SAP ABAP Monitoring Template are described in this section.
Similarly, for the environment variables, the configuration is identical for all SAP ABAP Monitoring
Template except the name of theMonitoring Template.

Parameter Description

-cfgfile Name of themonitor’s configuration file. For example, -cfgfile
<R3MONNAME>*.cfg

-trace Themonitor writes an initial trace file writetrace.log, which contains
information about the configuration file r3itosap and themonitor-specific
config file <R3MONNAME>*.cfg.

*Where <R3MONNAME> is the name of themonitor whose configuration-file location you want to
read. For example, r3mondmp.

In the following example, theMonitoring Template writes an initial trace file writetrace.log, which
contains information about the general configuration file r3itosap and themonitor-specific
configuration file r3monjob.cfg.

r3moncol -cfgfile r3monjob.cfg -trace

SAP Parameters

Parameters are variables that are an integral component of SAP Management Templates, Aspects,
and Policy Templates. Each parameter corresponds to a variable. Parameters contain default values
that are used for monitoring different components of SAP Application Server. You can alsomodify the
values of the variables to suit your monitoring requirements.

Types of Parameters

OMi MP for SAP contains the following set of parameters to monitor ABAP and J2EE application
servers:

User Guide
Chapter 3: Components

HPE OMi Management Pack for SAP (1.00) Page 237 of 308



l SAP J2EE Application Server Parameters

l SAP ABAP Application Server Parameters

l SAP ABAP Monitoring Template Parameters

SAP J2EE Application Server Parameters

OMi MP for SAP contains the following parameters for monitoring J2EE Application Server:

Parameter
Parameter
Type Description Default Values

Frequency of
VeryHigh
Scheduler

Expert Frequency for the scheduler which is expected
to run on very short interval (in minutes).

5

Frequency of
High Scheduler

Expert Frequency for the scheduler which is expected
to run on short interval (in minutes).

15

Frequency of
Medium
Scheduler

Expert Frequency for the scheduler which is expected
to run onmedium interval (in hours).

1

Frequency of Low
Scheduler

Expert Frequency for the scheduler which is expected
to run on high interval (in hours).

24

Application
Instance

Mandatory Application instance for which data needs to
be fetched.

CI Name

<J2EE aspect
name>
Frequency

Dependent Frequency tomonitor assigned J2EE
component.

VERYHIGH

<J2EE aspect
name> Severity

Dependent Severity of the event or component that is
monitored.

MAJOR

<J2EE aspect
name> Threshold

Dependent Threshold value of the event or component
that is monitored.

10000000.000000

SAP ABAP Application Server Parameters

OMi MP for SAP contains the following parameters for monitoring ABAP Application Server:

Parameter
Parameter
Type Description

Default/Sample
Values

Frequency of VeryHigh
Scheduler

Expert Frequency for the scheduler which is
expected to run on very short interval
(in minutes).

5
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Frequency of High
Scheduler

Expert Frequency for the scheduler which is
expected to run on short interval (in
minutes).

15

Frequency of Medium
Scheduler

Expert Frequency for the scheduler which is
expected to run onmedium interval (in
hours).

1

Frequency of Low
Scheduler

Expert Frequency for the scheduler which is
expected to run on high interval (in
hours).

24

ConfgurationFileName for
<monitored aspect name>

ReadOnly Configuration file for ABAP application
server monitoring.

Example:
r3monjob.cfg

FREQ for ABAP
<monitored aspect name>

Dependent Frequency for monitoring the assigned
aspect.

VERYHIGH

TraceLevel for ABAP
<monitored aspect name>

Dependent Trace level for monitoring the
assigned ABAP aspect.

0

TraceFileName for ABAP
<monitored aspect name>

Dependent Trace file namemonitoring the
assigned ABAP aspect.

Example:
r3monjob.log

TraceMode for ABAP
<monitored aspect name>

Dependent Trace file mode for monitoring the
assigned ABAP aspect.

w

TracePeriod for ABAP
<monitored aspect name>

Dependent Trace period (in mins) for monitoring
the assigned ABAP aspect.

60

RFCTimeOutInterval for
ABAP <monitored aspect
name>

Dependent RFCTimeout (in seconds) for
monitoring the assigned ABAP
aspect.

120

IsDPQCheckEnabled for
ABAP <monitored aspect
name>

Dependent DPQCheck for monitoring the
assigned ABAP aspect.

0

SAP ABAP Monitoring Template Parameters

TheOMi MP for SAP contains a set of parameters that are used for configuring ABAP Monitoring
Templates tomonitor ABAP Application Server. These parameters are user configurable and enables
you to change default values as per your monitoring requirements. TheOMi MP for SAP extends
ABAP monitoring capability by enabling you to create custom parameters required tomonitor specific
functionality or areas of your ABAP Application Server. The following table lists the user configurable
parameters provided to support ABAP Application Server monitoring:

Parameter Name Variable Name Description

ConfigurationFileName for ConfigurationFileName Name of the configuration file used by
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<Monitoring Template Name>* SAP ABAP Monitoring Template.

FREQ for <Monitoring Template
Name>

FREQ Frequency used by
SAP ABAP Monitoring Template.

TraceLevel for <Monitoring
Template Name>

TraceLevel Trace level for
SAP ABAP Monitoring Template
monitoring.

TraceFileName for <Monitoring
Template Name>

TraceFileName Trace file name for
SAP ABAP Monitoring Template
monitoring.

TraceMode for <Monitoring
Template Name>

TraceMode Trace file mode for
SAP ABAP Monitoring Template
monitoring.

TracePeriod for <Monitoring
Template Name>

TracePeriod Trace period (in minutes) for
SAP ABAP Monitoring Template
monitoring.

RFCTimeOutInterval for
<Monitoring Template Name>

RFCTimeOutInterval RFCTimeout (in seconds) for
SAP ABAP Monitoring Template.

IsDPQCheckEnabled for
<Monitoring Template Name>

IsDPQCheckEnabled DPQCheck for
SAP ABAP Monitoring Template
monitoring.

*The default naming convention of thementioned parameters include parameter name followed by the
ABAP Monitoring Template Name.

Configuring ABAP Monitoring Template Parameters

This section provides information about editing ABAP Monitoring Template Parameters.

You can edit the ABAP Monitoring Template Parameters to suit your monitoring requirements. To edit
ABAP Monitoring Template parameters, follow these steps:

1. Open the Policy Template Groups.

2. To tune the Parameters:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Policy Templates >
SAP ABAP Monitoring Template.

OnOMi 10.x, click Administration > Monitoring > Policy Templates.
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3. In thePolicy Template Groups tab on BSM 9.2x orPolicy Templates, click Templates
grouped by type onOMi 10.x.

4. Select SAP ABAP Monitoring.

5. In the Policy Templates pane, select the SAP ABAP Monitoring Template for which you want to
edit parameters.

The parameters for the selectedMonitoring Template are listed in the Details pane.

6. Double-click the Parameter you want to edit.

TheMonitoring Template editor menu opens.

7. Select thePolicy Data tab. The Policy Raw Data pane opens.

8. In the Policy Parameters pane, select the parameter you want to edit and then click . The Edit

Parameter dialog box opens. You can edit the Name, Variable Name, UI Order, Variable Type,
Default Value, and Flags.

9. Click the Item you want to edit, specify the value, and then click OK.

Creating Custom Parameters for SAP ABAP Monitoring Templates

TheOMi MP for SAP enables you to parametrize frequently changing elements or values in the
Monitoring Template Configuration String. The steps to parametrize SAPABAP_DispMon
Monitoring Template is shown here as an example:

1. Open the SAP ABAP Monitoring Template.

On BSM 9.2x, click Admin > Operations Management > Monitoring > Policy Templates >
SAP ABAP Monitoring Template.

OnOMi 10.x, click Administration > Monitoring > Policy Templates >
SAP ABAP Monitoring Template.

2. Select SAPABAP_DispMon Monitoring Template for which you want to create the custom
parameter.

3. Click and select Edit Policy Template (Raw Mode). The Policy Related Information window
opens.

4. Select Policy Data tab. The SAP ABAP Monitoring Template Configuration appears.

5. Go toDisableMonitoringWithSeverity keyword configuration string.

DisableMonitoringWithSeverity =ALL =ALL =ALL =WARNING
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6. To parametrize theWARNING configuration string value, add %% at the start and end of the
WARNING value as shown.

DisableMonitoringWithSeverity =ALL =ALL =ALL =%%WARNING%%

7. From thePolicy Parameters tab, click Synchronize parameters. The Synchronize
parameters dialog box opens.

8. Click Change to addWARNING to the list of parameters for SAPABAP_DispMon
Monitoring Template.

9. You can now define or edit the Name, Variable Name, UI Order, Variable Type, Default Value, and
Flags for theWARNING parameter.

Following is an example of defining a variable name for the Custom Parameter:

a. From the Edit Parameter dialog box of WARNING parameter, select Variable Name text
field.

b. Define a variable name forWARNING parameter.

Note: It is recommended that you provide a Variable Name that is easily recognizable by
you since the parameter will be displayed by the Variable Name during Deployment. For
example, you can provide DisableMonitoringWithSeverity_ALL_Severity as variable
name forWARNING custom parameter for ease of deployment.

c. Click OK and then click Synchronize parameters. The Synchronize parameters dialog
box opens.

d. Click Change to update the changes made to the parameter.

Note:You can also edit theWARNING custom parameter from All Parameter tab during
SAPABAP_DispMonMonitoring Template deployment.

Tuning OMi MP for SAP Parameters

You can edit the parameters of the SAP Management Templates and Aspects that are already
deployed to the SAP CIs.

1. Open the Assignments & Tuning pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Assignments &
Tuning.

OnOMi 10.x, click Administration > Monitoring > Assignments & Tuning.
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2. In theBrowse Views tab, select the RTSM View that contains the required Application Server CI
for which you want to tune parameters. Alternatively, you can use theSearch tab to find a CI.

3. In the list of SAP CIs, click aCI. The Assignments pane shows details of any existing
assignments for the CI.

4. Click the assignment for which you want to tune parameters. The Details of Assignment pane
shows the current parameter values.

5. In the Assignment Details pane, change the parameters:
a. (Optional). By default, the list shows only mandatory parameters. To see all parameters, click

.

b. Select a parameter in the list, and then click .

For standard parameters, the Edit Parameter dialog box opens.

Click Value, specify the value, and then click OK.

For instance parameters, the Edit Instance Parameter dialog box opens.

Change the instance values if necessary, and then for each instance value, change
dependent parameter values. After you change the instances and dependent parameter
values, click OK.

6. In the Assignment Details pane, click Save Changes. Operations Console deploys the 
new parameter values to the relevant HPE Operations Agent.

Run-time Service Model (RTSM) Views

RTSM View enables you to build and visualize a subset of the overall RTSMmodel.

How to Access RTSM Views

1. OpenModeling Studio pane:

On BSM 9.2x, click Admin > RTSM Administration > Modeling > Modeling Studio.

OnOMi 10.x, click Administration > RTSM Administration > Modeling > Modeling Studio.

2. Click Resource Type as Views.

3. Click Operations Management > SAP.

By default, OMi MP for SAP includes the following RTSM Views:
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l SAP_Deployment: This RTSM view shows the SAP System, SAP J2EE Application Server,
J2EE SAP Central Services, Database, SAP ABAP Application Server, SAPWork Process, and
ABAP SAP Central Services CI Types. The SAP_Deployment view enables you to visualize the
Event and Health perspectives of the SAP Application Server CIs that youmonitor. You can use
the SAP_Deployment view for visualizing events that are specific to themonitored SAP Application
Servers. You can also use the SAP_Deployment view for assigning and tuning the OMi MP for SAP
deployment in the SAP Application Server environment. The following image shows the relationship
among the CI Types:

l SAP_ABAP_Deployment: This RTSM view shows the SAP System, SAP ABAP Application
Server, ABAP SAP Central Services, SAP Work Process, and Database CI Types. The SAP_
ABAP_Deployment view enables you to visualize the Event and Health perspectives of the SAP
ABAP Application Server CIs that youmonitor. You can use the SAP_ABAP_Deployment view for
visualizing events that are specific to themonitored SAP ABAP Application Servers. You can also
use the SAP_ABAP_Deployment view for assigning and tuning the OMi MP for SAP deployment in
the SAP ABAP Application Server environment. The following image shows the relationship among
the CI Types:
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l SAP_J2EE_Deployment: This RTSM View shows the SAP System, Database,
SAP J2EE Application Server, and J2EE SAP Central Services CI Types. The SAP_J2EE_
Deployment view enables you to visualize the Event and Health perspectives of the SAP J2EE
Application Server CIs that youmonitor. You can use the SAP_J2EE_Deployment view for
visualizing events that are specific to themonitored SAP J2EE Application Servers. You can also
use the SAP_J2EE_Deployment view for assigning and tuning the OMi MP for SAP deployment in
the SAP J2EE Application Server environment. The following image shows the relationship among
the CI Types:
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l SAP_Cluster_Deployment: This RTSM View shows the SAP System, Database, SAP ABAP
Application Server, and ABAP SAP Central Services, ClusterSoftware, ClusterResourceGroup,
and Failover Cluster CI types in an SAP Cluster Configuration. You can use the SAP_Cluster_
Deployment view for visualizing events that are specific to themonitored SAP ABAP Application
Servers in cluster. The following image shows the relationship among the CI Types:

Event Type Indicators (ETIs)

ETIs are categorization of events based on the type of occurrence. TheOMi MP for SAP includes the
following ETIs tomonitor SAP-related events:

How to Access Event Type Indicators

1. Open the Indicators pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Indicators.

OnOMi 10.x, click Administration > Service Health > CI Status Calculation > Health- and
Event Type Indicators.

2. In the CI Type pane, click Configuration Item > InfrastructureElement > Application
Resource > [Select the related CI Type].
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CI
Type ETI Description Value/Severity

sap_r3_
server

TemSe File
Inconsistency

This provides the Temporary Sequential File
Inconsistency.

High/WARNING

sap_r3_
server

IDoc Status This provides the status of SAP IDocs. High/WARNING,
Normal/NORMAL

sap_r3_
server

LoggedIn
Users Max

Indicates the number of users who have logged
into the SAP system at any given point of time.

High/WARNING

sap_r3_
server

SAP User
Login Status

This provides the status of the users logged in
into the SAP System.

Highl/WARNING

sap_r3_
server

ABAP Dump
Rate

Indicates the frequency of runtime errors that
occur on the SAP system.

High/WARNING

sap_r3_
server

RFC Error
Rate

Indicates the frequency of RFC errors that occur
during the communication between the
application servers or among the various RFC
destinations.

High/WARNING

sap_r3_
server

Logon Failure This provides Logon failure status. Yes/MAJOR

sap_r3_
server

System
Change
Option Status

Indicates the SAP System Change option status. High/WARNING,
Normal/NORMAL

sap_r3_
server

SAP Process
Status

This provides the status of SAP process. Normal/NORMAL,
Low/WARNING

sap_r3_
server

ABAP
Dispatcher
Status

This provides the status of the SAP ABAP
Dispatcher.

High/WARNING,
Normal/NORMAL

sap_r3_
server

SAP
Transport
Error Rate

Indicates the transport errors on the application
server. This includes the errors due to import or
export.

Normal/NORMAL,
High/MAJOR

sap_
j2ee_
app_
server

SAP J2EE
Kernel

Generic Indicator for all the Kernel relatedmetrics
of SAP J2EE Application Server

Normal/NORMAL,
Warning/WARNING,
Major/MAJOR

sap_
j2ee_
app_
server

SAP J2EE
Services

Generic Indicator for all Service relatedmetrics of
SAP J2EE Application Server.

Normal/NORMAL,
Warning/WARNING,
Major/MAJOR

sap_ Unsuccessful Indicates the number of all the unsuccessful Normal/NORMAL,
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CI
Type ETI Description Value/Severity

j2ee_
app_
server

Logon
Attempts
Rate

logon attempts by all users from server startup. High/MAJOR

sap_
system

SAP System
Log Status

This provides the status of the SAP System Log
messages.

Highl/WARNING,
Normal/NORMAL

sap_
system

CTS
Performance

This indicates the performance of the SAP
Correction and Transport System.

High/WARNING

sap_
system

SAP
FileSystem
Utilization

This provides the information on the utilization of
the SAP File System.

High/WARNING

sap_
system

SAP System
Security
Status

This provides the status of SAP System Security
parameters.

Highl/WARNING,
Normal/NORMAL,
Low/WARNING

sap_
system

Work Load
Performance

Indicates the workload performance on the SAP
system.

Normal/NORMAL

Health Indicators (HIs)

HIs analyze the events that occur in SAP CIs and report the health of the SAP CIs. TheOMi MP for
SAP includes the following HIs tomonitor the SAP-related events:

How to Access Health Indicators (HIs)

1. Open the Indicators pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Indicators.

OnOMi 10.x, click Administration > Service Health > CI Status Calculation > Health- and
Event Type Indicators.

2. In the CI Type pane, click Configuration Item > InfrastructureElement > Application
Resource > [Select the respective CI Type].

CI Type HI Description Value/Severity

database Database
CPU Usage

Indicates the database CPU usage on the SAP
system.

Normal/NORMAL,
Highl/WARNING
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CI Type HI Description Value/Severity

sap_
work_
process

Batch
WorkProcess
Availability

Indicates the availability of the SAP background
work process.

Available/NORMAL,
Unavailable/MAJOR

sap_
work_
process

Gateway
WorkProcess
Performance

Indicates the performance of the SAP Gateway
work process.

Normal/NORMAL,
Low/MAJOR

sap_
work_
process

Spool
WorkProcess
Performance

Indicates the performance of the Spool work
process.

Normal/NORMAL,
Low/MAJOR

sap_
work_
process

Batch
WorkProcess
Performance

Indicates the performance of the SAP
background work process.

Normal/NORMAL,
Low/MAJOR

sap_
work_
process

Spool
WorkProcess
Availability

Indicates the availability of SAP Spool work
process.

Available/NORMAL,
Unavailable/MAJOR

sap_
system

SAP System
Memory
Utilization

Indicates thememory utilized on the SAP
system.

Normal/NORMAL,
High/MAJOR

sap_
system

SAP System
Status

Indicates whether the SAP system is up or
down.

Up/NORMAL,
Down/CRITICAL

sap_
j2ee_
app_
server

SAP J2EE
Application
Server Status

Indicates whether the SAP J2EE Application
Server is up or down.

Up/NORMAL,
Down/CRITICAL

sap_
work_
process

Dialog
WorkProcess
Availability

Indicates the availability of the dialog work
process on the SAP system.

Available/NORMAL,
Unavailable/MAJOR

sap_
work_
process

Update
WorkProcess
Performance

Indicates the performance of the update work
process.

Normal/NORMAL,
Low/MAJOR

sap_
work_
process

Gateway
WorkProcess
Availability

Indicates the availability of the Gateway work
process.

Available/NORMAL,
Unavailable/MAJOR

sap_
work_
process

Enqueue
WorkProcess
Performance

Indicates the performance of the SAP en queue
work process.

Normal/NORMAL,
Low/MAJOR

sap_
j2ee_

J2EE
Transaction

Indicates the ratio between committed
transactions count and total transactions count.

Normal/NORMAL,
Low/MAJOR
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CI Type HI Description Value/Severity

app_
server

Success Rate

database Database
Performance

Indicates the database performance on the SAP
system.

Normal/NORMAL,
Low/WARNING

sap_
system

SAP System
CPU
Utilization

Indicates the average utilization of CPU on the
SAP system.

Normal/NORMAL,
High/MAJOR

sap_
work_
process

Dialog
WorkProcess
Performance

Indicates the performance of SAP Dialog work
processes.

Normal/NORMAL,
Low/MAJOR

sap_
system

SAP
Transaction
Rate

Indicates the average response time and net
time of SAP transactions.

Normal/NORMAL,
Low/MAJOR

sap_
j2ee_
app_
server

Application
Thread Pool
Utilization

Indicates the ratio between the allocated task
slots and total number of task slots on the
application thread pool.

Normal/NORMAL,
High/MAJOR

sap_
work_
process

Enqueue
WorkProcess
Availability

Indicates the availability of SAP Enqueue work
process.

Available/NORMAL,
Unavailable/MAJOR

sap_
work_
process

Update
WorkProcess
Availability

Indicates the availability of update work process Available/NORMAL,
Unavailable/MAJOR

sap_
j2ee_
app_
server

JARM
Requests
Average
Response
Time

Indicates the average response time of all the
JARM requests on the J2EE application server.

Normal/NORMAL,
High/MAJOR

sap_r3_
server

SAP ABAP
Application
Server Status

Indicates whether the ABAP application server is
up or down

Up/NORMAL,
Down/CRITICAL

sap_
j2ee_
app_
server

Cache Hit
Rate

Indicates the cache hit rate on the J2EE
application server.

Normal/NORMAL,
High/MAJOR

sap_
j2ee_
app_

J2EE Memory
Usage Rate

Indicates the ratio between the usedmemory
and available memory.

Normal/NORMAL,
High/MAJOR
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CI Type HI Description Value/Severity

server

sap_
system

SAP Buffer
Hit Ratio

Indicates the ratio of percentage of database
requests that could be satisfied from the buffer,
without requiring the involvement of the
database.

Normal/NORMAL,
Low/MAJOR

sap_
j2ee_
app_
server

JARM
Requests
Average CPU
Time

Indicates the average CPU time for all the JARM
requests.

Normal/NORMAL,
High/MAJOR

sap_
j2ee_
app_
server

System
Thread Pool
Utilization

Indicates the ratio between the allocated task
slots and total number of task slots on the
system thread pool.

Normal/NORMAL,
High/MAJOR

Configuration Items and Configuration Item Types

Configuration Items (CIs) are components that have to bemanaged in order to deliver an IT Service.
CIs typically include IT Services, hardware, and software. Configuration Item Types (CITs) describes
the type of a CI and its attributes. The SAP CIs that are discovered in an environment are grouped
under the CITs.

The following table lists the CI Types that aremapped to RTSM in OMi using the OMi MP for SAP:

Package CI Type

OMi_MgmtPack_SAP SAP System

SAP ABAP Application Server

ABAP SAP Central Services

Database

J2EE SAP Central Services

SAP J2EE Application Server

SAPWork Process

Note:OMi MP for SAP Cluster Deployment View contains ClusterSoftware,
ClusterResourceGroup, and Failover Cluster CITs.
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Topology Based Event Correlation (TBEC) Rules

TheOMi MP for SAP includes the following Topology Based Event Correlation Rules (TBEC Rules) to
correlate SAP Application Server related events:

For more information on how the correlation rules work, see theOperations Manager i Concepts Guide.

How to Access Topology Based Event Correlation (TBEC) Rules

1. Open Correlation Rules pane:

On BSM 9.2x, click Admin > Operations Management > Event Correlation > Topology-
Based Event Correlation.

OnOMi 10.x, click Administration > Event Processing > Correlation > Topology-Based
Event Correlation.

2. In the Correlations pane, select the respective correlation rule.

SAP::Computer:Node Status >> SAP ABAP Application Server Status

Description: Correlates the node status to the availability of the SAP ABAP Application
Server

Symptom

CIT:
SAP ABAP Application Server

ETI:
SAPABAPApplicationServerStatus

Value: Down

Cause

CIT: Computer ETI: Node Status Value:Down

Value: Hang

Value: Suspended

SAP::Computer:Ping Availability>>SAP ABAP Application Server Status

Description: Correlates unavailability of the node to that of SAP

Symptom

CIT:
SAP ABAP Application Server

ETI:
SAPABAPApplicationServerStatus

Value: Down
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Cause

CIT: Computer ETI: Ping Availability Value: Down

Value: Unavailable

SAP::Computer:Memory Usage Level >> SAP Batch & Dialog Workprocess Performance

Description: Correlates the Computer memory usage level to the SAP Batch Workprocess
performance and Dialog Workprocess Performance

Symptom 1

CIT:SAPWork Process ETI:
BatchWorkprocessperformance

Value: Low

Symptom 2

CIT: SAPWork Process ETI:
Dialogworkprocessperformance

Value: Low

Cause

CIT: Computer ETI: Memory Usage Level Value: Much Higher than
Normal

SAP::SAP System :SAP System Memory Utilization >> Computer Memory Usage Level

Description: Correlates the SAP System's Memory utilization to the Computer Memory
Usage Level

Symptom

CIT: Computer ETI: Memory Usage Level Value: Much Higher than
Normal

Cause

CIT: SAP System ETI:
SAPSystemMemoryUtilization

Value: Much Higher than
Normal

Value: High

SAP::SAP System: SAP System CPU Utilization>>Computer CPU Load

Description: Correlates the SAP System CPU Utilization to the Computer CPU load

Cause

CIT: SAP System ETI: SAPSystemCPUUtilization Value: High
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Symptom

CIT: Computer ETI: CPU Load Value: Busy

Value: Constrained

Value: Overloaded

Value: Bottleneck

SAP::Computer:CPU Load>>SAP Batch & Dialog Workprocess Performance

Description: Correlates the Computer CPU Load to the SAP Batch Workprocess
performance and Dialog Workprocess performance

Symptom 1

CIT:SAPWork Process ETI:
BatchWorkprocessperformance

Value: Low

Symptom 2

CIT: SAPWork Process ETI:
Dialogworkprocessperformance

Value: Low

Cause

CIT: Computer ETI: CPU Load Value: Busy

Value: Constrained

Value: Overloaded

Value: Bottleneck

SAP::SAP ABAP Application Server:ABAP Dump Rate >>SAP Batch Workprocess
Availability and Performance

Description: Correlates the SAP ABAP Dump rate to the SAP Batch workprocess
performance and availability

Symptom 1

CIT:SAPWork Process ETI:
BatchWorkProcessPerformance

Value: Low

Symptom 2

CIT: SAPWork Process ETI:
Batchworkprocessavailability

Value:Not Available
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Cause

CIT: SAP ABAP Application
Server

ETI: ABAPDumpRate Value: High

SAP::Computer:Node Status >>SAP J2EE Application Server Status

Description: Correlates the Computer node status to the availability of SAP J2EE
Application Server

Symptom

CIT: SAP J2EE Application
Server

ETI:
SAPJ2EEApplicationServerStatus

Value: Down

Cause

CIT: Computer ETI: Node Status Value: Down

Value: Hang

Value: Suspended

SAP::Computer:Ping Availability >>SAP J2EE Application Server Status

Description: Correlates the Computer availability to the SAP J2EE Application Server
Status

Symptom

CIT: SAP J2EE Application
Server

ETI: SAPJ2EEApplicationServerStatus Value: Down

Cause

CIT: Computer ETI: Ping Availability Value:
Unavailability

SAP::SAP J2EE Application Server:Memory Usage Rate & Transaction Success Rate
>>Computer CPU Load

Description:Correlates the SAP J2EE Application Server Memory Usage rate and
transaction success rate to the Computer CPU Load

Cause 1

CIT: SAP J2EE Application
Server

ETI: J2EEMemoryUsageRate Value: High

Cause 2

CIT: SAP J2EE Application ETI: Value:Low
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Server J2EETransactionSuccessRate

Symptom

CIT: Computer ETI: CPULOAD Value: Overloaded

SAP::Computer:CPU Load>>SAP JARM Requests Average Response Time

Description: Correlates the computer CPU Load to the SAP JARM Requests Average
Response time

Symptom

CIT: SAP J2EE Application
Server

ETI: JARMRequestsAverageResponseTime Value:
High

Cause

CIT: Computer ETI: CPULOAD Value:
Overloaded

SAP::Computer:Memory Usage Level >>SAP J2EE Application Server Status & Transaction
Success Rate & Average Requests Response Time

Description: Correlates the Computer Memory Usage level to SAP J2EE Application Server
Status, SAP J2EE Transaction Success Rate and SAP JARM Average Requests Response
Time

Symptom 1

CIT: SAP J2EE Application
Server

ETI: J2EETransactionSuccessRate Value: Low

Symptom 2

CIT: SAP J2EE Application
Server

ETI: SAPJ2EEApplicationServerStatus Value:Down

Symptom 3

CIT: SAP J2EE Application
Server

ETI:
JARMRequestsAverageResponseTime

Value: High

Cause

CIT: Computer ETI: Memory Usage Level Value: Much Higher than
Normal

SAP::SAP J2EE Application Server:J2EE Memory Usage Rate >>SAP J2EE Application
Server Average Requests Response Time & Average Requests CPU Time
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Description: Correlates the SAP J2EE Memory Usage Rate to SAP JARM Average Requests
Response Time and SAP JARM Average Requests CPU time

Symptom 1

CIT: SAP J2EE Application
Server

ETI:
JARMRequestsAverageResponseTime

Value: High

Symptom 2

CIT: SAP J2EE Application
Server

ETI: JARMRequestsAverageCPUTime Value:High

Cause

CIT: SAP J2EE Application
Server

ETI: J2EEMemoryUsageRate Value: High

Tools

TheOMi MP for SAP is packaged with tools which you can use to administer andmonitor SAP CIs.

Note:OMi MP for SAP Tools does not work for remotely monitored SAP Application Server CIs.

Prerequisites

OMi MP for SAP ABAP tools launching SAP GUI for different transactions use theWEBGUI port. You
must enable theWEB-GUI for SAP for OMi MP for SAP ABAP tools to work with SAP systems in your
environment. To configure theWEB-GUI for SAP, follow these steps:

1. Go to transaction SICF and activate the following services:

a. /default_host/sap/bc/gui/sap/its/webgui

b. /default_host/sap/public/bc/ur
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c. /default_host/sap/public/bc/its/mimes

2. Publish all the services using the following transaction:

SIAC_PUBLISH_ALL_INTERNAL

3. Go to transaction SMICM

4. From theMenu, open theParameters Displaymenu:

GOTO > Parameters > Display

5. Note the icm/server_port_0 field Port Number. This is theWEBGUI port number used by OMi
MP for SAP Tools while launchingWEBGUI based Transactions.
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Formore information about SAP Transactions and ActivatingWEBGUI port, seeSAP Documentation.

The following table lists the tools provided with OMi MP for SAP:

CI Type Tool Name Description

SAP ABAP Application
Server

SAP ABAP
Application
Server - Stop
Performance
Agent

Stops the performance agent.

SAP ABAP
Application
Server -
Workload
Monitor

Displays the SAP transaction ST03 on the
SAPGUI.

SAP ABAP
Application
Server -
Background
JobOverview

Displays the SAP transaction SM37 on the
SAPGUI.

SAP ABAP
Application
Server -
SAPGUI for
HTML

Launches the SAPGUI for HTML.

SAP ABAP
Application

Displays the SAP transaction SM50 on the
SAPGUI.
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CI Type Tool Name Description

Server -
WorkProcess
Overview

SAP ABAP
Application
Server -
Instances
Information

Provides information about the running SAP
Application Server instances.

SAP ABAP
Application
Server -
Install
Performance
Package

Installs the performance package.

SAP ABAP
Application
Server -
Remove
Performance
Package

Removes the performance package.

SAP ABAP
Application
Server -
Background
Job Definition

Displays the SAP transaction SM36 on the
SAPGUI.

SAP ABAP
Application
Server - Start
Performance
Agent

Starts the performance agent.

SAP ABAP
Application
Server -
System Log
Overview

Displays the SAP transaction SM21 on the
SAPGUI.

SAP ABAP
Application
Server -
LoggedIn
Users
Overview

Displays the SAP transaction AL08 on the
SAPGUI.
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CI Type Tool Name Description

SAP ABAP
Application
Server -
Configured
Instance
Status (Only
Unix Nodes)

Displays the status of Configured SAP instances
for Unix Nodes only.

SAP ABAP
Application
Server -
Gateway
Connections

Displays the SAP transaction SMGW on the
SAPGUI.

SAP ABAP
Application
Server -
Database
Performance

Displays the SAP transaction DB02 on the
SAPGUI.

SAP ABAP
Application
Server -
Background
Job Status

Displays the SAP transaction SMX on the SAPGUI.

SAP ABAP
Application
Server - SAP
Server
Overview

Displays the SAP transaction SM51 on the
SAPGUI.

SAP ABAP
Application
Server -
CCMS
Control Panel

Displays the SAP transaction RZ03 on the SAPGUI

SAP ABAP
Application
Server -
Performance
Agent Status
(Only Unix
Nodes)

Provides the status of performance agent.

SAP ABAP
Application
Server - SAP

Checks the availability of SAP Database for Unix
Nodes only.
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CI Type Tool Name Description

Database
Availability
(Only Unix
Nodes)

SAP ABAP
Application
Server -
Profile
Maintenance

Displays the SAP transaction RZ10 on the
SAPGUI.

SAP J2EE Application Server SAP J2EE
Application
Server -
Remove
Performance
Package

Removes the performance package.

SAP J2EE
Application
Server -
Connection
Status

Checks and displays the SAP J2EE Application
Server Connection status.

SAP J2EE
Application
Server -
Performance
Agent Status
(Only Unix
Nodes)

Provides the status of performance agent on only
UNIX nodes.

SAP J2EE
Application
Server - Stop
Performance
Agent

Stops the performance agent.

SAP J2EE
Application
Server -
Configuration
Creation

Creates the configuration for the SAP J2EE
application server monitoring at the node level.

SAP J2EE
Application
Server -
Install
Performance

Installs the performance package.
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CI Type Tool Name Description

Package

SAP J2EE
Application
Server - Start
Performance
Agent

Starts the performance agent.
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Chapter 4: Creating SAP Management
Templates
1. Open theManagement Templates & Aspects pane:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

Configuration Folders > ERP Management > SAP NetWeaver Application Server

3. Select the SAP NetWeaver Application Server folder and if you need to create a new configuration

folder, click . The Create Configuration Folder dialog box opens.

4. Type the name of the new configuration folder and a description. For example, you can type the
new configuration folder name as <Test>.

5. Click OK. The new configuration folder is created.

Configuration Folders > ERP Management > SAP NetWeaver Application Server > Test

6. In theManagement Templates & Aspects pane, select the configuration folder and click

Create Management Template. The CreateManagement Template wizard opens.

7. In theGeneral tab, type aName for the new SAP Management Template. Click Next.

8. An SAP Management Template enables you tomanage ABAP and J2EE application servers and
all the related dependent CIs. Select SAP ABAP Application Server orSAP
J2EE Application Server from the list as the Topology View depending on your monitoring
requirement.

9. Click an item in the topology map to select theCI Type of the CIs that this Management Template
enables you tomanage. This is the type of CI to which theManagement Template can be
assigned. For example, you can select SAP J2EE Application Server to monitor SAP J2EE
Application server in your SAP Landscape.

Click Next.

10. In theAspects tab, add the Aspects to theManagement Template. To add an existing Aspect,
follow these steps:
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a. Select the Aspect you want to add from the Available Aspects matching the CI Types pane.
You can useCTRL orSHIFT key to select multiple Aspects.

b. Click to move the Aspect to the Selected Aspects pane. The Aspect is added to the

Management Template.

11. Youmust add the SAP ABAP Base Aspect or the SAP J2EE Base Aspect to the new
Management Template. The SAP ABAP Base Aspect and the SAP J2EE Base Aspect contains
the config file, scheduled task and log file policy templates, which are essential for data collection.

12. For each Aspect that you add, youmust specify at least one Target CI.

Click an Aspect in the list, and then in the topology map click the CIT you want the Aspect to
monitor when this Management Template is assigned. Use theCTRL orSHIFT key to select
several CITs. Each CIT that you select heremust correspond to one of the CI types assigned
within the Aspect itself (or a child of one of those CITs). For example, you can select SAP CI from
the topology map.

13. In theParameters tab, you see a list of all the parameters from the Aspects that you added to this
Management Template.

To combine parameters:

a. Press CTRL and click the parameters that you want to combine.

b. Click the . The Edit/Combine Parameters dialog box opens.

c. Type aName for the combined parameters.

d. (Optional). Specify aDescription, Default Value, and whether the combined parameter is
Read Only, anExpert Setting, orHidden.

You can specify either a specific default value, or you can click From CI Attribute and then
browse for a CI attribute. When you specify a CI attribute, Operations Management sets the
parameter value automatically during the deployment of the underlying policy templates, using
the actual value of this attribute from the CI. You can also change values of conditional
parameters. (The conditions are read-only and cannot be changed at Management Template
level.)

ReadOnly prevents changes to the parameter value when theManagement Template is
assigned to a configuration item. Hidden also prevents changes, but additionally makes the
parameter invisible when theManagement Template is assigned, and during parameter
tuning. Users can choose whether to show expert settings when they make an assignment.

e. Click OK.
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You can also edit the parameters without combining them, to override the defaults in the

Aspects or policy templates. Click one parameter, and then click . The Edit/Combine

Parameters dialog box opens.

14. In the CreateManagement Template wizard, click Finish to save theManagement Template and
close the wizard. The new Management Template appears in theManagement Templates &
Aspects pane.

Editing SAP Management Templates

You can edit the SAP Management Templates andmodify the following components:

l Parameters

l Aspects

Editing Parameters

Use Case:You are using Essential SAP ABAP Management Template tomonitor the status and
performance of batch jobs running on the SAP system. You aremonitoring the SAP ABAP Batch Job
and want to modify the corresponding parameters corresponding to closely monitor the
SAP ABAP Batch Job health.

To closely monitor the SAP ABAP Batch Job health, youmust modify the parameters
SAP ABAP Batch Jobmonitor parameters - FREQ for ABAP Batch Jobs, TraceLevel for ABAP Batch
Jobs, TraceFileName for ABAP Batch Jobs, TraceMode for ABAP Batch Jobs, TracePeriod for
ABAP Batch Jobs, RFCTimeOutInterval for ABAP Batch Jobs.

1. OpenManagement Templates & Aspects:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

Configuration Folders > ERP Management > SAP NetWeaver Application Server >
SAP ABAP Application Server Management Template
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3. Select theEssential SAP ABAP Management Template from the list, and then click . The

Edit Management Template dialog box opens.

4. Click theParameters tab. The list of parameters appear.

5. Double-click the ABAP Batch Jobs parameters.

In this instance, FREQ for ABAP Batch Jobs, TraceLevel for ABAP Batch Jobs, TraceFileName
for ABAP Batch Jobs, TraceMode for ABAP Batch Jobs, TracePeriod for ABAP Batch Jobs, and
RFCTimeOutInterval for ABAP Batch Jobs.

The Edit Parameter dialog box appears.

6. You can change the default value by using the drop down text. For example, you can change the
value of the parameter FREQ for ABAP Batch Jobs to HIGH from VERYHIGH depending on your
monitoring requirements.

7. Click OK. The Edit Management Template dialog box opens.

8. Click OK. The version of the SAP Management Template is incremented.

Note: The version number of the SAP Management Template is incremented when any
customizations aremade to the SAP Management Template.

Editing Aspects

Use Case:You are using Extensive SAP J2EE Management Template tomonitor your J2EE
environment. You do not want to use some Aspects which are part of the Extensive SAP J2EE
Management Template.

1. OpenManagement Templates & Aspects:

On BSM 9.2x, click Admin > Operations Management > Monitoring > Management
Templates & Aspects.

OnOMi 10.x, click Administration > Monitoring > Management Templates & Aspects.

2. In the Configuration Folders pane:

Configuration Folders > ERP Management > SAP NetWeaver Application Server >
SAP J2EE Application Server Management Template

3. Select theExtensive SAP J2EE Management Template from the list, and then click Edit.
The Edit Management Template dialog box opens.
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4. Click theAspects tab. The list of Aspects appear.

5. Select the Aspect that you want to delete from the list. For example, you want to delete the SAP
J2EE Connections Manipulator Performance.

6. Click to delete the selected Aspect.

7. Click OK. The version of the Extensive SAP J2EE Management Template is incremented.
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Chapter 5: Deployment Scenarios
You can useOMi MP for SAP tomonitor different SAP Application Server configurations like
SAP system with standalone ABAP Application Servers, J2EE Application Server Instances with
Central Server on same system, SAP ABAP Application Servers on remote nodes etc. This section
provides information about deploying OMi MP for SAP on different SAP Server configurations.

Monitoring SAP J2EE Application Servers on Single Host

OMi MP for SAP enables you tomonitor multiple SAP J2EE Application Servers running on a single
SAP Host system. To deploy OMi MP for SAPon SAP J2EE Application Servers running on a single
host, follow these steps:

1. Youmust add the nodes you want to monitor to the OMi console.

2. Deploy the SAP J2EE Discovery Aspect to discover J2EE Application Server CIs on the SAP
managed nodes.

3. Identify and deploy the SAP J2EE Management Template as per your monitoring requirement. For
more information about Identifying and Deploying SAP Management Templates, see Task 6:
Identifying and Deploying an SAP Management Template.

The following figure shows a typical deployment scenario where the OMi MP for SAP is deployed to
monitor SAP J2EE Application Servers on Single Host:
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Monitoring SAP J2EE Application Servers on Multiple Hosts

OMi MP for SAP enables you tomonitor J2EE Application Servers running onmultiple SAP Host
systems. To deploy OMi MP for SAP on SAP J2EE Application Servers running onmultiple hosts,
follow these steps:

Note:OMi MP for SAP only requires Agent to be installed on SAP node where SAP J2EE Central
Server Instance is running.

1. Youmust add the nodes you want to monitor to the OMi 10.x console.

2. Deploy the SAP J2EE Discovery Aspect to discover J2EE Application Server CIs on the SAP
nodes.

3. Identify and deploy the SAP J2EE Management Template as per your monitoring requirement. For
more information about Identifying and Deploying SAP Management Templates, see Task 6:
Identifying and Deploying an SAP Management Template.
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The following figure shows a typical deployment scenario where the OMi MP for SAP is deployed to
monitor SAP J2EE Application Servers running onMultiple Hosts:

Monitoring Standalone SAP ABAP Application Servers

OMi MP enables you tomonitor Standalone SAP ABAP Application Servers in your SAP Landscape.
To deploy OMi MP for SAP on SAP ABAP Application Servers, follow these steps:

1. Youmust add the nodes you want to monitor to the OMi console.

2. Deploy the SAP ABAP Discovery Aspect to discover ABAP Application Server CIs in your
SAP environment.

3. Deploy SAP ABAP Configuration Aspect.

4. Identify and deploy the SAP ABAP Management Template as per your monitoring requirement.
For more information about Identifying and Deploying SAP Management Templates, see Task 6:
Identifying and Deploying an SAP Management Template.

5. Configure SAP ABAP Monitoring Templates.
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The following figure shows a typical deployment scenario where the OMi MP for SAP is deployed to
monitor SAP ABAP Application Servers running on SAP CIs:

Monitoring Remote SAP ABAP Application Servers

OMi MP for SAP enables you tomonitor ABAP Application Servers running on remote nodes which
does not haveOperations Agent installed. For using this functionality youmust deploy
SAP ABAP Remote Configuration Aspect. The SAP ABAP Remote Configuration Aspect enables you
to configure the Proxy Node (with Agent) you want to use as host for monitoring and collecting required
information from ABAP Application Server running on the remote node.

Note:You can configure an SAP CI managed by OMi tomonitor any number of
SAP ABAP Application Server running on remote nodes.

To deploy OMi MP for SAP tomonitor ABAP Application Servers running on remote nodes, follow
these steps:

1. Add the Node with Agent installed to the OMi console.

2. Deploy the SAP Remote Configuration Aspect to populate remote ABAP Application Server CIs in
your SAP environment.
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The ABAP Application Servers on Remote nodes gets populated in RTSM View.

3. Configure ABAP Monitoring Templates to support RemoteMonitoring by adding RemoteHost
keyword.

For more information on configuring ABAP Monitoring Template to support ABAP Remote
Monitoring, see "RemoteMonitoring with SAP ABAP Monitoring Templates ".

4. Identify and deploy the SAP ABAP Management Template as per your monitoring requirement.
For more information about Identifying and Deploying SAP Management Templates, see Task 6:
Identifying and Deploying an SAP Management Template.

The following figure shows a typical deployment scenario where the OMi MP for SAP is deployed to
monitor SAP ABAP Application Servers running on remote nodes:
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Configuring OMi MP for SAP in High-Availability Cluster

OMi MP for SAP enables you tomonitor SAP Application Servers configured in High-Availability
cluster. The information in this section helps you to understand the process of configuring OMi MP for
SAP on SAP servers running in a high-availability environment such as anMC/ServiceGuard cluster.
Although the information provided in this section uses MC/ServiceGuard to explain cluster
configurations, the basic concepts for monitoring are same for high-availability environment.

Pre-requisites

The information in this section is designed to help you configure OMi MP for SAP in a high-availability 
environment: it is not intended to explain either how to set up the high-availability software or  
Operations Manager i. Before you start the process of configuring OMi MP for SAP in a high-availability 
environment, it is recommended to read through and consider the information included in the following 
sections:

l "Configuration Requirements "

l "Reports"

l "Views"

Configuration Requirements

Youmust complete the following tasks before starting to configure OMi MP for SAP with SAP High -
Availability cluster:

l High-availability softwaremust already be correctly installed and configured in your SAP
landscape, and the cluster should function correctly. For example, SAP servers in the
MC/ServiceGuard cluster must already be configured as OMi managed nodes with the appropriate
Operations Agent software and functionality installed and running. You have to decide whether to
configure one package for the central instance and the database server or set up separate packages
for each part.

l Set the SAPOPC_HOSTNAMES variable on themanaged node.

a. On themanaged node, run the following in the command prompt:

ovconfchg –edit

b. Enter the SAPOPC_HOSTNAMES variable as following:

[ctrl.env]

SAPOPC_HOSTNAMES=<hostnames of the Cluster environment>

Example :

[ctrl.env]
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SAPOPC_HOSTNAMES=sov02om139 sov02om140

c. Restart Operaions Agent using the following command:

ovc-restart

l Deploy the SAP ABAP Discovery Aspect on all Nodes in the cluster.

l Youmust configure and deploy SAP ABAP Configuration Aspect. The SAP ABAP Configuration
Aspect enables you to configure SAP ABAP Application Server CIs discovered from HA
environment.

Note: The HostName entry in SAP ABAP Application Server Message Node for HA defines
the name of the host with which you want to associate messages generated by nodes in the
SAP high-availability cluster.

Reports

If you want to generate OMi MP for SAP reports for all the nodes in theMC/ServiceGuard cluster, make
sure that:

l OMi MP for SAP's R3 Performance Agent Service is started on all nodes in the cluster

l Operations Bridge Reporter (OBR) is installed and correctly configured.

Views

OMi MP for SAP provides SAP_Cluster_Deployment view which enables you to you to build and
visualize a subset of the overall RTSMmodel. For more information about OMi MP for SAP Views, see
"Run-time ServiceModel (RTSM) Views".

Note:Youmust deploy the SAP ABAP Discovery and SAP ABAP Configuration Aspect on all
cluster nodes for the OMi MP for SAP to generate SAP_Cluster_Deployment view.

Configuring OMi MP for SAP in a High-Availability Environment

This section provides information about configuring the OMi MP for SAP in a High-Availability
Environment.

To configure OMi MP for SAP in SAP High-Availability Cluster Environment, follow these steps:

1. SAP ABAP Configuration Aspect and Login Credentials

Youmust deploy theSAP ABAP Discovery Aspect to identify SAP Cluster nodes in high-
availability environment. Youmust then deploy SAP ABAP Configuration Aspect on all the
discovered SAP CIs in High-Availability Cluster.
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Make sure that the SAP Log-in Credentials provided in the SAP ABAP Configuration Aspect is
having sufficient permissions to access the nodes in the SAP cluster.

2. Configure theOMi MP for SAP ABAP Monitoring Templates

Youmust configure the SAP ABAP Monitoring Templates provided with OMi MP for SAPdeploy
their respective Aspects to monitor SAP ABAP Application Server as per your monitoring
requirements. For more information on configuring SAP ABAP Monitoring Templates, see
"SAP ABAP Monitoring Templates".

Note:Youmust increment the version of SAP ABAP Management Templates after
configuring or customizing SAP ABAP Monitoring Templates tomake sure the changes in
Monitoring Template Configuration are synced at Management Template Level. For more
information on SAP ABAP Aspects and corresponding SAP ABAP Monitoring Templates,
see SAP ABAP Monitoring Templates, Monitors, and History Files.

3. DeployOMi MP for SAP Management Templates

Youmust deploy OMi MP for SAP's Management Templates on SAP SIDs in the cluster as per
your monitoring requirements. For more information on deployingManagement Templates and
Aspects, seeGetting Started.

4. Availability of OMi MP for SAP Monitoring Template History Files

Youmust make sure that each node in theMC/ServiceGuard cluster, can access respective
history file (r3<monitor_name>.his) before and after a fail-over package switch. For more
information on setting history path and history files used by SAP ABAP Monitoring Templates, see
"SAP ABAP Monitoring Templates, Monitoring Template Configuration Files, and History Files".

Advanced Configuration

This section provides additional information about configuring OMi MP for SAP in SAP High-Availability
Environment.

Host Mapping on Cluster Nodes

If the Agent discovers that multiple IP addresses are assigned to a single physical node in the high-
availability cluster, themessages the agent sends show the host name associated with the IP address
that is registered on theOMi management server for the cluster node, this is the name of the node
where the cluster package is running at the time themessage is sent.

Although this behavior is a feature of the OMi HTTPS agent in cluster environments, it overrides the
OMi MP for SAP’s host-mapping functionality, which can lead to a situation where the wrong name
appears to be associated with messages displayed in themessage browser. To ensure that the host-
mapping feature works as intended and the correct hostname is displayed in OMi MP for SAP
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messages coming from the high-availability cluster, youmust disable the OMi HTTPS agent feature on
themanaged node, as follows:

1. Log on as a user with administrative privileges to each physical node in the high-availability cluster
where anOMi HTTPS agent is running and open a command shell.

2. On HTTPS agents managed by OMi for Unix:

ovconfchg -ns eaagt -set OPC_SET_PROXY_FLAG_FOR_IP_ADDRESSES

'<IP_Address,IP_Address,...>'

Use the ovconfchg command on each physical node in the high-availability cluster to specify the
IP address of the package (the virtual node) that you want to replace the cluster-node name as
registered on theOMi management server, when amessage from one of the cluster nodes
appears in themessage browser. If multiple packages are running in the cluster (for example, for
OMi and for Oracle), use commas "," to separatemultiple IP addresses in the list.

Note:Spaces are not allowed in the list of IP addresses defined by OPC_SET_PROXY_
FLAG_FOR_IP_ADDRESSES. Never include the IP address specified in OPC_IP_
ADDRESS in the list of IP addresses.

3. Restart the agent with the new configuration using the following command:

opcagt -kill; opcagt -start

SAP ABAP Monitoring Template History Files in a High-availability Cluster

The SAPABAP_CCMSIntegrationMon, SAPABAP_TraceMon, SAPABAP_ProcMon, and SAPABAP_
StatRecMon SAP ABAP Monitoring Template have their own history files with the extension .his, for
example, r3monal.his. Each time one of theseOMi MP for SAP SAP ABAP Monitoring Template
starts, it relies on the contents of its history file r3<monitor_name>.his to determine the last events
monitored and, as a result, the point at which the current monitor run should start. This mechanism is
designed to avoid the problem of duplicate messages.

Note that SAPABAP_CCMSIntegrationMonMonitoring Template writes new information to its history
file only if the SAP System it is monitoring is available and theOMi MP for SAP monitors can connect.
If the SAP System beingmonitored is not available, SAPABAP_CCMSIntegrationMon
Monitoring Template only updates the time stamp to reflect the time of the latest monitor run. The
monitoring templates SAPABAP_TraceMon, SAPABAP_ProcMon, and SAPABAP_StatRecMon SAP
ABAP Monitoring Template, on the other hand, write to their respective history file after eachmonitor
run whether the SAP System they aremonitoring is available or not.

History File r3monal.his for the SAPABAP_CCMSIntegrationMon Monitoring Template

#-----------------------------------------------------------
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# Keyword SAP SAP SAP Last Scan

# System Number Instance Time

LastScannedSystem =SP6 =33 =DVEBMGS33 =1073908785

----------------------------------------------------------------

The history files for the OMi MP for SAP SAP ABAP Monitoring Template are usually stored on the
managed node where themonitors are running in a directory specified in eachmonitor’s configuration
file, r3<monitor_name>.cfg. By default, this directory is /var/opt/OV/conf/sapspi for all UNIX
managed nodes except AIX, which uses the directory /var/lpp/OV/conf/sapspi, and
%OVAGENTDIR%/conf/sapspifor Microsoft Windows managed nodes. However, if the cluster package
switches to another node, then the OMi MP for SAPABAP Monitoring Template can no longer access
themost recent history files stored on the failed cluster node. This may lead to the generation of
duplicate messages that have already been sent to OMi. For SAPABAP_CCMSIntegrationMon, the
duplicate messages can be avoided by enabling CCMSAcknowledgeMessage, see SAPABAP_
CCMSIntegrationMon.

Note: TheOMi MP for SAPcollector monitors keep their history information in the SAP tables. As
a result, they do not have a .his history file. The SAPABAP_TraceMonmonitor reads the SAP
trace and log files, and keeps the line number for each file in r3mondev.his. Therefore, in principle,
SAPABAP_TraceMon is prone to sending duplicate messages if the package is switched to the
other node. If r3mondev.his is stored on the local disks and SAPABAP_TraceMon on the new node,
the OMi MP for SAP starts scanning from a point that was scanned on the previous node already.

However, after starting an SAP instance, new dev_* files will be created. Most of the dev_* files will be
copied to dev_*.old files before creating new files. Therefore, r3mondev never monitors the dev_
*.old files.

SAPABAP_TraceMon detects (through the Inode column in r3mondev.his) if a file is created as new,
and then starts scanning the new file from the beginning. Therefore, you can use the default
configuration for SAPABAP_TraceMonand it is not necessary to place r3mondev.his on a shared disk.
For more information on SAP monitor to SAP ABAP Monitoring Template Mapping, see "OMi MP for
SAP ABAP Monitoring Template Configuration Files".

Special Considerations for the SAP ABAP Monitoring Templates

This section contains information which is intended to help you set up the OMi MP for SAP alert
monitors in a high-availability environment. To set up the OMi MP for SAP
SAP ABAP Monitoring Templates in a high-availability environment, follow these steps:

1. Enable (=1) theSAPABAP_CCMSIntegrationMonMonitoring Template’s auto-acknowledgment
feature for CCMS alerts in SAP to avoid duplicate messages appearing in the OMi message

User Guide
Chapter 5: Deployment Scenarios

HPE OMi Management Pack for SAP (1.00) Page 278 of 308



browser.

2. Define a CCMS monitor set. For example, "OMi", and a CCMS monitor: for example, "SAPMP
Monitoring", for themessages you want to forward from CCMS to the OMi message browser.
Note that themonitor-set feature can be only used with the XAL interface.

Special-Case Scenarios

For reasons of efficiency or cost, the secondary (or backup) node in a high-availability cluster might
already be in use as an application server. If this in the case in your environment and regular high loads
mean that you need the central instance tomaintain the same performance level after the fail-over
package switch as before, you have the option of shutting down the application server on the
secondary node after the fail-over so that themachine’s performance is available solely to the central
instance. You can then share the user load between any other available application servers.

If performance is not an issue in your environment, you can choose to keep the application server
instance running on the secondary node even after the fail-over package switch. However, if an
instance of an SAP application server is running on the samemachine as an SAP central instance, you
will need to ensure that the OMi MP for SAP SAP ABAP Monitoring Template monitors aremade aware
of this fact and do not generatemessages for both the central instance and the application server. The
OMi MP for SAP SAP ABAP Monitoring Template monitors which are only designed to work with the
central instance should be set up to excludemonitoring of the application-server instance. TheOMi MP
for SAP collector monitor and SAPABAP_ProcMon, for example, require special attention.

EachOMi MP for SAP SAP ABAP Monitoring Template monitor has a configuration file that you use to
define which SAP NetWeaver instances in your SAP landscape it should watch and, in addition, what
information it should collect. For example, you can use the SAPABAP_ProcMonMonitoring Template
configuration to collect information about either the central-instance processes or the processes tied to
the application-server instance.

Note: The SAP instance number associated with the application server already running on the
secondary node cannot be the same as the SAP instance number associated with the SAP central
instance, which starts on the secondary node after the fail-over package switch.

OMi MP for SAP ABAP Monitoring Template Configuration Files

SAP ABAP Monitoring Template

Monitoring
Template
Configuration
File (cfg)

Central
Instance

Application
Server

SAPABAP_TempSeqFileMon r3monaco ✓

SAPABAP_IdocStatusMon r3monale ✓
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SAPABAP_CCMSIntegrationMon r3monal a ✓

SAPABAP_SysChgOptMon r3monchg ✓

SAPABAP_CTSMon r3moncts ✓

SAPABAP_TraceMon r3mondev ✓ ✓

SAPABAP_DispMon r3mondisp ✓ ✓

SAPABAP_DmpMon r3mondmp ✓

SAPABAP_BatJobMon r3monjob ✓

SAPABAP_StatRecMon r3perfstat ✓ ✓

SAPABAP_PerfMon r3perfagent ✓ ✓

SAPABAP_LckChkMon r3monlck ✓

SAPABAP_ProcMon r3monpro ✓ ✓

SAPABAP_RFCDestMon r3monrfc ✓

SAPABAP_SplMon r3monspl ✓

SAPABAP_SecMon r3monsec ✓

SAPABAP_StatusMon r3status ✓ ✓

SAPABAP_TransMon r3montra ✓

SAPABAP_UpdProcMon r3monupd ✓

SAPABAP_UsrMon r3monusr ✓

SAPABAP_WPMon r3monwpa ✓

a. CCMS 4.x only

The OMi MP for SAPCollector in a High-Availability Cluster

TheOMi MP for SAPcollector collects alerts from all the OMi MP for SAPABAP Monitoring Templates
such as, for example, SAP ABAP Idoc Status Monitoring Template, SAP ABAP DumpStatus
Monitoring Template, etc. The alert monitors themselves ensure that alert collectors are executed
according to a defined schedule and report any messages that come back from the called function.

Note: TheOMi MP for SAP collector monitor is only intended to run on an SAP central instance: it
is not designed to run on an application server.

If the secondary node in a high-availability cluster is running an application server, care has to be taken
to ensure that themonitors that are started when the central instance comes up on the secondary node
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after the fail-over switch do not become confused about which SAP instance tomonitor—application
server or central instance.

To avoid problems when the central instance and the application server are running on the same cluster
node at the same time, for example, after a system fail over, you need to ensure that each of the
monitors which the collector monitor starts when the central instance comes up on the secondary node
is configured to ignore alerts associated with the application server andmonitor only those alerts that
belong to the central instance. This means modifying the configuration file of each of the OMi MP for
SAP’s central-instancemonitors in such a way as tomake sure that themonitor is tied to a particular
SAP central-instance number, for example, 00. By default, the OMi MP for SAP
ABAP Monitoring Template monitors are configured tomonitor all SAP instances present on the node,
which in this special-case scenario would include the unwanted application-server instance, too.

Tying the SAPABAP_IdocStatusMon to an SAP Instance Number illustrates how the configuration for
the SAPABAP_IdocStatusMonMonitoring Template on the secondary node would look if you
configured SAPABAP_IdocStatusMonMonitoring Template tomonitor only the central instance (for
example=00) on the secondary node nodename2.com and not the instance of the application server
(=01), which is already running. Note that the node name you specify in this file is the name of the
physical cluster node.

Tying the SAPABAP_IdocStatusMon Monitoring Template to an SAP Instance Number

#AlertMonFun SAP SAP SAP SAP Alert Enable=1 (...)

# Host System Number Client Monitor Disable=0 (...)

#----------------------------------------------------------------------------

--

AlertMonFun =ClusterNodeA =CI =00 =099 =ALE =1 (...)

AlertMonFun =ClusterNodeB =CI =00 =099 =ALE =1 (...)

The SAPABAP_ProcMon Monitoring Template in a High-Availability Cluster

The SAPABAP_ProcMonMonitoring Template scans for and checks all processes associated with a
given SAP instance, for example, the dialog, en queue, update, batch, dispatch, message, gateway,
and spool work processes. However, the SAPABAP_ProcMonMonitoring Template can be used to
monitor database processes, too.

If the secondary node in a high-availability cluster is running an application server, then care has to be
taken after a package switch that the SAPABAP_ProcMonMonitoring Template started by the
package does not assume that the processes associated with the application server also need to be
monitored along with the processes belonging to the central instance. One way of ensuring this is to
specify the exact number of processes to bemonitored by SAPABAP_ProcMonMonitoring Template
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in the configuration (in the column: Process number=#). The number of processes tomonitor must be
the same on each node both before and after the fail-over package switch.

In addition, if you want to ensure that the SAPABAP_ProcMonMonitoring Template monitors only
those processes belonging to a specific SAP instance on a node wheremultiple SAP instances are
running, for example, after a package switch, you have tomake sure that the SAPABAP_ProcMon
Monitoring Template knows which SAP instances it is supposed to watch. You can do this by
modifying the SAPABAP_ProcMonMonitoring Template configuration on the adoptive node in the
cluster in such a way that each SAP instance number (defined in the column: SAP Number=) is linked
to the appropriate process name, as illustrated in the following example:

Tying the SAPABAP_ProcMon Monitoring Template to an SAP Instance Number

#AlertInstMonPro SAP SAP Process Enable Mode Process (...)

# System Number name =1 number (...)

#--------------------------------------------------------------------------

AlertInstMonPro =T11 =00 =saposcol =1 =Exact =1 (...)

AlertInstMonPro =T11 =01 =saposcol =1 =Exact =1 (...)

OMi MP for SAP R3 Performance Agent in a High-availability Environment

Note:SinceOMi MP for SAP Performance Agent will always use the physical hostname in a
cluster environment, youmust specify the clustered SAP-system details by configuring OMi MP
for SAP Performance Agent with themanual mode (r3perfconfig -manual).

In the event of a fail over and subsequent package switch, the Performance Agent stops collecting
values for the SAP metrics on the host node and, as soon as the package comes up on the secondary
node, starts to monitor and report the appropriate SAP metrics on the secondary node. Metrics for
physical components such as CPU and disk performance continue to be collected on both nodes
irrespective of where the package is running. This needs to be taken into account when generating and
publishing performance reports and graphs.

Removing the OMi MP for SAP in a High-availability Environment

TheOMi MP for SAP software and functionality has to be removed from each individual physical node
in theMC/ServiceGuard cluster, where the product was installed and configured. This will involve the
following steps:

1. If you installed the OMi MP for SAP R/3 Performance Agent on themanaged nodes in the cluster,
you will have to remove it and its components from the SAP managed nodes in the
MC/ServiceGuard cluster before you proceed to step two. For more information, see"Removing
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the OMi MP for SAP R/3 Performance Agent"

2. After removing the OMi MP for SAP R/3 Performance Agent, youmust remove theOMi MP for
SAPcomponents from the SAP managed nodes in theMC/ServiceGuard cluster.

The following figure shows a typical deployment scenario where the OMi MP for SAP is deployed in
High Availability Environment:
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Chapter 6: Troubleshooting
The following section provides information about troubleshooting scenarios:

Note:OnUNIX nodes, youmust replace %OvDataDir%with /var/opt/OVwhile running
commands mentioned in this section.

Multiple SAP CIs discovered on MA Server with same Display Label

Problem:Display Label does not have name attribute.

Solution: If you want to Youmust add name as part of the default display label for
SAP ABAP Application Server and SAP J2EE Application Server CI. For more information, seeOMi
MP for SAP Installation Guide.

"Request does not match component version" error while adding the SAP MP Transports to
the import queue

Problem: “Request does not match component version” error displayed while adding the SAP MP
transports to the import queue.

Solution:You can select the option “Ignore the invalid component version” while importing Transport
request. The “Ignore the invalid component version” option can be used as the contents of the OMi MP
for SAP Transports are independent of the component version and SAP support pack.

SAP ABAP Performance Monitor is not logging the performance data for DBINFO_PERF
Performance Monitor

Problem:SAP reports the following runtime error along with errors in the r3perfmon.log:

Runtime Errors DBIF_DSQL2_OBJ_UNKNOWN

Exception CX_SY_NATIVE_SQL_ERROR

Date and Time [...]

r3perfmon.log on an SAP System contains the following errors:

140520-11:10:23 Info : Try to get performance data from ASE interface

140520-11:10:23 Info : Calling rfc function module /HPOV/OV_DISPATCH

140520-11:10:23 Info : Timeout variable is set to: 30.000000

140520-11:10:28 ERROR: RFC CALL ERROR.KEY :

140520-11:10:28 ERROR: RFC CALL ERROR.STATUS :
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140520-11:10:28 ERROR: RFC CALL ERROR.MESSAGE: - Table does not exist in database.

140520-11:10:28 ERROR: RFC CALL ERROR.INTSTAT:

140520-11:10:28 Info : call RfcLastError

140520-11:10:28 Info : set rfc error variables

140520-11:10:28 ERROR: OvCHandleIO::vHandle > Can't call the Performance Monitor :
- DBINFO_PERF

140520-11:10:28 ERROR: OvCPerfScheduler::RemoveSAPLoginPtr - No Connection to SAP

140520-11:10:28 Info : Scheduled Monitor: - Wed May 20 11:10:28 2014

S99 00 DBINFO_PERF

Solution: The DBINFO_PERF performancemonitor works only with Oracle database data structures. It
does not work with data structures from other database products. Disable DBINFO_PERF in the policy
template r3perfagent.cfg associated with the OMi MP for SAP Aspect to avoid the unnecessary
error. For more information about DBINFO_PERF performancemonitor, see "DBINFO_PERF"

"librfc32.dll not found" error while executing the OMi MP for SAP Aspects

Problem:OMi MP for SAP displays SAP RFC SDK Files not found errors while deploying OMi MP for
SAP.

Solution: To resolve SAP RFC SDK Files not found error, follow these steps:

1. DownloadSAP RFC SDK 6.40 from SAP Software Download Center.

Note:Youmust download SAP RFC SDK 6.40 irrespective of SAP version in your
environment. Select the appropriate RFC Library from the list based on theOperating System
of the SAP system that needs to bemonitored.

2. Uncar the downloaded RFC Library files and copy the library to Instrumentation folder on
SAP managed nodes. Instrumentation folder is available at the following locations:

Windows Node:

%OvAgentDir%\bin\instrumentation

UNIX Node:

/var/opt/OV/bin/instrumentation

Formore information about OMi MP for SAP Transports and un-carring the Transport files, see
OMi MP for SAP Installation Guide.
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Checking OMi MP for SAP Transports currently installed on SAP system

Problem:OMi MP for SAP ABAP Monitoring is not working as expected. You want to check the
Transports currently installed on SAP system.

Solution: To check OMi MP for SAP Transports currently installed on SAP system, follow these
steps:

1. Log into the SAP system using the SAPGUI.

2. Open STMS (/nstms) transaction.

3. Go toMenu Overview > Imports (F5). Select the queue for the SID of the SAP System you want
to check.

4. Click History > Import history. ‘No log information in selected area’ notification window appears.
Close the window. Last week's import history is displayed. The list may be empty.

5. Select theDate column, and click onEdit > Filters (Ctrl+F10). In the window, specify a start
date to cover the installation of OMi MP for SAP Transports. A list of requests for the specified
time range is displayed.

6. If the result list contains many non-OMi MP for SAP Transports, then you can restrict the list by
filtering on the Transport owner.

7. Select theOwner column title, and click onEdit -> Filters (Ctrl+F10). In the window, specify
owner HPMP, and press ENTER. The list of Transports is now restricted to HPMP owner.

OMi MP for SAP JAVA Discovery not working as expected

Problem:OMi MP for SAP JAVA Discovery not working as expected.

Solution: To troubleshoot the OMi MP for SAPJAVA Discovery, perform the following checks on
SAP managed nodes:

1. Check Environment Variable:

Set SAPMP_REMOTE_CLUSTID Environment variable with Remote Application Server cluster ID for
SAP NetWeaver 7.0.

2. Check if SAP J2EE Discovery ovpolicy -l -polname SAPJ2EE_Discovery is present and
enabled.

You deploy SAP J2EE Discovery Aspect if SAP J2EE Discovery ovpolicy -l -polname
SAPJ2EE_Discovery is not present. Confirm successful deployment at deployment tab in OMi
server. For more information about deploying SAP J2EE Discovery Aspect, see Task 3:
Deploying the SAP Discovery Aspect.

3. Check if SAP J2EE Discovery policy is in enabled state.
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Enable SAP J2EE Discovery policy using ovpolicy -e -polname SAPJ2EE_Discovery if the
SAP J2EE Discovery policy is not in enabled state.

4. Check if OMi MP for SAP instrumentation is available at the following location on the SAP node:

%ovDataDir%\bin\instrumentation\

You can deploy SAP J2EE Discovery Aspect if the OMi MP for SAP Instrumentation is not
present at the required location.

5. You can identify errors by verifying the sapmp_j2ee_discovery.log file available at the following
location:

%OvDataDir%\App_Monitoring\SAPJ2EE\log\sapmp_j2ee_discovery.log

6. If you have the Discovery policy ID, you can check the availability of the following files:

The files are available at %OvDataDir%\tmp\agtrep

o <Policy ID>.cis.xml

o <Policy ID>.out

o <Policy ID>.services.xml

o <Policy ID>_ci.xml

o <Policy ID>.ci_refs.xml

If you do not have the Discovery policy ID, you can get the policy ID by running the following
command on SAP managed node:

ovpolicy -list -level 4 -polname "SAPJ2EE_Discovery"

In case of failover, check if the abovementioned files are updated on all cluster nodes.

You can run the following command on respective cluster node to update the policy files:

Ovagtrep -run "SAPJ2EE_Discovery"

OMi MP for SAP ABAP Remote Discovery is not working as expected

Problem:OMi MP for SAP ABAP Remote Discovery not working as expected.

Solution: To troubleshoot the OMi MP for SAPABAP Remote Discovery, perform the following checks
on SAP managed nodes:

1. Check if SAP ABAP Discovery ovpolicy -l -polname SAPABAP_RemoteDiscovery is
available.
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You can deploy SAP ABAP Remote Configuration Aspect to make policy available. After
deployment, you can confirm successful deployment job at deployment tab in OMi Server.

2. Check if Remote Discovery policy is in enabled state.

You can enable policy using ovpolicy -e -polname SAPABAP_RemoteDiscovery.

3. Check if OMi MP for SAP Instrumentation is available on SAP node at the following location:

%ovDataDir%\bin\instrumentation\

You can deploy SAP ABAP Remote Configuration Aspect to confirm availability of OMi MP for
SAP instrumentation.

4. Check and identify errors in the sapmp_abap_remotediscovery.log file available at the following
location:

%OvDataDir%\App_Monitoring\SAPABAP\log\sapmp_abap_remotediscovery.log

5. If you have the Discovery policy ID, you can check the availability of the following files:

The files are available at %OvDataDir%\tmp\agtrep

o <Policy ID>.cis.xml

o <Policy ID>.out

o <Policy ID>.services.xml

o <Policy ID>_ci.xml

o <Policy ID>.ci_refs.xml

If you do not have the Discovery policy ID, you can get the policy ID by running the following
command on SAP managed node:

ovpolicy -list -level 4 -polname "SAPABAP_RemoteDiscovery"

In case of failover, check if the abovementioned files are updated on all cluster nodes.

You can run the following command on respective cluster node to update the policy files:

Ovagtrep -run "SAPABAP_RemoteDiscovery"

SAP ABAP Discovery not working as expected

Problem:SAP ABAP Discovery is not working after deploying SAP ABAP Discovery Aspect.

Solution: To troubleshoot the OMi MP for SAP ABAP Discovery, perform the following checks on
SAP managed nodes:
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1. Make sure that you have provided Fully Qualified computer name for all SAP managed nodes.

2. Check if SAP ABAP Discovery ovpolicy -l -polname SAPABAP_Discovery is available.

You can deploy SAP ABAP Discovery Aspect to make ABAP Discovery available. You can
confirm successful deployment job at deployment tab in OMi Server.

3. Check if SAP ABAP Discovery policy is in enabled state.

You can enable the SAP ABAP Discovery policy using ovpolicy -e -polname SAPABAP_
Discovery.

4. Check if OMi MP for SAP Instrumentation is available on SAP node at the following location:

%ovDataDir%\bin\instrumentation\

You can deploy SAP ABAP Discovery Aspect to ensure availability of Instrumentation.

5. You can identify errors by verifying the r3sdisc.log file available at the following location:

%OvDataDir%\App_Monitoring\SAPABAP\log\r3sdisc.log

6. If you have the Discovery policy ID, you can check the availability of the following files:

The files are available at %OvDataDir%\tmp\agtrep

o <Policy ID>.cis.xml

o <Policy ID>.out

o <Policy ID>.services.xml

o <Policy ID>_ci.xml

o <Policy ID>.ci_refs.xml

If you do not have the Discovery policy ID, you can get the policy ID by running the following
command on SAP managed node:

ovpolicy -list -level 4 -polname "SAPABAP_Discovery"

In case of failover, check if the abovementioned files are updated on all cluster nodes.

You can run the following command on respective cluster node to update the policy files:

Ovagtrep -run "SAPABAP_Discovery"

OMi MP for SAP Discovery is working on node but CIs are not discovered in RTSM

Problem:OMi MP for SAP Discovery is working on node but CIs are not discovered in RTSM.

Solution: If the OMi MP for SAP Discovery runs successfully on node,you can troubleshoot the
problem by checking the following logs at specific locations onMA Server:
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OnOMi Server (for debugging Service Discovery)

1. You can enable Trace Level to DEBUG:
a. In %TOPAZ_HOME%\conf\core\Tools\log4j\wde\opr-svcdiscserver.properties

b. Select value loglevel=, and update value to DEBUG.

c. Select value loglevelcitrace=, and update value to DEBUG.

2. You can check and identify errors from the Discovery logs available at the following locations:

o %TOPAZ_HOME%\log\wde\opr-svcdiscserver-citrace.log

o %TOPAZ_HOME%\log\wde\opr-svcdiscserver.log

o %OvDataDir%\shared\server\log\OvSvcDisc.log

OMi MP for SAP J2EE Data collection is failing or alerts are not reaching MA Event browser

Problem:OMi MP for SAP J2EE Data collection is failing or alerts are not reachingMA Event browser.

Solution:You can troubleshoot the problem by performing the following checks on SAP managed
nodes:

1. Check if SAP J2EE Discovery policy is available and is in enabled state.

2. Check if OMi MP for SAP Instrumentation is available at the following location:

%ovDataDir%\bin\instrumentation\

If Instrumentation is available but the Instrumentation file which starts with sapmp is missing, you
can redeploy SAP J2EE Discovery Aspect.

3. Check SiteConfig availability at the following location:

%OvDataDir%\conf\sapspi\global\SiteConfig

If SiteConfig is unavailable, you can run the following command from the instrumentation folder to
run the OMi MP for SAP Discovery:

r3mon_perl -S sapmp_j2ee_discovery.pl

4. Check SAP J2EE Discovery log available at the following location for errors:

%OvDataDir%\App_Monitoring\SAPJ2EE\log\sapmp_j2ee_cfg.log

Identify and resolve the errors from log. You can run the following command from the
instrumentation folder to re-run the SAP J2EE configuration:

r3mon_perl -S sapmp_j2ee_cfg.pl

5. OMi MP for SAP uses MetricDefinitions.xml file for J2EE data collection.The
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MetricDefinitions.xml is available at the following location:

%OvDataDir%/conf/sapspi/global/

You can run the following command from the instrumentation folder if theMetricDefinitions.xml is
not available:

r3mon_perl -S r3mon_configCheck -f

6. Check if OMi MP for SAP J2EE policies starting with SAPJ2EE_* is available and is in enabled
state.

You can perform the check running the following command:

ovpolicy -l

7. You can run the SAP J2EE data collectionmanually in debugmode and check logs to identify the
errors. To run the SAP J2EE data collectionmanually in debugmode:

SAPMP_CollMgr -app=SAPJ2EE -freq=<VERYHIGH|HIGH|MEDIUM|LOW> -d

Check the following logs to identify the errors:

o %OvDataDir%\App_Monitoring\SAPJ2EE\log\SAPMP_CollMgr.pl.log

o %OvDataDir%\App_Monitoring\SAPJ2EE\log\SAPMP_ConfHandler.pl.log

OMi MP for SAP J2EE Data logging is failing

Problem: J2EE Data logging is failing for OMi MP for SAP

Solution:Perform the following checks on SAP managed node:

1. Check if SAP J2EE policies starting with SAPJ2EE_* is available and is in enabled state.

You can perform the check by running the following command:

ovpolicy -l

2. Check the availability of Datasources.

You can run the following command to check the availability of Datasources:

ovcodautil -showds SAPSPINW_RPT_METRICS

If the Datasources are unavailable, you can run the following command to activate Datasources:

On Windows:

"%OvDataDir%\bin\R3PerfAgent\bin\r3PerfConfig.exe" -j2ee

On UNIX:
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"/var/opt/OV/bin/R3PerfAgent/bin/r3PerfConfig" -j2ee

3. Check if the SAP J2EE data logging is enabled.

You can check the value DATA_LOGGING_ENABLED=TRUE in the configuration file available at the
following location:

%OvDataDir%\conf\sapspi\global\SPIConfig

4. You can run the SAP J2EE data collectionmanually in debugmode and check logs to identify the
errors. To run the SAP J2EE data collectionmanually in debugmode:

SAPMP_CollMgr -app=SAPJ2EE -freq=<VERYHIGH|HIGH|MEDIUM|LOW> -d

Check the following logs to identify the errors:

o %OvDataDir%\App_Monitoring\SAPJ2EE\log\SAPMP_CollMgr.pl.log

o %OvDataDir%\App_Monitoring\SAPJ2EE\log\SAPMP_ConfHandler.pl.log

OMi MP for SAP ABAP Data collection is failing or alerts not reaching on MA event browser

Problem:OMi MP for SAP Data collection is failing or alerts not reaching onMA event browser.

Solution:Perform the following checks on SAP managed node:

1. Check if SAP ABAP Discovery policy is available and is in enabled state.

2. Check the availability of OMi MP for SAP Instrumentation at the following location:

%ovDataDir%/bin/instrumentation/

Deploy SAP ABAP Discovery Aspect again if OMi MP for SAPInstrumentation is available but the
files which starts with sapmp aremissing.

3. Check the availability of r3itodsap at the following location:

%OvDataDir%/conf/sapspi/global/r3itosap

If r3itosap is unavailable, re-run the SAP ABAP Configuration by running the following command
from the instrumentation folder:

r3mon_perl -S sapmpcfg.pl

4. You can check for errors in the SAP ABAP Configuration log file. You can check the availability of
SAP ABAP Configuration log file at the following location:

%OvDataDir%/App_Monitoring/SAPABAP/log/sapmp_abap_cfg.log

You can verify and resolve the errors using the log file. To run the SAP ABAP Configuration again,
run the following command from the instrumentation folder:
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r3mon_perl -S sapmpcfg.pl

5. Check if the Client and Username (password is in encrypted state) values in r3itosap file is
same as provided during deployment of SAP ABAP Configuration Aspect.

6. Check SAP ABAP policies for type sapconfigfile is available and is in enabled state.

7. You can run the SAP ABAP data collectionmanually in debugmode and check logs to identify the
errors. To run the SAP ABAP data collectionmanually in debugmode:

SAPMP_CollMgr -app=SAPABAP -freq=<VERYHIGH|HIGH|MEDIUM|LOW> -d

Check the following logs to identify the errors:

o %OvDataDir%/App_Monitoring/SAPABAP/log/SAPMP_CollMgr.pl.log

o %OvDataDir%/App_Monitoring/SAPABAP/log/SAPMP_ConfHandler.pl.log

OMi MP for SAP ABAP Data Logging is failing

Problem:OMi MP for SAP ABAP Data Logging is failing.

Solution:Perform the following checks on SAP managed nodes:

1. Make sure the OMi MP for SAP performance agent is started using Performance Agent tool from
MA server.

You can check the status of OMi MP for SAP performance agent by running the following
command:

On Unix nodes:

/var/opt/OV/bin/instrumentation/r3mon_perl -S SAPMP_Tool.pl Status

You can start the Performance Agent by running the following command:

/var/opt/OV/bin/instrumentation/r3mon_perl -S SAPMP_Tool.pl Start

On Windows nodes:

%OvAgentDir%\bin\instrumentation\r3mon_perl -S SAPMP_Tool.pl Start

2. Check the availability of Datasources.

You can run the following command to display status of datasources for configured instances:

ovcodautil -showds

You can run the following command to activate Datasources for configured instances:

UNIX:
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"/var/opt/OV/bin/R3PerfAgent/bin/r3PerfConfig.exe" -abap

Windows:

"%OvDataDir%\bin\R3PerfAgent\bin\r3PerfConfig" -abap

3. Youmust manually create Datasources for Remote Application servers using the following
command:

UNIX:

"/var/opt/OV/bin/R3PerfAgent/bin/r3PerfConfig.exe" -manual

Windows:

"%OvDataDir%\bin\R3PerfAgent\bin\r3PerfConfig" -manual

Youmust provide the SAP SID, HostName, and Instance to create data sources.

4. Agent Installation command returns errors if the r3PerfConfig file is not available onmanaged
node at the following location:

%OvDataDir%\bin\R3PerfAgent\bin\r3PerfConfig

You can run the following command to re-install OMi MP for SAPPerformance Agent:

%OvAgentDir%\bin\instrumentation\r3mon_perl -S SAPMP_Tool.pl Install

5. You can identify datasources errors by verifying the sapmp_abap_dscmd.log file available at
the following location:

%OvDataDir%\App_Monitoring\SAPABAP\log\sapmp_abap_dscmd.log

OMi MP for SAP ABAP Data collection on ABAP Application Server in HA environment is
failing or alerts are not reaching MA event browser

Problem:OMi MP for SAP ABAP Data collection on ABAP Application Server in HA environment is
failing or alerts are not reachingMA event browser.

Solution:You can perform the following checks onmanaged nodes to troubleshoot the problem:

1. Check if SAP ABAP Discovery policy and SAP ABAP Configuration policy is available and is in
enabled state.

2. Check the availability of OMi MP for SAP Instrumentation at the following location:

%ovDataDir%\bin\instrumentation\

Deploy SAP ABAP Discovery Aspect again if OMi MP for SAP Instrumentation is available but
the files which starts with sapmp aremissing.
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3. Check the availability of r3itosap at the following location:

%OvDataDir%/conf/sapspi/global/r3itosap

If r3itosap is unavailable, re-run the SAP ABAP Configuration by running the following command
from the instrumentation folder:

r3mon_perl -S sapmpcfg.pl

4. You can check for errors in the SAP ABAP Configuration log file. You can check the availability of
SAP ABAP Configuration log file at the following location:

%OvDataDir%\App_Monitoring\SAPABAP\log\sapmp_abap_cfg.log

You can verify and resolve the errors using the log file. To run the SAP ABAP Configuration again,
run the following command from instrumentation folder:

r3mon_perl -S sapmpcfg.pl

5. Check if the Client and Username (password is in encrypted state) values in r3itosap file is
same as provided during deployment of SAP ABAP Configuration Aspect.

6. Check for the HostMapping value in r3itosap file. The HostMapping value provides details about
cluster nodes participating in HA environment, Central Instance, SID, Virtual Server node name,
and Hostnamewith which you associate themessages at MA event browser.

The following is a sample HostMapping line syntax:

HostMapping =<SID> = <Central Instance> =<Physical node name1 >, <Physical Node
Name 2>,<Virtual Node Name > = <Message Node Name>

Message Node Name is optional. If not specified, Virtual Server Namewould act as Message
Node Name.

The following is a sample HostMapping configuration:

HostMapping =NA9 =09
=ipv6winclus1.hpeswv6lab.com,ipv6winclus2.hpeswv6lab.com,saphanw.hpeswv6l
ab.com =IXYZE01XXX.hpeswlabs.adapps.hpe.com

Make sure the details provided in HostMapping entry is valid. If the HostMapping configuration is
invalid, you can check the sapmp_cluster_details.txt available at the following location to
verify the details:

%OvDataDir%\App_Monitoring\SAPABAP\sapmp_cluster_details.txt

OMi MP for SAP Cluster discovery is not working as expected

Problem:OMi MP for SAP Cluster discovery is not working as expected.
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Solution:You can perform the following checks to troubleshoot the problem:

1. Make sure that you have provided Fully Qualified computer name for all SAP managed nodes.

2. Check if SAP ABAP Discovery ovpolicy -l -polname SAPABAP_Discovery is available.

You can deploy SAP ABAP Discovery Aspect to make ABAP Discovery available. You can
confirm successful deployment job at deployment tab in OMi Server.

3. Check if SAP ABAP Discovery policy is in enabled state.

You can enable the SAP ABAP Discovery policy using the ovpolicy -e -polname SAPABAP_
Discovery command.

4. Check the availability of OMi MP for SAP Instrumentation at the following location:

%ovDataDir%\bin\instrumentation\

You can deploy SAP ABAP Discovery Aspect again if OMi MP for SAP Instrumentation is
unavailable.

5. You can verify the Discovery logs files available at the following locations for more details:

o %OvDataDir%\App_Monitoring\SAPABAP\log\r3sdisc.log

o OvDataDir%\App_Monitoring\SAPABAP\log\sapmp_cluster_discovery.log

6. If you have the Discovery policy ID, you can check the availability of the following files:

The files are available at %OvDataDir%/tmp/agtrep

o <Policy ID>.cis.xml

o <Policy ID>.out

o <Policy ID>.services.xml

o <Policy ID>_ci.xml

o <Policy ID>.ci_refs.xml

If you do not have the Discovery policy ID, you can get the policy ID by running the following
command on SAP managed node:

ovpolicy -list -level 4 -polname "SAPABAP_Discovery"

In case of failover, check if the abovementioned files are updated on all cluster nodes.

You can run the following command on respective cluster node to update the policy files:

Ovagtrep -run "SAPABAP_Discovery"

7. Make sure that after Discovery the removeRelationOnPassive file is present only on active node
at the following location:
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%OvDataDir%\App_Monitoring\SAPABAP\

Note:SAP Cluster Deployment view will not get updated for passive nodes, if the
removeRelationOnPassive file is not available.

8. The SAP_Cluster_Deployment view will not get updated for first run of Discovery immediately
after fail over. The SAP_Cluster_Deployment view will get updated after the first run of Scheduled
Discovery on Passive node.

If you want to update the view before the Scheduled Discovery run, you can run the discovery
manually on active nodes (passive before failover) after failover using the following commands:

To run the SAP ABAP Discovery:

Ovagtrep -run "SAPABAP_Discovery"

To publish CIs to RTSM:

Ovagtrep -publish -all

SAP Cluster Deployment view not getting updated with current SAP active node after SAP
Cluster failover

Problem:SAP Cluster Deployment view is not getting updated with current SAP active node after
SAP Cluster failover.

Solution:SAP Cluster Deployment view is updated with the next schedule of SAP ABAP Discovery.
If you want to update the SAP Cluster Deployment view before scheduled run of SAP ABAP
Discovery, deploy SAP ABAP Discovery Aspect on current active node.

"Could not connect to the node. Please check if the agent is up and running, the certificates are in place
and your firewall configuration is correct" error when deploying SAP Management Templates on
Remote SAP Systems.

Problem:On remote configured SAP Application Server CI, Management Template deployment
shows the Could not connect to the node. Please check if the agent is up and
running, the certificates are in place and your firewall configuration is correct”
error message in Deployment Jobs Wizard. 

Solution: This error is only for SAP systems where the Operations Agent is not installed. You can 
ignore this error since the SAP Aspects are successfully deployed. This error shows when the system 
attempts to deploy the Infrastructure Aspects within the SAP Management Templates on SAP 
systems which do not have the Operations Agent. For more information, see Task 5: Deploying SAP 
ABAP Remote Configuration Aspect.
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Appendix: Metrics and Datasources
TheOMi MP for SAP creates data store tables to enable data collection frommetrics. OMi MP for SAP
uses two separate Datasources and relatedmetrics for logging the data collected from
SAP ABAP Application Servers and SAP J2EE Application Servers in your SAP Environment.

SAP ABAP Application Server

TheOMi MP for SAP creates the following data store table to log the data collected by metrics from
SAP ABAP Application Server:

Note: R3_<SAP_Hostname>_<SAP_SID>_<SAP_Instance_ Number>_DATA is the Datasource used
by SAP ABAP Application Server Policy Templates. The R3_<SAP_Hostname>_<SAP_SID>_<SAP_
Instance_ Number>_DATADatasource is created for every SAP ABAP Application Server
Instance to log the collected data.

Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

DBINFO_PERF CPUUSAGE

BUFPREADS

BUFPWRITES

BUFQUAL

BUFSIZE

BUFWAITS

BUFWTIME

DICTSIZE

DDQUAL

LOGBLOCKS

LOGENTRIES

LOGSIZE

LOGFAULT

R64

I32

I32

R64

I32

I32

I32

I32

R64

I32

I32

I32

R64
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

LOGALLOC

ROLLBACKS

SCANLONG

SORTDISK

SORTMEM

SORTROWS

HOSTNAME_
DBINFO

SID_DBINFO

INSTANCE_DBINFO

KEY_DBINFO

I32

I32

I32

I32

I32

I32

UTF8

UTF8

UTF8

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

DOCSTAT_
PERF

APPMODE_DOC

CNTHEADER

CNTITEM

CNTDIV

CNTTOTAL

CNTLINE

CNTCHGDOC

CNTTEXT

HOSTNAME_
DOCSTAT

SID_DOCSTAT

INSTANCE_
DOCSTAT

KEY_DOCSTAT

UTF8

I32

I32

I32

I32

I32

I32

I32

UTF8

UTF8

UTF8

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

EP_PERF SID_EP

HOSTNAME_EP

START_TIME_EP

NO_REQ_EP

UTF8

UTF8

UTF8

I32
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

AVG_RESP_TIME_
EP

AVG_CPU_TIME_
EP

REQ_PER_SEC_EP

AVG_OUTBND_
DATA_EP

ACC_RESP_TIME_
EP

ACC_CPU_TIME_
EP

OUTBND_DATA_
REQ_EP

ACC_OUTBND_
DATA_EP

NO_COMPCALLS_
REQ_EP

AVG_
CMPCALLPERREQ_
EP

VALID_MONDATA_
REQ_EP

REQ_NOT_CORR_
CLSD_EP

REQCLSD_
TOOMNYCMP_EP

REQS_RUNLEVEL_
0_EP

REQS_RUNLEVEL_
1_EP

REQS_RUNLEVEL_
2_EP

USRS_SINCE_1_
REQ_EP

USRS_SINCE_

R64

R64

I32

I32

R64

R64

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

UTF8

UTF8

UTF8
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

LSTRST_EP

LST_REQ_RST_
TSTMP_EP

LST_CMPREQ_
TSTMP_EP

LST_USRREQ_
TSTMP_EP

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

ICMSTAT_
PERF

ICM_STATUS

MAX_THREADS

PEAK_THREADS

CUR_THREADS

MAX_
CONNECTIONS

PEAK_
CONNECTIONS

CUR_
CONNECTIONS

MAX_
QUEUEENTRIES

PEAK_
QUEUEENTRIES

CUR_
QUEUEENTRIES

RUNNING_
THREADS

DEAD_THREADS

PROCESSED_
THREADS

HOSTNAME_
ICMSTAT

SID_ICMSTAT

INSTANCE_
ICMSTAT

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

UTF8

UTF8

UTF8
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

KEY_ICMSTAT

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

JOBREP_PERF RUNNING

READY

SCHEDULED

RELEASED

ABORTED

FINISHED

PUT_ACTIVE

UNKNOWN_STATE

HOSTNAME_
JOBREP

SID_JOBREP

INSTANCE_
JOBREP

KEY_JOBREP

UTF8

I32

I32

I32

I32

I32

I32

I32

UTF8

UTF8

UTF8

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

SAPBUFFER_
PERF

BUFFER_NAME

HITRATIO

ALLOCATED_SIZE

FREE_SPACE

FREE_SPACE_
PERCENT

MAXDIR_ENTR

FREEDIR_ENTR

FDIR_ENTR_
PERCENT

BUFFER_SWAPS

BUFFER_SWAPS_
DELTA

DB_ACCESSES

DB_ACCESSES_

UTF8

R64

I32

I32

R64

I32

I32

R64

I32

I32

I32

I32

UTF8

UTF8
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

DELTA

HOSTNAME_
SAPBUFFER

SID_SAPBUFFER

INSTANCE_
SAPBUFFER

KEY_SAPBUFFER

UTF8

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

SAPMEMORY_
PERF

MEMORY_AREA

CURRENT_USE_
PERCENT

CURRENT_USE

MAX_USE

IN_MEMORY

ON_DISK

HOSTNAME_
SAPMEMORY

SID_SAPMEMORY

INSTANCE_
SAPMEMORY

KEY_SAPMEMORY

UTF8

R64

I32

I32

I32

I32

UTF8

UTF8

UTF8

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

SPOOL_PERF ALL_SJ

SJ_ARCHIVE

PRINT_REQ

OPEN_PR

SUCCESS_PR

ERROR_PR

FAILED_PR

HOSTNAME_
SPOOL

SID_SPOOL

I32

I32

I32

I32

I32

I32

I32

UTF8

UTF8

UTF8
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

INSTANCE_SPOOL

KEY_SPOOL

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

SAP_
STATRECS_
PERF

SAP_TCODE

SAP_RESPONSE_T
IME

SAP_NET_TIME

SAP_REC_COUNT

SAP_HOST_
STATRECS

SAP_SID_
STATRECS

SAP_INSTNO_
STATRECS

SAP_KEY_
STATRECS

UTF8

I32

I32

I32

UTF8

UTF8

UTF8

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

UPDATE_PERF ALL_TASKS

INITIAL_TASKS

ERRONOUS_
TASKS

VB1

V2

HOSTNAME_
UPDATE

SID_UPDATE

INSTANCE_
UPDATE

KEY_UPDATE

UTF8

I32

I32

I32

I32

UTF8

UTF8

UTF8

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

USER_PERF USER_CLIENT

USER_CNT

SESSION_CNT

HOSTNAME_USER

UTF8

I32

I32

UTF8
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

SID_USER

INSTANCE_USER

KEY_USER

UTF8

UTF8

UTF8

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

SAP_WLSUM_
PERF

SAP_HOSTNAME _
WLSUM

SAP_SID_WLSUM

SAP_INSTANCE_
WLSUM

SAP_KEY_WLSUM

SAP_TASKTYPE

SAP_CNT

SAP_DBACTIVCNT

SAP_RESPTI

SAP_CPUTI

SAP_QUEUETI

SAP_LOADGENTI

SAP_COMMITTI

SAP_DDICTI

SAP_QUETI

SAP_CPICTI

SAP_ROLLINCNT

SAP_ROLLINTI

SAP_ROLLOUTCNT

SAP_ROLLOUTTI

SAP_READDIRCNT

SAP_READDIRTI

SAP_
READSEQCNT

SAP_READSEQTI

UTF8

UTF8

UTF8

UTF8

UTF8

I32

I32

R64

R64

R64

R64

R64

R64

R64

R64

I32

R64

I32

R64

I32

R64

I32

R64

I32

R64
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

SAP_CHNGCNT

SAP_CHNGTI

SAP_BYTES

SAP_GUITIME

SAP_GUICNT

SAP_GUINETTIME

I32

R64

I32

R64

SAP ABAP
PerformanceMonitor

SAPABAP_
PerfMon

WP_PERF ALL_WP

SEMAPHORE_WP

DEBUG_WP

LONG_RUNNING

PRIVAT_WP

NOSTART_WP

DIA_IDLE

DIA_ALL

DIA_RUNNING

BTC_IDLE

BT_ALL

BTC_RUNNING

SPO_IDLE

SPO_ALL

SPO_RUNNING

ENQ_IDLE

ENQ_ALL

ENQ_RUNNING

UPD_IDLE

UPD_ALL

UPD_RUNNING

UPD2_IDLE

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32

I32
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Aspect Name

Policy
Template
Name Table Name Metric Name

Metric
Data Type

UPD2_ALL

UPD2_RUNNING

HOSTNAME_WP

SID_WP

INSTANCE_WP

KEY_WP

I32

I32

UTF8

UTF8

UTF8

UTF8

SYSUP_PERF SYSTEM_STATUS

HOSTNAME_
SYSUP

SID_SYSUP

INSTANCE_SYSUP

KEY_SYSUP

UTF8

UTF8

UTF8

UTF8

UTF8

Note: The default frequency of the SYSUP_PERF availability monitor is oneminute and the value
cannot be changed.

SAP J2EE Application Server

TheOMi MP for SAP creates the following data store table to log the data collected by metrics from
SAP J2EE Application Server:

Note: SAPSPINW_RPT_METRICS is the Datasource and table used by SAP J2EE Application Server
Policy Templates for logging the collected data.

Table Name Metric Name Metric Data Type

SAPSPINW_RPT_METRICS METRICID

VALUEID

VALUE

SORTID

SERVERNAME

OBJECTNAME

I32

I32

R64

UTF8

UTF8

UTF8
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Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on User Guide (OMi Management Pack for SAP 1.00)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to docfeedback@hpe.com.

We appreciate your feedback!
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